


 

Úvodem  
Předmětem brožury, kterou držíte v ruce, je práce 

s daty, o nichž se předpokládá, že jsou nebo budou uložena 
v sešitech Excelu a uspořádaná jako seznamy neboli 
databáze pracovních listů.  

Je určena především čtenářům, jejichž klíčovým 
produktem je Excel nebo kteří se teprve pro svůj 
„mateřský“ produkt rozhodují a přemítají o tom, zda by to 
neměl být Excel. Rozhodně ano.  

Cílem brožury je ukázat, že Excel je špičkovou aplikací 
nejen pro nejrůznější výpočty, analýzy a grafy, ale že s ním 
snadno zvládnete i typické úlohy „hromadného zpracování 
dat“ jako jsou řazení, filtrování, hierarchické výběry 
z tabulek propojených relacemi, agregované statistiky 
a přehledy či kontingenční tabulky. 

Na trhu samozřejmě existují produkty, jejichž 
primárním úkolem je poskytovat nástroje pro vývoj 
plnohodnotných databázových aplikací a které také 
obsahují vyspělé vizuální nástroje pro interaktivní práci 
s databázemi. Jestliže však při své práci nepotřebujete 
pracovat s velmi objemnými daty, možná by byly náklady 
spojené s nákupem a zvládáním databázového produktu 
zbytečné. 

Předchozími odstavci jsem chtěl hlavně říci, že budete-
li potřebovat občas řešit nějakou databázovou úlohu, 
obvykle vystačíte čistě s Excelem, i když data, která máte 
zpracovat, dostáváte ve všelijakých formátech a zadaná 
úloha nevypadá na první pohled zrovna jednoduše. 

 
Zdravím všechny čtenáře a přeji mnoho úspěchů. 

Máte-li k obsahu brožury nebo k jejímu vzhledu či 
uspořádání jakékoli připomínky či náměty, buďte tak 
laskaví a pošlete mi zprávu na adresu 

janpokorny@volny.cz  
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Než začnete 
Postupy uvedené v brožuře jsou převážně založené na uživatelských technikách, které jsou někdy 

doplněny o programový kód VBA či SQL. Úlohy řešené v brožuře ale zvládnete čistě vizuálně a ukázky 
kódu uvádím především pro případné potřeby budoucí automatizace úloh. Rozsah brožury je velmi malý, 
takže není možné do výkladu zahrnout základy ovládání Excelu či tvorby vzorců, tím méně psaní příkazů 
SQL či kódu VBA. Jestliže s Excelem začínáte, přečtěte si nejprve nějakou úvodní příručku o práci ve 
vývojovém rozhraní Excelu, resp. o základech programování v těchto jazycích. 

Brožura se z kapacitních důvodů dále nezabývá ani tvorbou grafů, ani speciálními matematickými 
a statistickými metodami a analýzami (rozdělením četností, regrese, lineární programování atp.), i když tyto 
oblasti Excelu souvisejí jistým způsobem z databázemi (vstupní data pocházejí často ze seznamů na listech). 
Cílem brožury je ukázat, jak se dají v Excelu řešit databázové úlohy, ne ty úlohy, které byste v databázovém 
produktu stejně řešit nemohli nebo neměli. 

V řešených ukázkách se také většinou předpokládá, že se jedná o interaktivní řešení úloh a že se 
seznamy uloženými na listech Excelu budou pracovat inteligentní uživatelé. Tímto nepřesným označením 
chci vyjádřit to, že pro takové lidi nemá valnou cenu vyrábět aplikace typu „bombenfest und idiotensicher“, 
které jsou obvykle značně komplikovanější, náročnější na vývoj i údržbu a také podstatně dražší, než když 
je možno úlohy řešit přímo, na místě, hned teď. Inteligentní uživatel řadu triviálních chyb a nesmyslů prostě 
nedělá. Kromě toho je zodpovědný, takže potřebné kontroly či zabezpečovací akce nepodceňuje, pravidelně 
provádí údržbu atd.  

Dostane-li se do potíží, většinou si je umí vyřešit sám a obvykle je také okamžitě odstraní. V tom také 
spočívá jedna z  výhod interaktivního nebo částečně automatizovaného zpracování, protože může být 
efektivnější při běhu a méně nákladné při vývoji. Jestliže se někde něco zadrhne při plně automatizovaném 
zpracování, nedá se často dělat nic jiného, než nedělat nic nebo pustit celý proces znovu od začátku, protože 
se nepředpokládá, že by konečný uživatel měl takovou kvalifikaci, aby mohl do procesu řešení úlohy nějak 
aktivně zasáhnout (raději se mu proto obvykle ani taková možnost nedá). 

S jak velkými seznamy budete moci pracovat 
Hned na začátku považuji za nutné připomenout, že se v této brožuře bude předpokládat, že nehodláte 

pracovat s obrovitými tabulkami. S databázovou tabulkou se v Excelu pracuje pohodlně jen tehdy, vejde-li 
se na jediný pracovní list a toho se budeme v  brožuře držet.  

Možná, že zjistíte, že vás to zase až tak neomezuje. Vystačíte-li  s pouhými 65 535 záznamy, plus jeden 
řádek na záhlaví polí a nepotřebujete-li v tabulce více než 256 polí, není o čem mluvit. Takové jsou totiž 
meze pro velikost pracovního listu v Excelu 2000 a je to největší seznam, s nímž budete moci v brožuře 
pracovat. Pro zajímavost, seznam může být tvořen jen jedinou buňkou, což je tedy nejmenší seznam, s nímž 
byste mohli teoreticky pracovat. 

Poznámka. Potřebujete-li v tabulce více než 256 polí, je patrně špatně navržená a doporučuji, abyste ji 
rozdělili do dvou nebo do několika. Pokud opravdu musíte evidovat více než 256 ukazatelů jediné entity, 
rozdělte tabulku na dvě části. Jedna může obsahovat dejme tomu „veřejná“ data, druhá „důvěrná“ data. Do 
obou tabulek přidejte totéž propojovací pole a tabulky propojte relací 1:1. Propojovat tabulky na pracovních 
listech či jinde se v brožuře naučíte.  
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Jak je to se vstupními daty 
Jednou ze základních a nejotravnějších databázových úloh je pořizování dat. V této brožuře hromadně 

data pořizovat nebudete muset, údaje získáte importem. Základní aktualizační operace nad daty však nepo-
mineme, takže uvidíte, jak se dají údaje aktualizovat jednotlivě nebo hromadně. Nemůžete-li data odněkud 
vzít a musíte pořídit větší množství údajů ručně, dá se to také udělat v Excelu, a to zhruba dvojím způsobem 
tak, že buď pořizujete data přímo do buněk, nebo pořizujete data prostřednictvím formulářů. 

Pořizování přímo do buněk je poměrně pohodlné a rychlé a žádnou „pořizovací aplikaci“ k tomu 
nepotřebujete. V brožuře si ukážeme, že se vám při objemnějším či komplikovanějším pořizování mohou 
hodit speciální nástroje Excelu – totiž podmíněné formátování a ověřování dat. Pořizování dat si také 
můžete usnadnit pomocí uživatelského (vestavěného) formuláře Excelu.  

Máte-li neodolatelnou potřebu pořizovat data na vlastních formulářích, osobně doporučuji, abyste to 
v Excelu nedělali a raději si, máte-li dostup k nějakému vyspělému databázovému systému, vytvořili 
pořizovací aplikaci v něm. Například v Accessu 2000 by vás měli plně uspokojit jeho průvodci.  

Chcete-li nebo musíte pro potřeby pořizování a aktualizace dat nebo pro jiné účely vytvářet vlastní 
formuláře v Excelu, najdete vyčerpávající rozbor této tématiky s konkrétními aplikacemi v několika částech 
knihy „Paul McFedries: VBA MS Office 2000“, jejíž překlad vydalo nakladatelství UNIS Publishing 
v květnu 2000.  

Co budete potřebovat 
Ukázky uvedené v brožuře byly vyzkoušeny pod Windows 2000 Millenium Me v Office 2000. Abyste 

mohli používat bez úprav vše, co je v brožuře uvedeno, musíte mít kopii aplikace Microsoft Excel 2000. 
Mnohé z úloh by obecně měly „projít“ i v Excelu 97, někdy se ale využívají nové schopnosti, které přišly do 
Excelu až s verzí 2000. Jestliže se v brožuře importují nějaká data z databáze Accessu nebo se do ní 
exportují, předpokládá se, že se jedná o databáze ve formátu 2000 (soubory .mdb Accessu 97 mají jiný 
formát než v Accessu 2000). Při importu HTML se předpokládá práce s Internet Explorerem verze 5.  

I když cílem brožury je ukázat, že databázový systém vlastně nepotřebujete, hodláte-li se při práci 
obracet na objekty z nějaké databáze, je zejména pro programování velmi pohodlné, když se do ní můžete 
jednoduše podívat (jak se jmenují tabulky, pole, jak jsou nastaveny relace mezi tabulkami apod.) a případně 
něco jednoduchého vyzkoušet. Protože je brožura založena na datech z populární databáze „Severní vítr“, 
bude pro vás výhodné, budete-li mít přístup k této databázi, nebo alespoň k její verzi z Office 97 nebo k její 
anglické verzi NWind.mdb z Visual Studia 6. Máte-li přístup k Accessu 2000, tím lépe. 

Co se naučíte 
Svazek o rozsahu přibližně 80 stran nemůže v žádném případě vyčerpat všechny schopnosti, které Excel 

2000 pro práci se seznamy poskytuje. Chcete-li si znalosti prohloubit, obstarejte si nějakou objemnější 
publikaci o Excelu. Nevyčerpatelným zdrojem informací o všech aspektech Excelu jsou pochopitelně 
stránky WWW společnosti Microsoft věnované Excelu a jeho okolí. Nebo vlezte do libovolného 
vyhledávače, napište Microsoft Excel, klepněte na Hledat a budete mít několik nocí starosti jen s tím, jak 
nalezené odkazy rozdělit na ty, které si rozhodně chcete přečíst hned, které později a které zatím odložíte.  

Elektronická podoba knihy a CD 
Brožura také existuje v elektronické podobě na CD. Vstupní soubory pro import pocházejí vesměs 

z ukázkové databáze (v češtině) Northwind.mdb Accessu 2000 a najdete je ve složce VstupníSoubory. Ve 
složce Sešity najdete ukázkové sešity s veškerým kódem VBA používaným v brožuře. Další pokyny najdete 
na prvním listu sešitu Severní vítr.xls na doprovodném CD. Na disku najdete také další sešity.  
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Databáze v pracovním listu sešitu Excelu 
Co se vlastně v Excelu rozumí databází pracovního listu? Za databázi pracovního listu se dá považovat 

(a také s ní jako s databází pracovat) jakákoli obdélníková oblast buněk, která obsahuje ve svém prvním 
horním řádku záhlaví (textové nadpisy či titulky) a v dalších řádcích data, jimiž popisujete charakteristiky 
konkrétních subjektů.  

Každý jednotlivý řádek obsahuje charakteristiky jednoho konkrétního subjektu (například zákazníka 
Nováka). Které charakteristiky se u jednotlivých subjektů dané entity pořizují a zpracovávají, určují právě 
jednotlivé sloupce oblasti buněk. V databázové terminologii se jedná o databázovou tabulku složenou ze 
záznamů (jednotlivých zákazníků), u nichž se evidují údaje, ukládané do jednotlivých polí daného záznamu. 

Nad databázovou tabulkou (na listu se jí říká seznam) se v databázových systémech provádějí určité ty-
pické hromadné akce, které jsou založeny na dotazech. Dotazy se sestrojí buď vizuálně nebo programátor-
sky, čímž se získá definice dotazu. Spuštěním dotazu se pak vykoná požadovaná akce. Dotazy mohou být 
nejrůznějšího druhu. Nejběžnější jsou tzv. výběrové dotazy obracející se na jedinou tabulku nebo na více ta-
bulek či dotazů propojených relací, které jako výsledek akce produkují sadu záznamů. Výsledná sada zá-
znamů může posloužit jsou podklad pro další dotaz. 

Výběrové dotazy nejsou jediným druhem dotazů. Existuje ještě několik dalších. Důležité jsou  zejména 
akční dotazy, jejichž účelem není produkovat sadu záznamů, ale v databázi něco udělat (aktualizovat 
hromadně záznamy, odstranit záznamy, přidat nové záznamy nebo vytvořit novou databázovou tabulku) 
a definiční dotazy, jejichž účelem je měnit strukturu databáze. 

Dvě strategie řešení databázových úloh 
Než se pustíme do konkrétních ukázek, je třeba vědět, že v Excelu lze úlohy databázového charakteru 

řešit mnoha způsoby. Ale bez ohledu na to, rozhodnete-li se pro vizuální řešení nebo pro řešení založené na 
programovacích jazycích, lze nástroje či strategie, které použijete, rozdělit v podstatě do dvou kategorií:  

• Výsledky se získávají prostřednictvím vestavěných technik pro práci s buňkami Excelu a 
prezentují se buď přímo v seznamu nebo v jeho okolí (řazení, filtry, různé souhrny apod.) nebo se 
získávají v podobě speciálních tabulek (například kontingenční tabulky), které se ukládají na 
tentýž list, na němž je seznam, nebo na jiný list. 

• Výsledky jsou založeny, podobně jako v databázových produktech, na výběrovém databázovém 
dotazu SQL, který se sestaví a spustí buď přes speciální pomocnou aplikaci Microsoft Query nebo 
z kódu Visual Basic for Applications (dále VBA). Výsledek spuštěného dotazu jsou externí data. 

Výklad importu externích prvotních dat z různých formátů je v brožuře založen na vizuálních 
technikách Excelu, ale pro potřeby opakovaných akcí se doplňuje o procedury, jimiž je možno z původních 
zdrojů data aktualizovat (nebo obnovit, pokud jste si je nějak narušili). V seznamech vytvořených 
z prvotních tabulek se pak předvádějí různé „databázové“ techniky Excelu. Někdy se jedná o statické kopie 
původních seznamů, které jsou umístěny na samostatných listech, aby se výsledky jednotlivých postupů 
nemíchaly.  

Pro potřeby některých úloh se v brožuře vytvářejí dotazy, které se obracejí na databázové tabulky 
uložené na listech (téhož sešitu nebo jiného sešitu). Tyto seznamy se propojují relacemi a výsledky ukládají 
na nové listy. Je to proto, aby si čtenáři uvědomili, že databázové dotazy, i komplikované, založené na 
relacích, lze vytvářet přímo nad seznamy na listech, že není třeba obracet se pokaždé na původní data 
v databázi, nepotřebujete-li nejčerstvější data. Ale i v takovém případě bude stačit, aktualizovat z databáze 
pouze prvotní seznamy. Kontingenční tabulky budeme také vytvářet z dat nacházejících se na listech sešitu. 
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Scénář ukázek obsažených v brožuře 
Představte si, že jste se dostali do nějaké firmy, v níž náplní práce vaší a vašich spolupracovníků je 

produkovat všelijaké analýzy dat ekonomického či finančního charakteru. Finálními výstupy jsou obvykle 
všelijaké výroční zprávy, grafy a statistické výpočty. Protože se pro tyto účely nejlépe hodí tabulkový 
kalkulátor, pracují vaši spolupracovníci převážně v Excelu. 

První potíž, kterou jste zjistili, je to, že se prvotní data pocházejí z různých zdrojů. Vaším prvním 
úkolem bude, soustředit všechna data pokud možno do jediného sešitu Excelu (vytvořit pro sebe i pro své 
spolupracovníky jakousi výchozí databázi), protože základní techniky práce v Excelu všichni znají, ale 
pracovat s databázemi možná ne. 

Jak se taková databáze v sešitu vytvoří, ukazuje první část brožury s názvem „Vytvoření databáze 
v sešitu Excelu“. Přejdou-li uživatelům techniky importu as exportu do krve, budou moci aktualizace 
provádět poměrně velmi rychle, i když je budou muset provádět „ručně“ například proto, že data občas 
přijdou ne úplně v pořádku a vyplatí se je kontrolovat ještě před importem i v průběhu importu. Možná ani 
nebudete muset vytvářet automatizované procedury pro aktualizace pomocí programového kódu. 

Nejste-li si jisti, zda všichni spolupracovníci umějí využívat základní techniky Excelu určené pro práci 
se seznamy, můžete jim vytvořit ukázkový sešit, v němž budou na jednotlivých listech tyto akce 
předvedeny. Tímto tématem se zabývá část „Základní techniky pro databázové operace“ brožury. 

Podstatou práce s relační databází je vytváření hierarchických výběrů nad databází, tedy získávání sad 
záznamů, které pocházejí z několika tabulek propojených relacemi. Že i tyto úlohy lze řešit snadno přímo 
v sešitu Excelu se ukazuje v části „Databázové dotazy“. Seznámíte se s prostředím vizuálního „návrháře 
dotazů Excelu“, jímž je pomocná aplikace Microsoft Query a sestrojíte několik výběrových dotazů, které 
budou sloužit jako podklad pro další analýzy a tvorbu grafů. Dozvíte se také, že se pomocí Query dají řešit 
i parametrické dotazy, dotazy založené na datech OLAP a dokonce i některé zcela odlišné úlohy, například 
definovat nové databázové tabulky. 

Důležitou součástí databázových operací jsou také tzv. agregované výpočty. Jedná se o výpočty různých 
souhrnů, počtů, průměrů apod. V brožuře uvidíte dva základní způsoby řešení těchto úloh. Zaprvé, pomocí 
zabudovaných technik Excelu jako jsou běžné vzorce, výpočty souhrnů s osnovou (přehledy) nebo 
kontingenční tabulky. Zadruhé, naučíte se tvořit tzv. agregační dotazy SQL, kdy výstupem jsou pouze 
záznamy na zvolené úrovni agregace. 

V části „Pomůcky pro import, pořizování a výpočty“ se dozvíte o několika schopnostech Excelu, které 
mohou podstatě zefektivnit a zpřesnit práci s daty nejen v seznamech, ale v podstatě kdekoli na listech. Patří 
mezi ně automatické vyplňování, podmíněné formátování, ověřování platnosti dat, ale také některé speciální 
schopnosti, které se nacházejí v doplňcích Excelu, jako jsou například Průvodce šablonou se sledováním dat 
nebo možnost přímého propojení sešitu s aplikací Microsoft Access.  

Poznámka. Vstupní tabulky, které se budou importovat na listy, pocházejí z ukázkové databáze 
Northwind, takže si prvotní data můžete jednoduše připravit předběžným exportem z této databáze (návod 
viz list Importovat data sešitu Severní vítr.xls na doprovodném CD). Probírané postupy ale na konkrétních 
datech v podstatě závislé nejsou, takže byste je měli být sto bez potíží vyzkoušet na svých vlastních datech. 
Musíte samozřejmě „hlídat“ cesty a názvy souborů as používat své názvy tabulek a jejich polí. Tabulky 
byste měli také mít předem připravené tak, aby se daly vhodně propojit relacemi.  
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Vytvoření databáze v sešitu Excelu 
Pro import dat z různých formátů. resp. pro export dat do různých formátů, disponuje Excel pohodlnými 

vizuálními technikami, které si vysvětlíme na konkrétních ukázkách. Zároveň se seznámíte s několika 
variantami importu řešenými přes VBA, které by se vám mohly hodit, pokud byste potřebovali import 
opakovat či automatizovat.  

Předpokládejme, že dostáváte nepravidelně několik tabulek, které jsou uložené v různých formátech 
a každou z nich chcete importovat na samostatný list sešitu. V následujících oddílech uvidíte vizuální řešení 
importu z několika běžně používaných formátů. Součástí řešení jednotlivých úloh bude vytvoření takových 
pomocných nástrojů, aby bylo možno import kdykoli později jednoduše zopakovat. Automatickou 
aktualizaci řešenou přes programový kód VBA bude uživatel sešitu spouštět klepnutím na nějaké k tomuto 
účelu sestrojené tlačítko. Tlačítka (případně další potřebné informace a ovládací prvky) budou soustředěna 
na speciálním „řídícím“ listu sešitu. 

Upozornění. Protože následující ukázky importují data, která se vždy nacházejí v jediné databázové 
tabulce, mohl by vzniknout mylný dojem, že složitější data nejde jediným postupem importovat. Na list ale 
můžete dostat najednou zvolenou podmnožinu dat, která jsou uložena v několika tabulkách nebo (u 
některých databází) dokonce v tabulkách a jiných dotazech definovaných v databázi. Ukázky najdete 
v oddílu „Databázové dotazy“.  

Import a export externích dat  
Pomocí ovladačů, které tvoří součást dodávky Microsoft Office, můžete načítat data z těchto zdrojů (da-

tabází): Access, dBASE, FoxPro, Excel, textové soubory, Paradox, SQL Server a služby OLAP SQL Serve-
ru. Existují ovladače i pro mnoho jiných zdrojů dat. Z Exchange či Lotusu 1-2-3 lze načítat z VBA pomocí 
objektů pro přístup k datům. 

Importovat lze mnoha způsoby. Asi nejednodušší je prostě soubor otevřít příkazem Soubor > Otevřít, 
v dialogovém okně Otevřít zvolit typ souboru a klepnout na Otevřít. Pokusíte-li se z Excelu například takto 
přímo otevřít textový soubor, spustí se Průvodce importem textu, s nímž se seznámíte dále a výsledkem 
operace bude nový sešit s importovaným obsahem. My se budeme ale hlavně zabývat „standardními“ 
způsoby importu textových souborů, databázových souborů přes MS Query. Kromě toho uvidíte dvě ukázky 
importu přes technologii objektů pro přístup k datům (ADO). 

Začneme importem z běžných textových souborů a z tabulky uložené na stránce WWW. Pak zkusíme 
importovat tabulku pocházející z xBASE, budeme pokračovat importem seznamu, který se nachází v jiném 
sešitu nějaké starší verze Excelu a skončíme importem z databáze Accessu 2000. (Všechny varianty importu 
jsem do brožury nemohl zařadit kvůli jejímu omezenému rozsahu.) 

Poznámka. Máte-li přístup k Microsoft SQL Serveru a připravíte si odpovídající zdroj dat, budete moci 
pracovat  s daty na SQL Serveru analogicky, jako kdyby to byla databáze Accessu (.mdb). Za těchto před-
pokladů si můžete práci s databázemi SQL Serveru ověřit například pomocí ukázkového projektu Nothwin-
dcs.adp, což je verze populární ukázkové databáze „Severní vítr“ SQL Serveru dodávaná s Accessem 2000 
nebo na ukázkových databázích dodávaných s SQL Serverem (populární je zejména databáze „pubs“ obsa-
hující data o knihách, autorech, vydavatelích atd.) Postup, jak připravíte zdroj dat pro databáze SQL Serve-
ru, najdete na konci oddílu „Výběr či vytvoření zdroje dat“.  
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Import z některých formátů se provádí prostřednictvím pomocné aplikace Microsoft Query verze 2000 
(dále jen MS Query), která je součástí Office. Nemáte-li ji nainstalovanou, zopakujte běh instalačního pro-
gramu a nainstalujte si ji. V této části brožury se výkladem práce ve vývojovém prostředí aplikace 
MS Query zabývat nebudeme. podrobně se s ní seznámíte v části „Databázové dotazy“.  

Při importu mívají někdy uživatelé Excelu potíže se zdrojem dat, který je nutno na začátku procesu 
importu zvolit. Budete-li mít při pokusu o import nějaké těžkosti-například zjistíte, že v dialogovém okně 
Zvolit zdroj dat žádný zdroj nemáte-podívejte se do oddílu „Výběr či vytvoření zdroje dat“na konci této části 
brožury. 

Pro ty čtenáře, kteří ještě import nikdy nedělali, je v příštím oddílu uveden poměrně podrobný postup, 
počínaje otevřením sešitu. V dalších oddílech se uvádí postup podstatně zkrácený. Předpokládá se, že 
soubory pro import jsou uloženy ve složce C:\ExcelDB\VstupníSoubory. 

Exportování dat se provádí obvykle v databázových produktech, ale i Excel poskytuje mnoho jednodu-
chých schopností, které lze chápat jako nástroje pro export. Například, několik příkazů z nabídky Soubor: 
Uložit jako, Uložit jako stránku WWW, ale i Odeslat, některé příkazy z nabídky Úpravy (pro práci se schrán-
kou, Přesunout či zkopírovat list), příkazy z doplňku Propojení s aplikací MS Access apod. Informace 
o tomto doplňku najdete v oddílu „Pomůcky pro import, pořizování a výpočty“. 

Import textového souboru 
Něčím začít musíme. Rozhodl jsem se, že se nejprve vypořádáme s textovými soubory. Při ukládání dat 

databázového charakteru do textových souborů se používají dva základní formáty, které se označují jako 
SDF a DELIMITED. Začneme importem z formátu s pevnou délkou řádku, protože ho považuji za 
nejjednodušší a také automatizované řešení přes VBA je voleno tak, aby se muselo řešit co nejméně 
problémů. 

Import souboru s pevnou délkou řádku (SDF) 
 První textový soubor, z něhož budeme importovat v tomto oddílu, obsahuje data uspořádaná tak, že 

údaje z jednoho záznamu původní databázové tabulky se umístí do jediného řádku textového souboru těsně 
za sebou, bez jakýchkoli oddělovačů a počet znaků, do nichž se uloží hodnota obsažená v jednotlivých po-
lích záznamu tabulky, bude dán délkou pole ve struktuře (návrhu) tabulky.  

Dejme tomu, že máte v tomto formátu uloženy údaje o přepravcích, které chcete importovat na nějaký 
list sešitu. Postup: 

1. Spusťte Excel. V sešitu s výchozím názvem Sešit1 dvojitě klepněte na záložku nějakého listu a 
výchozí název přepište na Přepravci. (Nevidíte-li záložky listů, zvolte Nástroje > Možnosti, 
v dialogovém okně Možnosti klepněte na záložku Zobrazení a zaškrtněte políčko Ouška listů.) 

2. Protože si pro pozdější potřeby chcete proces importu zaznamenat, zvolte Nástroje > Makro > 
Záznam nového makra. V dialogovém okně Záznam makra přepište výchozí název Makro1 na 
lépe vypovídající, například ImportSDF a klepněte na OK. 

Na pracovní ploše se objeví malý panel nástrojů Zastavit záznam se dvěma tlačítky. První ( ) 
slouží k zastavení záznamu, druhé, Relativní odkaz, umožňuje určit, zda se budou zaznamenávat 
absolutní nebo relativní adresy buněk.  

3. Zvolte Data > Načíst externí data > Importovat textový soubor. V dialogovém okně Importovat 
textový soubor vyhledejte složku obsahující textový soubor (dejme tomu, že se jmenuje 
Přepravci.txt) a klepněte na Importovat. 

Excel spustí průvodce importem textu a oznámí, co zjistil. Viz obrázek na další straně. 
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V prvním kroku obvykle 
nemusíte dělat nic jiného, 
než zkontrolovat v oblasti 
Náhled souboru, zda data 
alespoň přibližně 
odpovídají.  

 

V našem případě zjistíte, že 
přepínač je ve správné 
poloze a soubor přímo 
začíná daty, takže import 
začne na řádku 1 

4. Klepněte na Další. Ve druhém kroku je třeba zkontrolovat a podle potřeby upravit rozhraní 
jednotlivých polí. 

 

Protože průvodce zjistil mezi 
směrovacími čísly a vlastními 
telefonními čísly mezery, 
považuje tato trojčíslí 
v závorkách za samostatné pole.  

Protože vy ale chcete celé 
telefonní číslo uložit jako jediný 
údaj, odtáhněte prostě oddělovací 
čáru myší ven z oblasti náhledu 

5. Klepněte na Další. Ve třetím kroku můžete explicitně stanovit formát jednotlivých sloupců.  

6. Klepněte ve sloupci a vyberte polohou přepínače.  

Naše tabulka je velmi jednoduchá (nemáme v ní ani datum, ani skutečné číselné údaje), takže 
v podstatě žádné úpravy dělat nemusíte. V této ukázce jsme pro druhé a třetí pole zvolili formát 
Text. Důležitá je ale možnost neimportovat zvolený sloupec. Tu byste měli využít v situaci, když 
údaje z některého sloupce nepotřebujete nebo když jsou v některých sloupcích evidentní nesmysly, 
ale vy potřebujete data zpracovat rychle (klíčová data jsou dejme tomu v jiných sloupcích, a ty jsou 
v pořádku) a nemáte čas nebo chuť původní soubor reklamovat. 

7. Klepnete-li na Upřesnit, můžete ještě pro jednotlivé sloupce zvolit znak pro oddělovače 
desetinných míst a (nebo) tisíců (v naší zemi je to čárka resp. mezera). Viz obrázek na další 
straně: 
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8. Klepněte na Dokončit. Dostanete se do dialogového okna Importovat data. Jak vidíte na dalším 

obrázku, chce Excel, abyste potvrdili nebo určili místo, kam se mají chcete data vložit. 

 

Nabídne adresu té buňky, která 
byla aktivní, když jste proces 
importu zahájili. 

Zde to byla buňka G14 
(orámovaná silnou čárou 
s úchytem v pravém dolním 
rohu) na listu Přepravci. Uživatel 
ji už změnil na A12 na tomtéž 
listu (orámovaná běhajícím 
čárkovaným obdélníkem). 

 

9. Buňku levého horního rohu oblasti, do níž se vloží importovaná data, lze určit klepnutím 
v buňce nebo ukázáním. Klepnete-li na tlačítko s červenou šipkou v pravém okraji textového 
pole, dialogové okno se smrskne. Pak můžete pohodlně vybrat oblast na jakémkoli místě 
v sešitu. Až budete s výběrem hotovi, klepněte opět na tlačítko se šipkou. Adresa vybrané 
oblasti se objeví v textovém poli.  

10. Zvolíte-li polohu přepínače Nový list, vloží se importovaná data od buňky A1 na list, který 
Excel do sešitu přidá. Poloha Kontingenční tabulka je nepřístupná, protože nevytváříme 
kontingenční tabulku, ale seznam. 

Poznámka. Vstupní data nebo sady záznamů vzniklé jako výsledky databázových dotazů budeme na 
listy umisťovat jednotně od buňky A11 (v něm bude předpokládané nebo importované záhlaví 
seznamu). Jak uvidíte později, při práci se seznamy občas potřebujete mít na listu ještě nějaké jiné 
údaje, a obvykle je vhodné, když se tyto údaje nacházejí nad seznamem nebo pod ním (viz například 
oddíl zabývající se filtrováním seznamů).  
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Mě osobně připadá pozice nad seznamem výhodnější, a to nejméně ze dvou důvodů. Když uživatel 
zobrazí obsah listu, obvykle začíná nahoře, takže by všechny podstatné informace měl vidět ihned. 
Nacházejí-li se informace nad seznamem, nemusíte také řešit problém, co s nimi, když se budou do 
seznamu přidávat nové záznamy. 

11. Klepnutím na tlačítko Vlastnosti můžete zobrazit poměrně obsáhlé dialogové okno Vlastnosti 
oblasti externích dat, jímž se v této ukázce zabývat nebudeme. Vrátíme se k němu později 
v oddílu „Import z databáze Accessu“, kdy už budeme mít všechny klíčové problémy importu 
za sebou. Chcete-li zjistit význam jednotlivých ovládacích prvků v tomto dialogovém okně 
hned, klepněte na tlačítko s otazníkem v titulkovém pruhu dialogového okna a klepněte na 
ovládacím prvku. Zobrazí se okénko s nápovědou. 

12. Máte-li vhodně vybranou buňku pro levý horní roh oblasti, klepněte v dialogovém okně 
Importovat data na OK. Data se vloží na list. 

13. Dopište do řádku 11 vhodná záhlaví sloupců, například Číslo přepravce, Firma a Telefon. 

14. Nezapomeňte teď zastavit zaznamenávání makra, takže klepněte na tlačítko  na panelu 
nástrojů Zastavit záznam. 

Zkontrolujte, mají-li jednotlivá pole takový formát, který jste zvolili při práci s průvodcem (vyberte 
buňku a zvolte Formát > Buňky). Dále si všimněte, že se na list také přidal název oblasti exportovaných dat. 
Rozviňte seznam Pole názvů a vyberte z něj název Přepravci. Vyberete tím oblast, kterou jste právě 
importovali. (Seznam Pole názvů se nachází zcela vlevo na řádku vzorců. Nevidíte-li řádek vzorců, zvolte 
Zobrazit > Řádek vzorců.)  

Automatizace importu z formátu SDF 
Makra se zaznamenávají do standardního modulu, který se přidá do projektu VBAProject, s nímž 

v Excelu pracujete. S makry pracujete v aplikaci Visual Basic, do níž se můžete dostat mnoha různými způ-
soby,. Přechod do této aplikace zajišťuje kombinace kláves Alt+F11, resp. její ekvivalentní příkaz Nástroje > 
Makro > Editor jazyka Visual Basic.  

Strukturu projektu uvidíte v okně průzkumníka projektu. Nevidíte-li je, vydejte příkaz View > Project 
Explorer. (Aplikace Visual Basic není počeštěná.) Pod složkou VBAProject(Sešit1) najdete složku 
Modules, v ní prvek Module1. Když na něm dvojitě klepnete, zobrazí se okno kódu s naším 
zaznamenaným makrem ImportSDF. 

Druhá běžná cesta je, že v Excelu zvolíte Nástroje > Makro > Makra. V dialogovém okně Makro 
vyberete makro, které chcete upravovat a klepnete na Upravit.  

Protože jste si celý postup zaznamenali jako makro, můžete kód makra, což není nic jiného než 
procedura Sub Visual Basicu využít jako kostru pro výslednou proceduru, jejímž zavoláním budete moci 
import zopakovat. Proceduru budete spouštět klepnutím na tlačítko, které umístíte na zvláštní list, který si 
pro tyto účely můžete vyhradit. 

Ovládací prvky na listu 
Některé ovládací prvky lze na listech Excelu sestrojovat dvojím způsobem, buď přes panel nástrojů 

Formuláře (jednodušší), nebo přes panel nástrojů Ovládací prvky (modernější a bohatší možnosti). Abyste 
si mohli vybrat na základě konkrétní zkušenosti, popíšu v tomto oba oddílu oba způsoby. V dalších ukáz-
kách brožury už budeme pracovat pouze s panelem Ovládací prvky. 

1. Přejmenujte nějaký volný list na Importovat data. (Nemáte-li už v sešitu volný list, vyberte list, 
před který chcete nový list vložit a zvolte Vložit > List)  
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2. Buď 

• Klepněte pravým tlačítkem myši na některém viditelném panelu nástrojů (včetně pruhu nabídek) 
a z místní nabídky zvolte Formuláře. Klepněte na ovládací prvek Tlačítko a klepněte na vhodném 
místě na listu. V dialogovém okně Přiřadit makro vyberte název zaznamenaného makra (v našem 
případě ImportSDF) a v seznamu dole vyberte tento sešit a klepněte na OK Přepište výchozí ná-
zev tlačítko 1 na vypovídající, například Přepravci. Tažením úchytů upravte velikost tlačítka, 
klepněte na něm pravým tlačítkem myši a z místní nabídky zvolte Ukončit úpravu textu. Příkaz 
Formát ovládacího prvku by vás dovedl do dialogového okna Písmo, v němž můžete zvolit atribu-
ty textu zobrazeného na tlačítku. Tlačítko máte připravené už dokonce s přiřazeným makrem. Bu-
dete-li chtít makro upravit, vyberte tlačítko (aby okolo něj byly úchyty) a klepněte na tlačítko 
Upravit kód panelu Formuláře.  

  Nebo 
• Klepněte pravým tlačítkem myši na některém viditelném panelu nástrojů (včetně pruhu nabídek) 

a z místní nabídky zvolte Ovládací prvky. Klepněte na ovládací prvek Příkazové tlačítko a klepněte 
na vhodném místě na listu. Tažením úchytů upravte velikost tlačítka, klepněte na něm pravým tla-
čítkem myši a z místní nabídky zvolte Vlastnosti. Přepište hodnotu vlastnosti Name na cmdPře-
pravci a titulek tlačítka (hodnotu vlastnosti Caption) třeba na Přepravci. Vlastnost Font by vás 
dovedla (po klepnutí v ní a klepnutí na tlačítko „tři tečky“) do dialogového okna Písmo, v němž 
můžete zvolit atributy textu zobrazeného na tlačítku. Chcete-li přiřadit makro tlačítku sestrojené-
mu přes panel ovládacích prvků, klepněte na panelu Ovládací prvky na tlačítko Režim návrhu, 
klepněte pravým tlačítkem myši na tlačítku a z místní nabídky zvolte Zobrazit kód. Dostanete se 
do kostry událostní procedury Click tlačítka v rámci modulu listu, do něhož jste tlačítko umístili. 
Do těla procedury zkopírujte (přes schránku) obsah vygenerovaného makra (bez příkazů Sub a 
End Sub). Budete tedy upravovat kopii makra a kdykoli se budete moci vrátit k původnímu tva-
ru.  

Makro zaznamenané jako výsledek konkrétních akcí je polotovarem, který většinou pro obecné potřeby 
nevyhovuje a musí se proto upravit. V dalších postupech budeme využívat pouze ovládací prvky z panelu 
ovládací prvky a budeme předpokládat, že umíte najít kód makra a dostat se do kostry událostní procedury 
Click tlačítka umístěného na list. 

Podrobný rozbor kódu uvedeného zde i v dalších ukázkách přesahuje rámec a hlavně kapacitní možnosti 
brožury. Potřebujete-li nápovědu k nějakému programovacímu prvku, vyberte ho v kódu a stiskněte F1. Mě-
li byste se dostat přímo do nápovědy Visual Basicu k tomuto prvku. Nemáte-li nápovědu Visual Basicu do-
stupnou (není to součást tzv. typické instalace Office), budete muset ještě jednou spustit instalační program 
Office a nápovědu VBA doinstalovat. 

3. Makro bychom mohli například zobecnit tím, že by si uživatel mohl zadat cestu a název soubo-
ru, který chce importovat. Jednoduchý způsob poskytuje funkce InputBox Visual Basicu, al-
ternativní způsob najdete v příštím oddílu: 

NázevSouboru = InputBox("Zadejte název souboru", "Import SDF souboru", _ 
   "C:\ExcelDB\VstupníSoubory\Přepravci.txt") 
If "" = Dir(NázevSouboru) Then 
   MsgBox ("Chybný název souboru nebo chybná cesta nebo soubor na cestě chybí") 
        Exit Sub 
End If 
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4. Uživatel by mohl obdobně zadat i adresu buňky levého horního rohu oblasti: 
LevýHorníRoh = InputBox("Zadejte buňku levého horního rohu cílové oblasti dat 
(nad ním budou vytvořena záhlaví polí)", _ 
    "Import SDF souboru - levý horní roh", "A12") 
If "" = LevýHorníRoh Then 
    MsgBox ("Nezadaná adresa buňky nebo chybná adresa") 
    Exit Sub 
End If 
' Zapnutí chybové rutiny nebo test, zda je oblast platná 
Range(LevýHorníRoh).Select 
   If ActiveCell.Row <= 1 Then 
    MsgBox ("Zadaná adresa musí být od 2. řádku výš") 
    Exit Sub 
End If 

5. Další záležitost se týká opakovaných importů. Jedna z variant řešení (jiné uvidíte v příštích 
ukázkách) může spočívat v tom, že pokud už v sešitu existuje list s názvem Přepravci, tak se 
odstraní, přidá nový na konec sešitu a data se vždy importují do nového listu: 

If ExistujePracovníList(NázevListu) Then 
   MsgBox "List " & NázevListu & " existuje, odstraní se, vytvoří nový na konci" 
'   Potlačí se na chvíli zobrazení okna výzvy 
   Application.DisplayAlerts = False 
   Worksheets(NázevListu).Delete 
   Application.DisplayAlerts = True 
End If 
 
'   přidá se nový list na konec sešitu, aktivuje a přejmenuje 
Worksheets.Add After:=Worksheets(Worksheets.Count) 
Worksheets(Worksheets.Count).Activate 
Worksheets(Worksheets.Count).Name = NázevListu 
 

ExistujePracovníList je vlastní funkce, jejíž umístění či obor zvolte podle toho, jakým procedurám 
má být přístupná:  
Public Function ExistujePracovníList(ByVal NázevListu As String) As Boolean 
Dim PracovníList As Worksheet 
ExistujePracovníList = False 
For Each PracovníList In Worksheets 
        If PracovníList.Name = NázevListu Then 
             ExistujePracovníList = True 
             Exit For 
         End If 
Next 
End Function 
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6. Nyní se konečně dostaneme ke kódu původně vygenerovaného makra. Za předpokladu, že máte 
někde na začátku deklaraci: 

Dim DotazováTabulka As QueryTable 
7. můžete kód vygenerovaného makra upravit takto: 

     Set DotazováTabulka = ActiveSheet.QueryTables.Add(Connection:= _ 
        "TEXT;" & NázevSouboru, _ 
         Destination:=Worksheets(NázevListu).Range(LevýHorníRoh)) 
     With DotazováTabulka 
'  Takto se bude jmenovat oblast externích dat na listu: 
        .Name = Název 
'  Typ zpracovávaného souboru 
        .TextFileParseType = xlFixedWidth 
'  Nastavení dalších charakteristik dotazové tabulky, z nichž některé lze  
'  odstranit, protože mají výchozí hodnoty. Je ale lepší je jen prohlásit za  
'  komentář. Co kdybyste je později potřebovali upravit. 
'  Import začíná na řádku TextFileStartRow: 
        .TextFileStartRow = 1 
'  Datové typy sloupců (obecný, text, text): 
        .TextFileColumnDataTypes = Array(1, 2, 2) 
'  Šířky sloupců – měly by být v podstatě podle originální dokumentace 
'  Předpokládá se, že vstupní soubory budou správné, nikoli vždy nějak zmršené 
'  Pokud je velké nebezpečí, že budou, importujte raději "ručně" 
      .TextFileFixedColumnWidths = Array(11, 40, 24) 
'  Metodou Refresh se aktualizuje dotazová tabulka 
       .Refresh BackgroundQuery:=False 
    End With 
 

8. Ještě by bylo vhodné přidat nějakým způsobem automaticky záhlaví sloupců: 
    ActiveSheet.Range(LevýHorníRoh).Select 
    ActiveCell.Offset(rowOffset:=-1, columnOffset:=0).Activate 
    ActiveCell.Value = "Číslo přepravce" 
    ActiveCell.Offset(rowOffset:=0, columnOffset:=1).Activate 
    ActiveCell.Value = "Firma" 
    ActiveCell.Offset(rowOffset:=0, columnOffset:=1).Activate 
    ActiveCell.Value = "Telefon" 

Vlastnost Offset objektu Range připomínám proto, že je to velmi šikovný prostředek, jak získat oblast, 
která je vzhledem k aktivní oblasti (zde aktivní buňce) posunuta o stanovený ofset, neboli počet řádků 
a sloupců. Záporná čísla znamenají nahoru a vlevo, kladná dolů a doprava. Za předpokladu, že jsou impor-
tovaná data uložena v oblasti s levým horním rohem A12, naplní se buňky A11, B11 a C11. 

Kolekce QueryTables objektů QueryTable představuje tabulky (seznamy) na listech vytvořené z dat, 
které byly získány pomocí  externího zdroje dat. Další informace o metodě Refresh a způsobu  aktualizace 
viz oddíl „Import tabulky dBASE“. 
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Převod textu do sloupců 
Při importu ne zcela dobře či jednotně formátovaných textových souborů obsahujících seznamy si ně-

kdy můžete vypomoci dodatečnou etapou, při níž využijete schopnost Excelu, které se říká Převod textu do 
sloupců. Vypořádáme se s ní hned teď, pomocí našich importovaných dat. 

Dejme tomu, že jste po prohlédnutí importovaných dat usoudili, že byste přeci jen chtěli mít směrovací 
čísla a telefonní čísla zvlášť. Držte se následujícího postupu. Pracuje s dialogovými okny, která se velmi 
podobají oknům průvodce importem textu, s nimiž jste pracovali výše. 

1. Vyberte sloupec, který chcete rozdělit do více sloupců (v našem případě oblast C12:C14) 
a zvolte Data > Text do sloupců.  

2. V dialogovém okně Průvodce převodem textu do sloupců vyberte polohu přepínače Pevná šířka 
a klepněte na Další. V dalším okně byste měli jen zkontrolovat oddělovací čáru, která by měla 
být na správném místě. Klepněte na Další. 

3. Formát pro oba sloupce zvolte text (jinak se mohou závorky okolo 503 chápat jako symboly 
záporného čísla, což by znamenalo, že by se v prvním  výsledném sloupci objevilo znaménko 
mínus. Kromě toho se vlastně nejedná o čísla, s nimiž byste chtěli něco počítat. V takových 
případech bývá všeobecně formát text vhodnější.) 

4. Do textového pole Cíl napište (raději zvolte ukázáním) levý horní roh cílové oblasti. Pak 
klepněte na Dokončit. 

Na závěr ještě jedna drobnost, abyste ji náhodou nepřehlédli. Jestliže jste zjistili, že jste text do sloupců 
umístili jinak, než jste chtěli (například jste nezvolili cíl oblasti, takže se vám obsah sloupce C rozdělil do 
sloupců C a D), můžete (nejlépe ihned) celou akci vrátit pomocí tlačítka Zpět na panelu Standardní.  

Tuto techniku byste mohli využít v mnoha analogických (i složitějších) situacích. Pro rozčlenění 
sloupce, který obsahuje křestní jména a příjmení, celou adresu apod.  

Import textového souboru s oddělovači 
Druhým, patrně nejobvyklejším typem textového souboru, je formát DELMITED. Jednotlivé řádky tex-

tového souboru nejsou stejně dlouhé, prvky dat jsou oddělovány zvoleným oddělovačem prvků, textové ře-
tězce bývají uzavřeny v kvalifikátoru uvozovky a je tu ještě několik drobností, s nimiž se seznámíte 
v průběhu importu na údajích objednávek. 

Nedostáváte-li současně s textovým souborem nějakou dokumentaci o tom, jak má vypadat, měli byste 
si před pokusem o import soubor otevřít v nějakém textovém editoru a zkontrolovat, zda jsou data správně. 
Je-li nějaký záznam chybný, je to někdy vidět na první pohled-například řádek nezačíná číslem objednávky. 
Pak se pokuste z jednotlivých dat odhalit tvar data a apod. Bude se vám to při práci v průvodci hodit. 

1. V sešitu, v němž právě pracujete, pojmenujte nějaký prázdný list Objednávky. Opět budete 
postup zaznamenávat, takže zvolte Nástroje > Makro > Záznam nového makra, makro 
pojmenujte například ImportDLM a klepněte na OK. 

2. Zvolte Data > Načíst externí data > Importovat textový soubor, vyhledejte textový soubor 
(dejme tomu, že se jmenuje Objednávky.txt) a klepněte na Importovat.  

Excel spustí jako v předchozí ukázce Průvodce importem textu a oznámí, že se jedná o soubor 
s oddělovači.  

3. Klepněte na Další. Ve druhém kroku je třeba nastavit oddělovače (podle dokumentace, kterou 
jste obdrželi se souborem, ale raději je zkontrolujte v oblasti náhledu). Viz obrázek: 
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Především si všimněte, že na prvním 
řádku souboru se nacházejí záhlaví 
sloupců, takže  (podobně jako ve všech 
dalších ukázkách) odpadne dodatečné 
pojmenování importovaných sloupců na 
listu.  
 
Údaje o datu obsahují i čas, který si 
mohla dodávající organizace odpustit.  
 
 

Navíc jste v prvním kroku průvodce zjistili, že oddělovačem prvků v záznamech není nabízený 
tabulátor, ani středník (výchozí oddělovač v Česku), protože data možná pocházejí z anglické databáze nebo 
tak prostě oddělovače zvolil člověk, který data vytvořil. Všechny rozdíly mezi nabízenými hodnotami a 
skutečností je třeba napravit. Proto: 

4. V oblasti Oddělovače zaškrtněte políčko Čárka, odškrtněte políčko Tab a v rozvíracím seznamu 
Textový kvalifikátor vyberte jednoduchý apostrof. Náhled dat se změní, takže budete moci 
zkontrolovat, zda jsou všechny oddělovací čáry správně. Viz příští obrázek. Až budete hotovi, 
klepněte na Další. 

Podobně jako při importu ze souboru s pevným formátem se v třetím kroku průvodce stanovují 
datové typy sloupců budoucího seznamu. Protože máme v souboru položky obsahující datum, je 
třeba zkontrolovat, v jakém je tvaru a správně je nastavit. Z dat v náhledu nemusí být vůbec jasné, 
zda jsou data ve formátu den, měsíc, rok nebo měsíc, den, rok. V naší ukázce je sice oddělovačem 
položek data lomítko, ale datum je přesto uloženo ve tvaru den, měsíc a čtyřmístný rok. 

5. Přepněte u všech položek obsahujících datum přepínač Formát dat ve sloupcích do polohy 
Datum a ze seznamu vpravo vyberte DMR. Nastavte u všech položek obsahujících texty datový 
typ na text.  

6. U zbylých (vesměs číselné položky) ponechejte výchozí typ obecný, ale pokud se 
v importovaných datech vyskytují pole obsahující desetinná čísla (zde se jedná jen o pole Do-
pravné) je třeba ještě nastavit správně symbol pro desetinná místa. Klepněte na Upřesnit, vyber-
te ze seznamu Oddělovač desetinných míst tečku a klepněte na OK.  

 
7. Klepněte na Dokončit. V dialogovém okně Importovat data vyberte buňku levého horního rohu 

cílové oblasti (A11) a klepněte na OK.  
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Data se vloží na list. První řádek bude obsahovat záhlaví a v listu se také objeví definovaný název 
Objednávky, který bude zahrnovat i řádek záhlaví. Projděte alespoň letmo řádky seznamu. Zdá-li se vám, že 
je vše v pořádku, můžete přikročit podobně jako v předchozím importu k automatizaci postupu. 

Automatizace importu z formátu DELIMITED 
Začátek postup je analogický jako v oddílu „Automatizace importu z formátu SDF“ uvedeném výše. Za 

předpokladu, že máte zaznamenaný postup a na vhodném listu připravené příkazové tlačítko, můžete se 
pustit do úpravy vygenerovaného kódu a napsat událostní proceduru Click daného tlačítka. Některé části 
procedury ale budeme sestrojovat jinak než v předchozím příkladu. 

1. Cestu a název souboru uživatel přijímal resp. modifikoval do textového pole dialogovém okna 
InputBox. Předpokládáte-li, že se budou vstupní soubory nacházet na různých místech, musel 
by uživatel často psát ručně dlouhé cesty, a určitě by se mu je téměř nikdy nepodařilo napsat 
bez chyby. Pro je v takových případech lepší, poskytnout mu společné dialogové okno Otevřít, 
ať si složku a soubor najde. Místo volání InputBox dejte do procedury kód podobný tomuto: 

NázevSouboru = Application.GetOpenFilename("Textové soubory (*.txt), *.txt", _ 
   , "Vybrat textový soubor pro import", "Vybrat", False) 
If NázevSouboru = False Then 
   MsgBox ("Klepli jste na Strono, patrně nechcete nic importovat.") 
   Exit Sub 
End If 
If NázevSouboru = "" Or "" = Dir(NázevSouboru) Then 
   MsgBox ("Chybný název souboru nebo chybná cesta nebo soubor chybí") 
    Exit Sub 
End If 

Dialogové okno Otevřít se v Excelu zobrazuje metodou GetOpenFile objektu Application. První 
parametr určuje, co se zobrazí v rozvíracím seznamu Soubory typu, druhý masku pro soubory zobrazené 
v dialogovém okně a třetí nápis v titulkovém pruhu dialogového okna. Čtvrtý má určovat nápis na tlačítku 
Otevřít, ale funguje to bohužel jen na Macintoshích. Pátý určuje, zda se může nebo nemůže (False, výcho-
zí) současně vybrat více souborů. 

Jestliže uživatel opustí dialogové okno Otevřít klepnutím na Storno, vrátí se hodnota False, jinak název 
souboru, který uživatel vybral. 

2. V prvním importu jsme postupovali tak, že jsme importovali vždy na nový list, což u objem-
nějších dat nemusí být zrovna hospodárné a kromě toho vznikají potíže, pokud byste chtěli na 
list ukládat i něco jiného než importovanou tabulku. V tomto importu proto žádný list odstra-
ňovat nebudeme, mírně upravený test existence daného listu ale ponecháme: 

If Not ExistujePracovníList(NázevListu) Then 
'  Zpráva uživateli, vytvoření a aktivace listu na konci sešitu 
End If 

3. Jestliže list Objednávky existuje, patrně už na něm importovaná data budou a v takovém 
případě není třeba importovat znovu, stačí jen data aktualizovat: 

If ActiveSheet.QueryTables.Count > 0 Then 
   ActiveSheet.QueryTables(1).Refresh BackgroundQuery:=False 
Else 
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   Set DotazováTabulka = ActiveSheet.QueryTables.Add(Connection:= _ 
     "TEXT;C:\ExcelDB\VstupníSoubory\Objednávky.txt", _ 
      Destination:=ActiveSheet.Range("A11")) 
   With DotazováTabulka 
'  Takto se bude jmenovat oblast externích dat na listu: 
      .Name = Název 
'   Typ zpracovávaného souboru (toto je výchozí hodnota) 
      .TextFileParseType = xlDelimited 
'   Některá další nastavení: 
'   oddělovač Tab a středník vypnuté, čárka zapnutá: 
      .TextFileTabDelimiter = False 
      .TextFileSemicolonDelimiter = False 
      .TextFileCommaDelimiter = True 
'   Datové typy sloupců (obecný =1, text = 2 a datum = 4): 
      .TextFileColumnDataTypes = Array(1, 2, 1, 4, 4, 4, 1, 1, 2, 2, 2, 2, 2, 2) 
'  Oddělovač desetinných míst: 
      .TextFileDecimalSeparator = "." 
      .Refresh BackgroundQuery:=False 
    End With 
End If 

Výše uvedený kód předpokládá, že je na listu nejvýše jediná dotazová tabulka a buňka levého horního 
rohu pro importovaný seznam je stanovena „natvrdo“–A11. Chcete-li potlačit zobrazování času, který je stá-
le nulový, dá se to udělat naformátováním patřičných buněk nebo rovnou celých sloupců. Buď vizuálně ne-
bo zařazením příkazů, které to zařídí v kódu: 
ActiveSheet.Columns("D:F").EntireColumn.Select 
Selection.NumberFormat = "d. mmmm yyyy" 

Chcete-li, zkuste kód zobecnit tak, aby byl nezávislý na konkrétních buňkách. Sloupce s položkami 
obsahující datum jsou tři a se nacházejí se o tři sloupce napravo od levého horního rohu oblasti pro seznam. 

Potíže při importu textového souboru s oddělovači 
Nedostanete-li soubor s očekávanými oddělovači nebo s údaji zapsanými podle nějakých zvláštních 

konvencí, mohou při importu vznikat různé potíže. Někteří lidé mívají v takových situacích nutkání otevřít 
soubor v textovém editoru a pokouší se pomocí hledání a nahrazování soubor „spravit“. Nezdá se mi, že by 
byla tato cesta vždy nejvhodnější. Osobně si myslím, že je lepší, importovat data ve stavu, v jakém se je 
vám podařilo rozdělit do polí a u všech podezřelých nebo sloučených nebo evidentně nesprávných polí 
zvolit datový typ text. Pak se pokuste data opravit na listu některou z technik bohatého arzenálu Excelu. 

První příklad – datum se nerozpozná jako datum 
Dostanete-li soubor, který obsahuje v některých sloupcích data ve formátu měsíc, den, rok, nepomůže 

při importu (alespoň v kopii Excelu 2000, s níž pracuji, se průvodce importem textu tak chová) navolit 
v druhém kroku odpovídajícím způsobem datum, protože Excel prostě jako datum hodnotu 6/17/1998, ani 
6.17.1998 nerozpozná a naformátuje ji jako text.  
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Jestliže se vám to stalo a na listu máte takový sloupec (navíc vzadu ještě s časem 0:00:00), vzniká otáz-
ka, jak tato data převést na tvar den, měsíc, rok (a zároveň odstranit čas a převést lomítka na tečky). 
V textovém editoru to půjde obtížně, protože lomítka se mohou vyskytovat i v jiných textech, tečky zase 
mohou znamenat něco jiného, takže převod lomítek na tečky by mohl způsobit katastrofu. Navíc, data jsou 
už na listu, oddechli jste si, že jste s importem konečně prorazili a nechcete to dělat znovu.  

Kdo rád pracuje se vzorci, může sáhnout po nich. Za předpokladu, že testujete obsah buňky B2, najdete 
v textu první lomítko zleva vzorcem =NAJÍT("/";B2;1) a druhé lomítko zleva vzorcem: 
=NAJÍT("/";B2;NAJÍT("/";B2;1)+1) 

Uložíte-li si výsledky dejme tomu do buněk F2 a G2, dostanete přehozené datum vzorcem: 
=ČÁST(B2;F2+1;(G2-F2))&ZLEVA(B2;F2)&ČÁST(B2;G2+1;NAJÍT(" ";B2)-G2) 

Nahradíte-li odkazy na buňky F2 a G2, přidáte výběr roku (až do první mezery) a nahradíte lomítka 
tečkami, dostanete následující „monstrvzorec“: 
=DOSADIT(ČÁST(B2;NAJÍT("/";B2;1)+1;(NAJÍT("/";B2;NAJÍT("/";B2;1)+1)-
NAJÍT("/";B2;1)))&ZLEVA(B2;NAJÍT("/";B2;1))&ČÁST(B2;NAJÍT("/";B2;NAJÍT("/";B2;1)+
1)+1;NAJÍT(" ";B2)-NAJÍT("/";B2;NAJÍT("/";B2;1)+1));"/";".") 
 

 

 
Výsledný vzorec zkopírujte směrem dolů na úroveň 
poslední buňky seznamu, zkopírujte výběr do schránky, 
vyberte původní sloupec textů, zvolte Vložit > Jinak, v 
dialogovém okně Vložit jinak přepněte přepínač do polohy 
Hodnoty a klepněte na OK. 
 
V oblasti operace můžete dokonce například určit, aby se 
hodnoty vkládaných buněk sečetly s hodnotami v cílových 
buňkách. 
 
Políčko Transponovat umožňuje při vkládání zaměnit řádky 
za sloupce. 
 

 
Až budete s akcemi hotovi, můžete pomocné oblasti se vzorci odstranit. Vše můžete pochopitelně také 

zaznamenat jako makro, pokud byste chtěli i tuto část zpracování automatizovat. 
Někdo dá možná přednost řešení přes vlastní funkci VBA, která nevypadá tak odstrašujícím způsobem, 

zpracování pomocí funkcí VBA bývá ale podstatně pomalejší než přes (byť i velmi komplikované) vzorce: 
Function ZaměnitDatum(ByVal řetězec As String) As String 
Dim I1 As Integer, I2 As Integer, I3 As Integer 
Application.Volatile 
I1 = InStr(1, řetězec, "/") 
I2 = InStr(I1 + 1, řetězec, "/") 
I3 = InStr(1, řetězec, " ") 
ZaměnitDatum = Left(řetězec, I1) & _ 
   Mid(řetězec, I1 + 1, I2 - I1) & Mid(řetězec, I2 + 1, I3 - I2) 
End Function 
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Poznámka. Volatile je metoda objektu Application, která má účinek jen uvnitř vlastních funkcí lis-
tu. Způsobí, že se taková vlastní funkce musí přepočítat vždy, když proběhne nějaký výpočet v jakékoli 
buňce na listu (jinak se funkce přepočítává jen tehdy, když se mění vstupní proměnné). Připomínám, že vzo-
rec, resp. vlastní funkce uvedené výše řeší obecnější úlohu, protože dané zadání lze snadno zobecnit na vý-
skyt jakéhokoli znaku, ne pouze lomítka. Řešení je také nezávislé na tom, co se nachází v textu za datem 
a kolika číslicemi je vyjádřen rok. 

Druhý příklad – hodně sloupců makra smrt 
Někteří uživatelé rádi importují tak, že prostě textový soubor otevřou jako nový sešit příkazem Soubor > 

Otevřít. Když si tuto činnost zaznamenají jako makro, může se stát, že je nebudou moci spustit, protože Vi-
sual Basic oznámí, že je „příliš mnoho pokračovacích řádků“. Co to znamená a jak z toho? Jedna cesta spo-
čívá v tom, že tento postup používat nebudete a data budete importovat zásadně přes Data > Načíst externí 
data > Importovat textový soubor.  

Spravit se dá ale i vygenerované nefunkční makro volající metodu OpenText. U importovaných soubo-
rů které obsahují poměrně hodně polí (až 256), může při generování makra nastat situace, že se překročí 
maximální povolený počet pokračovacích řádků příkazu. Makro pak vypadá zhruba takto: 
Workbooks.OpenText Filename := "C:\ExcelDB\VstupníSoubory\DlouhýDELIMITED.txt" _ 
   , Origin := xlWindows, StartRow := 1, DataType := xlDelimited, TextQualifier _ 
   := xlDoubleQuote, ConsecutiveDelimiter := FALSE, Tab := TRUE, _ 
      Semicolon := TRUE  , Comma := FALSE, Space := FALSE, Other := FALSE, _ 
FieldInfo := Array(Array(1,1) _ 
,Array(2,1),Array(3,1),Array(4,1),Array(5,1),Array(6,1),Array(7,1),Array(8,1), _ 
' atd. až do zblbnutí: 
 Array(124,1),Array(125,1),Array(126,1),Array(127,1),Array(128,1),Array(129,1), _ 

Chcete-li za každou cenu textový soubor importovat a zároveň mít k dispozici fungující makro, dá se to 
vyřídit velmi jednoduše. Nezáleží-li vám na datových typech importovaných polí (nevadí, když se použije 
výchozí typ), můžete prostě parametr FieldInfo (a jiné) vyhodit. Celé volání se pak zkrátí na: 
Workbooks.OpenText Filename:="C:\ExcelDB\VstupníSoubory\DlouhýDELIMITED.txt" _ 
   , Origin:=xlWindows, StartRow:=1, DataType:=xlDelimited, TextQualifier _ 
   :=xlDoubleQuote, ConsecutiveDelimiter:=False, Semicolon:=True 

Import tabulek ze stránek WWW 
Posledním importem z textového souboru je přenos tabulek ze souborů uložených ve formátu HTML. 

Soubory tohoto typu se otevírají v prohlížeči, ale formálně je to čistý textový soubor, který si můžete otevřít 
třeba i v Poznámkovém bloku a podívat se, jak jeho zápis vypadá. 

Dejme tomu, že máte v takovém souboru uloženy údaje o dodavatelích. obrázek na příští straně ukazuje, 
jak vypadá tabulka v Internet Exploreru: 
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Součástí tabulky dodavatelů je i jedno pole, v němž se nacházejí hypertextové odkazy, takže vás určitě 

zajímá, zda Excel zvládne import tak, aby se jako odkazy objevily i v patřičné sloupci importovaného 
seznamu. Postup: 

1. Za předpokladu, že máte otevřený sešit, jste na volném listu a případně máte zapnuté 
i zaznamenávání makra, zvolte Data > Načíst externí data > Nový dotaz v síti WWW. Zobrazí se 
dialogové okno Nový dotaz v síti WWW.  

2. Obecně se předpokládá, že budete opravdu hledat na síti, ale importovat můžete pochopitelně 
i data ze souborů uložených na disku (jako v tomto případě). Možnosti dialogového okna a 
tlačítka Upřesnit vidíte na obrázku: 

 
3. Protože chcete zachovat hypertextové odkazy, přepněte spodní přepínač do polohy Úplné 

formátování HTML a klepněte na OK. 

4. V dialogovém okně Importovat data vyberte buňku levého horního rohu cílové oblasti (A11) a 
klepněte na OK. 
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Data se vloží na list v veškerým formátováním buněk. První řádek nebude obsahovat záhlaví sloupců, 
ale centrovaný nápis Dodavatelé převzatý ze stránky WWW. Přejděte k poslednímu sloupci. V několika 
řádcích by měly být hypertextové odkazy na stránky WWW dodavatelů. (V původní tabulce se jedná o pole 
Domovská stránka.) 

Poznámka. Poskytuje-li prohlížeč (jako například Internet Explorer) možnost prohlížet zdrojový kód 
(příkaz Zobrazit > Zdrojový kód), můžete tabulky vyhledat, protože začínají příznakem <TABLE> a končí 
příznakem </TABLE>. Podobně předem formátované oddíly začínají na <PRE> a končí příznakem </PRE>.  

Sestrojený dotaz lze uložit do souboru s příponou .iqy a pak ho třeba parametrizovat v nějakém 
textovém editoru, ovšem za předpokladu, že stránka WWW zadávání parametrů podporuje. Dialogové okno 
Nový dotaz v síti WWW přímo parametrizované dotazy nepodporuje.  

Automatizace importu z formátu HTML 
Zdá-li se vám, že je vše v pořádku, můžete přikročit podobně jako v předchozích importech 

k automatizaci postupu. Jedná se o obdobné techniky jako v předchozích oddílech  Klíčová část vytvářející 
dotazovou tabulku je také analogická: 
Set DotazováTabulka = ActiveSheet.QueryTables.Add(Connection:="URL;" & 
NázevSouboru, Destination:=ActiveSheet.Range("A11")) 
    With DotazováTabulka 
   '  Název a další vlastnosti a metody 
   '  Tímto příkazem se zachová formátování ze stránky WWW: 
      .WebFormatting = xlWebFormattingAll 
    End With 

Import tabulky xBASE 
Import textových souborů teď opustíme a obrátíme se ke skutečným databázím. Import z nich je založen 

na databázových dotazech, při nichž se využívá zdrojů dat, příkazů SQL a aplikace Microsoft Query. 
Otázky spojené s vytvořením zdroje dat se probírají v oddílu „Výběr či vytvoření zdroje dat“, s aplikací 
MS Query se blíže seznámíte v části „Databázové dotazy“. 

Začneme importem z populárního formátu .dbf, tj. tabulky, která vznikla v nějakém systému xBASE, 
FoxPro případně Clipper, nebo byla v tomto formátu uložena z jiného produktu, který umí s e soubory .dbf 
pracovat. Před importem bych měl připomenout, že soubory .dbf mají oproti jiným databázím určitá omeze-
ní. Asi nejzávažnější, s nímž se setkáte téměř ihned, je omezení délky názvu polí na 10 znaků bez mezer. Na 
toto omezení byste hlavně neměli zapomínat při exportu. Například, exportujete-li z databáze Accessu, mů-
že se vám snadno stát, že v exportované tabulce budou mít některá pole stejné názvy (prvních 10 znaků je 
stejných) a budete mít potíže s tím, abyste byli sto vůbec exportovanou tabulku otevřít. Potíže mohou způ-
sobovat i názvy polí obsahující znaky s diakritikou. 

Dejme tomu, že na disku máte tabulku Zakaznik.dbf obsahující údaje o vašich zákaznících. Zkusíme ji 
importovat. Postup: 

1. Máte otevřený sešit, jste na volném listu a máte zapnuté zaznamenávání makra. Zvolte Data > 
Načíst externí data > Nový databázový dotaz. Zobrazí se dialogové okno Zvolit zdroj dat. 
Vyberte vhodný zdroj dat. 

Jak se vyrábějí vlastní zdroje dat jako je Tabulka dBASE IV, který vidíte na obrázku na příští straně, 
se dozvíte v oddílu „Výběr nebo vytvoření zdroje dat“, kam si odskočte také v případě, že 
v dialogovém okně vidíte jen položku <nový zdroj dat> a nevíte, jak dál.  
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2. Klepněte na OK. Excel zobrazí informativní okénko s nápisem „Připojování ke zdroji dat“. Po 

chvíli okénko zmizí  a zobrazí se okno Průvodce dotazem –volba sloupců.  

 

 
V našem případě bude obsahovat 
pouze jedinou tabulku označenou 
tlačítkem pro rozbalení a sbalení. 
 
Protože chcete importovat vše, stačí 
klepnout na tlačítko >. Sloupce se 
přenesou do seznamu vpravo. 

3. Klepněte na Další.  

4. V kroku „filtrování dat“ byste mohli určit, která data chcete importovat. To by mělo smysl 
zejména tehdy, pokud by byla tabulka měla tolik řádků, že by se nevešla na list (zhruba nad 
65000). Jinak je lepší filtrovat až na listu vyspělými technikami Excelu. Obvykle se totiž stává, 
že brzy zjistíte, že sice máte na listu spoustu informací, ale právě ta data, která bytostně 
potřebujete, jste „odfiltrovali“ a na listu je nemáte. Ještě více to platí pro pozdější statické kopie 
dat, která jste si odvodili z původní oblasti externích dat na listu. 

5. Klepněte na Další. V kroku určujícím pořadí řazení můžete zvolit až tři kritéria. Podobně jako 
v předchozím kroku to není podstatné. Nemůžete-li se rozhodnout, odložte řazení na pozdější 
dobu. Až budou data na listu, budete si je moci snadno seřadit podle libosti. Klepněte na Další. 

 

 
Dostanete se do závěrečného kroku průvodce. 
Ponechejte přepínač v horní poloze a 
klepněte na Dokončit. 
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6. V dialogovém okně Vložení externích dat vyberte buňku levého horního rohu cílové oblasti 
(A11) a klepněte na OK. 

Data se objeví na listu spolu se záhlavím sloupců a výchozí název seznamu (v našem případě to bude 
Dotaz_z_Tabulka_dBASE_IV) se doplní do definovaných názvů na listu. Jak se dotaz zobrazuje a upravuje 
v prostředí aplikace MS Query se dozvíte v oddílu „Databázové dotazy“. Základní informace o OLAP a 
datových krychlích najdete v oddílu „Kontingenční tabulky“.  

Uložíte-li dotaz, uchová se v souboru s příponou .dqy. Jedná-li se o dotaz na databáze přes ovladače 
ODBC dodávaných s aplikací MS Query, můžete dotazy parametrizovat. Ukázku parametrického dotazu 
najdete v části „Databázové dotazy“. 

Automatizace importu z formátu DBF 
Chcete-li import tohoto druhu také automatizovat přes VBA, opět můžete postupovat v podstatě analo-

gicky, takže jen několik poznámek. Ve vygenerovaných  klíčových příkazech (specifikace připojení 
v příkazu, který přidává novou dotazovou tabulku do kolekce a nastavení vlastnosti CommandText) se vám 
patrně objeví několikanásobné volání funkce Array. Opatrně je vyházejte, protože se nejedná o nic jiného 
než o zakuklené řetězce:  
Set DotazováTabulka = ActiveSheet.QueryTables.Add(Connection:= _ 
   "ODBC;CollatingSequence=ASCII;DBQ=" & Cesta & _ 
   ";DefaultDir=" & Cesta & _ 
    ";Deleted=1;Driver={Microsoft dBase Driver (*.dbf)};DriverId=277;FIL=dBase 
IV;MaxBufferSize=2048;MaxScanRows=8;PageTimeout=600;SafeTransactions=0;Statistics
=0;Threads=3;UserCommitSync=Yes;", _ 
   Destination:=ActiveSheet.Range("A11")) 

Pro import z databází přes MS Query je podstatnou vlastností CommandText, který nastavuje nebo vrací 
řetězec příkazu-zde je to běžný výběrový dotaz daný příkazem SELECT SQL: 
   With DotazováTabulka 
      .CommandText = "SELECT Zákazník.KÓDZÁKAZNÍ, Zákazník.FIRMA, 
Zákazník.KONTAKTNÍO, Zákazník.FUNKCE, Zákazník.ADRESA, Zákazník.MĚSTO, 
Zákazník.REGION, Zákazník.PSČ, Zákazník.ZEMĚ, Zákazník.TELEFON, Zákazník.FAX FROM 
Zákazník ORDER BY Zákazník.KÓDZÁKAZNÍ" 
'    atd. 
      .Refresh BackgroundQuery:=False 
   End With 

Protože se záhlaví vrací ve velkých písmenech, rozhodli jste se ho převést na tvar „první písmeno velké, 
ostatní malá“ a dvě záhlaví přejmenovat: 
   ActiveSheet.Range("A11:K11").Select 
   For Each buňka In Selection 
      buňka.Value = Application.WorksheetFunction.Proper(buňka.Value) 
   Next 
 
   ActiveSheet.Range("A11").Select 
   ActiveCell.Value = "Kód zákazníka" 
   ActiveSheet.Range("C11").Select 
   ActiveCell.Value = "Kontaktní osoba" 



D a t a b á z e  v  s e š i t e c h  E x c e l u  2 0 0 0  

24 

Chcete-li ,upravte si kód tak, aby se neodkazoval na konkrétní buňky. Výpis ukazuje, jak se z kódu 
VBA volá vestavěná funkce listu (musí se volat anglickým názvem a z kódu nelze volat všechny dostupné 
funkce, jen ty, které jsou zařazené v kolekci WorksheetFunctions). Pokud byste to chtěli vyřídit vzorcem 
na listu, odpovídá funkci Proper český název VELKÁ2.  

Při přepisování záhlaví seznamu, který je založen na externích datech musíte počítat s tím, že vyvoláte-
li aktualizaci seznamu pomocí tlačítek na panelu Externí data (další informace o něm viz konec oddílu 
„Import z databáze Accessu“), obnoví se původní záhlaví podle zdrojových dat. Pokud to jde, zbavíte se této 
nepříjemnosti tím, že prostě přejmenujete názvy přímo ve zdrojové tabulce. Jestliže k ní nemáte přístup 
nebo to není vhodné, importujte data bez řádku záhlaví: 

1. V parametru Destination metody Add zvětšete adresu levého horního rohu oblasti budoucích 
externích dat o jeden řádek (v našem případě na A12). 

2. Změňte hodnotu vlastnosti FieldNames na False. 

3. Přidejte vlastní záhlaví (například pro první sloupec): 
        ActiveSheet.Cells(11, 1).Value = "Kód zákazníka" 

4. Pak můžete udělat další formátovací úpravy. Například přizpůsobit šířku všech sloupců 
a nastavit styl záhlaví na tučný: 

        Columns("A:K").EntireColumn.AutoFit 
        ActiveSheet.Range("A11:K11").Select 
        Selection.Font.Bold = True 

Ještě několik informací o metodě Refresh. Ta způsobí, že se Excel připojí ke zdroji dat dotazové tabul-
ky, provede příkaz SQL a vrátí data na specifikované cílové místo. Aktualizuje nejen dotazové tabulky, ale 
také kontingenční tabulky, s nimiž budete pracovat později. Její volitelný parametr ale účinkuje pouze 
u dotazových tabulek založených na příkazu SQL. False znamená, že se řízení vrátí do procedury VBA až 
po stažení veškerých dat na list. True znamená, že se řízení předá po navázání připojení a odeslání dotazu, 
který se aktualizuje na pozadí.  

Chcete-li testovat, zda náhodou importovaná data nepřekročí počet řádků listu, otestujte hodnotu vlast-
nosti FetchedRowOverflow. Do kódu byste také měli přidat zpracování chyb pro případ, že metoda Ref-
resh selže. Něco lze předjímat testováním její návratové hodnoty: True, když byl dotaz úspěšně vykonán 
nebo spuštěn, False, když uživatel stornoval dialogové okno připojení nebo parametru, jedná-li se o para-
metrizovaný dotaz (ukázku parametrizovaného dotazu najdete v oddílu „Databázové dotazy“). 

Import seznamu uloženého v jiném sešitu Excelu 
I běžný sešit Excelu může posloužit jako opravdický databázový zdroj dat. Předvedeme si to na drobné 

ukázce, v níž data seznamu z jednoho sešitu (obsahuje údaje o rozpisu objednávek) budeme importovat do 
jiného sešitu. Data by pochopitelně mohla zůstat na místě, protože až budeme seznamy na listech propojovat 
relacemi, můžeme se přitom bez potíží odkazovat i na seznamy nacházející se v jiných sešitech. Na začátku 
jsme si však řekli, že chceme mít všechna data v jediném sešitu, takže se toho budeme držet. 

Dejme tomu, že jsou údaje uloženy jako seznam v sešitu vytvořeném v Excelu 5 s názvem Rozpis ob-
jednávek.xls na listu s názvem Rozpis objednávek počínaje buňkou A1. Značná část postupu je analogická 
jako při importu tabulky .dbf: 
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1. Máte otevřený sešit, jste na volném listu a máte zapnuté zaznamenávání makra. Zvolte Data > 
Načíst externí data > Nový databázový dotaz. Zobrazí se dialogové okno Zvolit zdroj dat. 
Vyberte vhodný zdroj dat, například s názvem Vstupní sešity Excelu (viz oddíl „Výběr nebo 
vytvoření zdroje dat“) a klepněte na OK. 

2. V okně Průvodce dotazem–volba sloupců vyberte tabulku s názvem Rozpis_objednávek 
(všimněte si, že název je se znakem podtržení, v názvu nemůže být mezera). Klepněte na 
tlačítko >, pak dvakrát na Další, nakonec na Dokončit. V dialogovém okně Vložení externích dat 
vyberte buňku levého horního rohu cílové oblasti a klepněte na OK. 

Data se objeví na listu spolu se záhlavím sloupců a název seznamu se doplní do definovaných názvů na 
listu. Výchozí název bude tentokrát Dotaz_z_Vstupní_sešity_Excelu. Jak se dotaz zobrazuje a upravuje 
v prostředí aplikace MS Query se dozvíte v oddílu „Databázové dotazy“. 

Automatizace importu z formátu XLS 
Jestliže jste si zaznamenali celý postup jako proceduru VBA (makro), je i vytvoření automatizovaného 

zpracování obdobou importu .dbf. Opět se sestaví připojovací řetězec a příkaz SQL, který importuje data. 
Protože název listu obsahuje mezeru, vyskytují se zde drobné zádrhele, na které upozorňuje následující vý-
pis. Všimněte si také, že připojovací řetězec požaduje cestu a název souboru bez přípony. Cestu získáme 
z úplné cesty k souboru uložené v proměnné NázevSouboru tak, že najdeme první zpětné lomítko zprava 
a vybereme zleva část řetězce až k lomítku, ale bez něj. Podobně získáme úplnou cestu bez přípony souboru 
tím, že najdeme první tečku zprava a vybereme zleva část řetězce až do tečky, ale bez ní. 
NázevListu = "Rozpis objednávek" 
' Definovaný název na listu obsahuje podtržítko, ne mezeru 
Název = "Rozpis_objednávek" 
Cesta = Left(NázevSouboru, InStrRev(NázevSouboru, "\") - 1) 
NázevSouboruBezPřípony = Left(NázevSouboru, InStrRev(NázevSouboru, ".") - 1) 

Klíčové příkazy pro dotazovou tabulku a text příkazu vypadají po odstranění funkce Array ve 
vygenerovaném kódu takto: 
S1 = "ODBC;DBQ=" & NázevSouboru & ";DefaultDir=" & Cesta & _ 
   ";Driver={Microsoft Excel Driver (*.xls)};DriverId=790;FIL=excel 
8.0;MaxBufferSize=2048;MaxScanRows=8;PageTimeout=5;ReadOnly=1;SafeTransactions=0;
Threads=3;UID=admin;UserCommitSync=Yes;" 
Set DotazováTabulka = ActiveSheet.QueryTables.Add(Connection:=S1, _ 
   Destination:=Sheets("Rozpis objednávek").Range("A11")) 
With DotazováTabulka 
' Musí být tento apostrof `, rovný dělá potíže 
   .CommandText = "SELECT Rozpis_objednávek.ČísloObjednávky, 
Rozpis_objednávek.ČísloVýrobku, Rozpis_objednávek.JednotkováCena, 
Rozpis_objednávek.Množství, Rozpis_objednávek.Sleva FROM `" & _ 
    NázevSouboruBezPřípony & "`.Rozpis_objednávek " & _ 
   "ORDER BY Rozpis_objednávek.ČísloObjednávky" 
   .Name = Název 
'    atd. 
   .Refresh BackgroundQuery:=False 
    End With 
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Kód příkazu SQL znovu připomíná, že jeden ze způsobů, jak se vyhnout zbytečným potížím je, nepou-
žívat názvy obsahující mezery a že při přenosu kódu příkazů SQL z nějakého návrháře do kódu VBA se 
musí dávat pozor, pokud příkaz obsahuje nějaká data v uvozovkách (například řetězcovou konstantu ve frázi 
WHERE). Musí se použít jiný povolený oddělovač (ale ne svislý apostrof, protože byste mohli vyrobit ko-
mentář) nebo znak CHR(34) reprezentující uvozovku. 

Při opakovaných importech dat jsme doposud používali dvě varianty – vždy odstranit list nebo 
aktualizovat data metodou Refresh. Někdy byste ale mohli potřebovat z listu importovaný seznam 
odstranit, ale samotný list přitom ponechat. Nemáte-li na listu jiné názvy, dá se to udělat takto: 

   Application.Goto Reference:=ActiveSheet.Names(1).Name 
   Selection.Clear 
   Selection.QueryTable.Delete 
   ActiveSheet.Names(1).Delete 
 
Nebo se odkažte na název skutečným názvem. Protože se ale název listu skládá ze dvou slov, je součástí 

definovaného názvu úrovně listu též odkaz na list včetně apostrofů, takže kompletní název vypadá takto: 
'Rozpis objednávek'!Rozpis_objednávek 

v kódu tedy: 
KompletníNázev = "'" & NázevListu & "'!" & Název 

Import z databáze Accessu 
Nakonec jsem si nechal import z formátu, který možná budete používat v drtivé většině případů, totiž 

z databáze Accessu (.mdb). Konkrétně budeme importovat tabulky Výrobky, Kategorie a Zaměstnanci. 
Ukážeme si import tabulky Kategorie, protože je nejjednodušší, zbývající tabulky se dají importovat zcela 
analogicky. Novinkou při tomto importu je ale to, že tabulky Kategorie a Zaměstnanci obsahují pole typu 
objekt OLE (konkrétně obrázky kategorie jídel resp. portréty zaměstnanců). Uvidíme, jak se s tím při impor-
tu průvodce vypořádá. 

V těchto ukázkách importu budeme dále předpokládat, že na počítači je dostupná ukázková databáze 
Northwind na standardní cestě a že máte k dispozici zdroj dat s názvem Severní vítr (viz oddíl „Výběr nebo 
vytvoření zdroje dat“). Postup bude víceméně analogický jako v předchozích dvou ukázkách. Připomínám 
ještě, že obdobně byste mohli importovat i data z SQL Serveru nebo z jiné dostupné databáze. 

1. Zvolte Data > Načíst externí data > Nový databázový dotaz. Zobrazí se dialogové okno Zvolit 
zdroj dat. Vyberte jako zdroj dat Severní vítr a klepněte na OK. 

2. Excel po chvíli zobrazí okno Průvodce dotazem –volba sloupců. Tentokrát v něm bude seznam 
všech dotazů a tabulek, které se nacházejí v databázi, k níž jste se připojili. Najděte tabulku 
Kategorie, klepněte na ní (nemusíte ji rozbalovat), klepněte na >, dvakrát na Další a nakonec na 
Dokončit. Pak vyberte buňku levého horního rohu cílové oblasti a klepněte na OK. 

Data se objeví na listu spolu se záhlavím sloupců a název seznamu se doplní do definovaných názvů na 
listu. Výchozí název bude v tomto případě Dotaz_z_Severní_vítr. Všimněte si, že i když jste vybrali pro 
import i pole Obrázek, žádné obrázky se neimportovaly, protože se prostě pole tohoto typu ignoruje. Co 
s tím, chcete-li obrázky vidět na listu? 

Dá se to udělat samozřejmě mnoha způsoby, které naznačují, že obrázky a jiné objekty pocházející 
z všelijakých aplikací (zvukové  soubory, dokumenty Wordu apod.) lze evidovat a spravovat i jinak, než 
v polích typu objekt OLE databázových tabulek (jejichž objem kvůli těmto vloženým objektům někdy 
narůstá nade všechny rozumné meze). 
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Jedna, velmi elegantní možnost spočívá v tom, že v databázové tabulce evidujete v poli typu 
hypertextový odkaz adresy k objektům a s tímto pole svážete textové pole na nějakém formuláři. 
(Předpokladem jednoduchého řešení ale je, že zvolený databázový systém podporuje pole tohoto typu.) 
Uživatel prohlíží data a chce-li si zobrazit nějaký obrázek, klepne prostě na hypertextovém odkazu pole 
aktivního záznamu podkladové tabulky. 

My ale nechceme pracovat ani v databázovém systémem, ani se mořit s tvorbou formulářů. Řekli jsme 
si, že vystačíme se sešitem. Proto jsem zvolil jiný způsob. Objekty jsou prostě uložené jako soubory 
v nějaké dohodnuté složce (v našem případě soubory .bmp v podsložce s názvem Obrázky), odkud se tahají. 
Výsledek ukazuje obrázek. Vpravo vidíte panel nástrojů Ovládací prvky: 

 

 

 
Název souboru s obrázkem je 
shodný (pokud to jde) 
s obsahem pole Název 
Kategorie původní tabulky.  
 
Následující postup 
předpokládá, že data z tabulky 
Kategorie máte uložené jako 
seznam s levým horním rohem 
v buňce A11 na listu s názvem 
Kategorie 

1. Klepněte pravým tlačítkem myši na nějakém zobrazeném panelu nástrojů a z místní nabídky 
vyberte Ovládací prvky. Klepněte na tlačítko Režim návrhu a nad seznam přidejte dva objekty: 
Příkazové tlačítko a Obrázek. 

2. Vyberte tlačítko (okolo něj budou bílé úchyty), klepněte na panelu Ovládací prvky na Vlastnosti 
a nastavte tyto vlastnosti tlačítka: Name na cmdObrázekKategorie a Caption na Zobrazit 
obrázek. 

3. Vyberte objekt Obrázek a nastavte tyto jeho vlastnosti: Name na imgObrázek, 
PictureSizeMode na 1 a Visible na False. 

4. Napište proceduru Click tlačítka: Umožníte, aby uživatel mohl zobrazování obrázků vypnout.  
Private Sub cmdObrázekKategorie_Click() 
   If cmdObrázekKategorie.Caption = "Zobrazit obrázek kategorie" Then 
       cmdObrázekKategorie.Caption = "Skrýt obrázek kategorie" 
       imgObrázek.Visible = True 
   Else 
       cmdObrázekKategorie.Caption = "Zobrazit obrázek kategorie" 
       imgObrázek.Visible = False 
   End If 
End Sub 
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5. Napište proceduru SelectionChange listu:  
Private Sub Worksheet_SelectionChange(ByVal Target As Range) 
' Zapnutí chybové rutiny 
With Range(ActiveSheet.Names(1).Name) 
   If .Rows.Count > 1 Then 
       If Target.Row > .Row And Target.Row < (.Row + .Rows.Count) Then 
           If imgObrázek.Visible Then 
             Set imgObrázek.Picture = LoadPicture("C:\Exceldb\Obrázky\" & _ 
                 Replace(ActiveSheet.Cells(ActiveCell.Row, 2).Value, _ 
                    "/", "a") & ".bmp") 
            End If 
       End If 
   End If 
End With 
Exit Sub 
' Chybová rutina 
End Sub 

Když uživatel klepne v nějakém řádku seznamu, načte se z dohodnuté složky soubor obrázku a zobrazí  
v ovládacím prvku imgObrázek. Procedura testuje, zda jsou v seznamu nějaké řádky dat a zda uživatel 
klepl uvnitř seznamu. Pokud ne, nic se neděje. Funkce Replace se volá kvůli tomu, že se v některých 
názvech používá lomítko, což je znak, který při vytváření názvu souboru vadí. Jednoduší by bylo 
samozřejmě přepsat hodnoty pole NázevKategorie v databázi nebo v importovaném seznamu, ale nechtěl 
jsem do dat sahat. 

Připomínám, že kód funguje i tehdy, když uživatel místo klepnutí v buňce vybere nějakou obdélníkovou 
oblast. Zobrazí se prostě obrázek odpovídající hornímu řádku vybrané oblasti. Podobně lze importovat 
tabulky výrobků a zaměstnanců.  

 

 
Je-li záznamů hodně, posouváte se při procházení 
záznamů po listu směrem dolů a možná by se 
vám více líbilo, kdyby se obrázek zobrazoval na 
místě aktuálního záznamu, řekněme vlevo od něj 
zarovnaný s horní stranou řádku.  
 
Za předpokladu, že máte všechny řádky stejně 
vysoké to jde snadno. Všimněte si, že tentokrát 
jsme zaměstnance importovali od buňky D11. 

Jmenuje-li se objekt Obrázek imgObrázekZaměstnance, stačí vnitřní konstrukci If v proceduře 
Worksheet_SelectionChange upravit takto: 
If Target.Row > .Row And Target.Row < (.Row + .Rows.Count) Then 
   Set imgObrázekZaměstnance.Picture = LoadPicture("C:\Exceldb\Obrázky\" & _ 
        ActiveSheet.Cells(ActiveCell.Row, 5).Value & ".bmp") 
   imgObrázekZaměstnance.Top = (Target.Row - 1) * Target.Height 
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End If 

Automatizace importu z formátu MDB 
Je zcela analogická jako v předchozích případech. Opět stačí upravit vygenerovanou proceduru (zejmé-

na odstranit volání funkce Array), takže klíčové příkazy pak vypadají takto: 
Set DotazováTabulka = _ 
   ActiveSheet.QueryTables.Add(Connection:="ODBC;DBQ=c:\Program Files\Microsoft 
Office\Office\Samples\Northwind.mdb;DefaultDir=c:\Program Files\Microsoft 
Office\Office\Samples;Driver={Microsoft Access Driver (*.mdb)};DriverId=25;FIL=MS 
Access;MaxBufferSize=2048;MaxScanRows=8;PageTimeout=5;SafeTransactions=0;Threads=
3;UserCommitSync=Yes;", Destination:=ActiveSheet.Range("A11")) 
With DotazováTabulka 
   .CommandText = "SELECT Kategorie.ČísloKategorie, Kategorie.NázevKategorie, 
Kategorie.Popis, Kategorie.Obrázek FROM `c:\Program Files\Microsoft 
Office\Office\Samples\Northwind`.Kategorie ORDER BY Kategorie.ČísloKategorie" 
   .Name = "Kategorie" 
'    atd. 
    .Refresh BackgroundQuery:=False 
End With 

Import přes ADO 
Výše uvedené ukázky importu z databází využívaly pomocné aplikace Microsoft Query. Při akcích im-

portu lze ale také využít vyspělý aparát objektů pro přístup k datům (ActiveX Data Objects, ADO). Výklad 
ADO by vystačil na samostatnou knihu a kromě toho není předmětem této brožury. Protože je to ale pro-
gramovací technika elegantní a jednoduchá, alespoň dvě ukázky. Při importu přes ADO ale musíte počítat 
s tím, že nebudete moci data aktualizovat pomocí panelu Externí data. 

Import pomocí objektu dotazové tabulky 
Následující funkce převezme jako parametry připojovací řetězec, text příkazu SELECT SQL, název lis-

tu a buňku levého horního rohu cílové oblasti. Skončí-li import úspěšně, vrátí funkce True, jinak False. 
Než začnete programovat, nezapomeňte si zpřístupnit objekty ADO. Ve Visual Basicu zvolte Tools > Refe-
rences a zaškrtněte knihovnu Microsoft ActiveX Data Objects x.y Library. 
Function ImportovatSaduZáznamů(ByVal Připojovacířetězec As String, _ 
     ByVal TextPříkazuSQL As String, _ 
     ByVal NázevListu As String, ByVal LevýHorníRoh As String) As Boolean 
 
    Dim PřipojeníADO As ADODB.Connection, SadaZáznamůADO As ADODB.Recordset 
    Dim DotazováTabulka As Excel.QueryTable 
 
'  Zapnutí chybové rutiny  
    Set PřipojeníADO = New ADODB.Connection 
    PřipojeníADO.Open Připojovacířetězec 
     Set SadaZáznamůADO = New ADODB.Recordset 
     SadaZáznamůADO.Open TextPříkazuSQL, PřipojeníADO, adOpenForwardOnly 
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    If Not ExistujePracovníList(NázevListu) Then 
   '   Přidá se nový list 
    Else 
   '   Aktivuje se existující list  
   '   Existuje-li dotazová tabulka, odstraní se a oblast se vyprázdní 
    End If 
    Set DotazováTabulka = ActiveSheet.QueryTables.Add(SadaZáznamůADO, _ 
           ActiveSheet.Range(LevýHorníRoh)) 
    DotazováTabulka.Refresh 
    ImportovatSaduZáznamů = True 
 
ImportovatSaduZáznamů_Konec: 
'   Údržbové činnosti a odchod 
ImportovatSaduZáznamů_Chyba: 
'    Chybová rutina 
    ImportovatSaduZáznamů = False 
'    atd. 
End Function 
 
Sub VoláníADO() 
Dim Připojení As String, PříkazSQL As String, NázevListu As String 
 
Připojení = "Provider=Microsoft.Jet.OLEDB.4.0;User Id=Admin;Data 
Source=C:\Program Files\Microsoft Office\Office\Samples\NorthWind.mdb" 
PříkazSQL = "SELECT * From Výrobky" 
 
NázevListu = "VýrobkyADO" 
If ImportovatSaduZáznamů(Připojení, PříkazSQL, NázevListu, "A11") Then 
   MsgBox "Import výrobků přes ADO se zdařil" 
Else 
    MsgBox "Import výrobků přes ADO se nepovedl: " 
End If 
End Sub 

Import metodou CopyFromRecordset 
Pro import statických dat na list poskytuje Excel speciální metodu, takže řešení přes VBA je ještě jed-

nodušší než v předchozím případě. Data se importují na nový list: 
Function ImportovatSaduZáznamůJinak(ByVal Připojovacířetězec As String, _ 
     ByVal TextPříkazuSQL As String, NázevListu As String) As Long 
 
   Dim PřipojeníADO As New ADODB.Connection 
   Dim SadaZáznamůADO As New ADODB.Recordset 
   Dim CílováOblast  As Range, výsledek As Long 
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   PřipojeníADO.Open Připojovacířetězec 
   SadaZáznamůADO.Open TextPříkazuSQL, PřipojeníADO, adOpenForwardOnly 
 
   Worksheets.Add After:=Worksheets(Worksheets.Count) 
   Worksheets(Worksheets.Count).Activate 
   Worksheets(Worksheets.Count).Name = NázevListu 
   Set CílováOblast = ActiveSheet.Range("A11") 
   výsledek = CílováOblast.CopyFromRecordset(SadaZáznamůADO) 
 
   SadaZáznamůADO.Close 
   Set SadaZáznamůADO = Nothing 
   Set PřipojeníADO = Nothing 
End Function 

Poznámka. Použijete-li připojovací řetězec a příkaz SQL jako v předchozí ukázce, zobrazí se skutečná 
podkladová data z tabulky Výrobky. Máte-li k dispozici Access a otevřete v něm tabulku Výrobky 
v zobrazení datového listu, uvidíte, že se například ve třetím a čtvrtém sloupci zobrazuje něco jiného.  

Je to z toho důvodu, že v Accessu se často v tabulkách používají tzv. vyhledávací sloupce. Je to vý-
znamná schopnost Accessu, i když uživatele někdy mate. Místo hodnot pole, jehož účelem je sloužit jako 
propojovací pole do jiné tabulky (nevlastní klíč), vidíte totiž v datovém listu texty odpovídajícího pole 
z tabulky, která se v dotazech spojuje relací s právě zobrazovanou tabulkou. 

Konkrétně, chcete-li místo čísla dodavatele a čísla kategorie vidět název firmy a název kategorie, 
nevolejte výše uvedené funkce s příkazem  
PříkazSQL = "SELECT * From Výrobky" 

který nezobrazí vyhledávací sloupce, ale původní hodnoty, ale vytvořte příkaz SQL, který skutečně 
propojí odpovídající tabulky. Celý kód je jediný příkaz: 
PříkazSQL = "SELECT Výrobky.ČísloVýrobku, Výrobky.NázevVýrobku, Dodavatelé.Firma, 
Kategorie.NázevKategorie, Výrobky.MnožstvíVJednotce, Výrobky.JednotkováCena, 
Výrobky.JednotkyNaSkladě, Výrobky.ObjednánoJednotek, Výrobky.MinimálníÚroveň, 
Výrobky.NákupUkončen FROM Dodavatelé INNER JOIN (Kategorie INNER JOIN Výrobky ON 
Kategorie.ČísloKategorie = Výrobky.ČísloKategorie) ON Dodavatelé.ČísloDodavatele 
= Výrobky.ČísloDodavatele;" 

Panel nástrojů Externí data 
Při práci se seznamy, které obsahují externí data, nemusíte nutně programovat nějaké procedury. Máte 

k dispozici také pohodlné interaktivní nástroje. Nejdůležitější se nacházejí na panelu Externí data. 
 

 

Panel obsahuje následující tlačítka (zleva): Upravit dotaz, Vlastnosti, 
Parametry dotazu, Aktualizovat data, Zrušit aktualizaci, Aktualizovat vše 
a Stav aktualizace. 

Čtyři z tlačítek se tkají aktualizací. Chcete-li aktualizovat nějakou oblast, vyberte ji a klepněte na Aktua-
lizovat data. Je-li na listu více oblastí externích dat, můžete hromadně aktualizovat klepnutím na Aktualizo-
vat vše. Tlačítko Stav aktualizace se hodí v situacích, kdy zpracovávání dotazu na pozadí trvá dlouho a 
chcete zjistit, v jakém je stavu. 

Řada věcí se dá nastavit v dialogovém okně, které se zobrazí po klepnutí na tlačítko Vlastnosti. 
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Možná jste se s ním už setkali při importu, 
když jste v dialogovém okně s názvem 
Importovat data resp. Vložení externích dat 
klepli na tlačítko Vlastnosti.  
 
Většina ovládacích prvků odpovídá 
vlastnostem dotazové tabulky (objektu 
QueryTable), s nimiž jste se seznámili při 
zaznamenávání procesů importu. 
 
Za zmínku určitě stojí políčko Aktualizovat 
data při otevření souboru. Jeho zaškrtnutím 
zajistíte, že se externí data budou automa-
ticky aktualizovat při každém otevření seši-
tu. Dále přepínač a políčko dole, jimiž 
můžete ovlivnit způsob přidávání nových 
dat, dojde-li při importu ke změně velikosti 
oblasti externích dat. 

Výběr či vytvoření zdroje dat 
Určení zdroje dat je vlastně až posledním podmínkou k tomu, abyste mohli vůbec s externími daty 

pracovat. Mlčky se samozřejmě především předpokládá, že máte k nějakým externím datům přístup. Kromě 
toho musíte mít nainstalovanou aplikaci Microsoft Query. Není-li dostupná, spusťte instalační program 
Office a tuto aplikaci nainstalujte. Současně s ní se totiž nainstaluje sada ovladačů ODBC pro databáze, 
jejichž výčet byl uveden na začátku oddílu „Import a export externích dat“. 

Za těchto předpokladů můžete přikročit k určení konkrétních zdrojů načítaných dat, které jsme použili 
při importu tabulky .dbf, z jiného sešitu Excelu a z databáze Accessu. Podobně se tvoří zdroje i pro další 
dostupné databáze nebo formáty, které lze za databáze považovat.  

Zdroj dat pro tabulky dBASE či FoxPro 

1. Za předpokladu, že pracujete v sešitu Excelu, otevřete příkazem Data > Načíst externí data > 
Nový databázový dotaz okno Zvolit zdroj dat a dvojitě klepněte na položku <Nový zdroj dat>.  

Uvědomte si, že se sice nacházíte v Excelu ,ale záležitosti týkající se zdrojů dat obstarává aplikace 
Microsoft Query, jejíž ikonu také uvidíte na hlavním panelu Windows. 

2. V dialogovém okně Vytvořit zdroj dat svůj nový zdroj dat pojmenujte tím, že do jediného 
přístupného pole (očíslovaného číslicí 1.) napíšete svůj název, například Tabulka dBASE IV. 
Zpřístupní se rozvírací seznam označený číslicí 2. Klepněte na rozvírací šipku a vyberte 
ovladač  Microsoft dBASE Driver (*.dbf) a klepněte na Připojit. 

3. V dialogovém okně Nastavení ODBC pro dBASE vyberte v seznamu verze položku dBASE IV a 
zrušte zaškrtnutí políčka Použít aktuální adresář, pokud čistě náhodou nemáte tabulku ve slož-
ce, která je právě aktuální (což bývá C:\Dokumenty), jejíž název je vypsán vpravo od slova Ad-
resář:. Zpřístupní se tlačítka Vybrat adresář a Vybrat indexy. Klepněte na Vybrat adresář a 
vyhledejte složku, v níž se nacházejí tabulky dBASE (soubory .dbf). Viz obrázek: 
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4. Indexové soubory žádné nemáme, proto klepněte na OK a ještě jednou na OK. Vrátíte se do 

dialogového okna Vytvořit nový zdroj dat, v němž se zpřístupní seznam označený číslicí 4. 
Vyberte některou z tabulek .dbf, s níž budete pracovat nejčastěji a klepněte na OK. Vrátíte se do 
dialogového okna Zvolit zdroj dat. Klepněte na OK a dále se držte postupu uvedeného v oddílu 
„Import tabulky xBASE“. 

Poznámka. Indexové soubory jsou soubory sdružené s tabulkou (dbf) a umožňují volit logické pořadí 
záznamů při práci v databázovém systému dBASE. Aby stále odpovídaly tabulce, s níž jsou sdružené, musí 
se při změně dat v tabulce průběžně aktualizovat. Soubory .mdx pocházejí z dBASE IV nebo vyšší verze 
a ovladač ODBC dBASE je otevírá a aktualizuje automaticky. Soubory .ndx pocházejí z dřevní dBASE III 
a musí se k tabulce explicitně přiřadit v dialogovém okně Vybrat indexy.  

 

 
Podobně byste postupovali, kdybyste 
chtěli vytvořit zdroj dat pro tabulky 
Visual FoxPro. Jak vidíte, objeví se 
někdy při tvorbě zdrojů dat dialogové 
okno v angličtině.  
Ve FoxPro se rozlišují volné tabulky 
(free tables), které zhruba odpovídají 
tabulkám dBASE a tabulky patřící do 
nějaké (jediné) databáze (.dbc). Řadu 
schopností Visual FoxPro lze 
v tabulce využívat pouze tehdy, je-li 
zařazena do databáze. 
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Zdroj dat pro sešit Excelu 

 

 
Analogicky se postupuje i při vytvoření zdroj dat zalo-
ženém na nějakém sešitu Excelu. Určíte verzi Excelu, 
z níž sešit pochází a soubor sešitu vyberete po klepnutí 
na tlačítko Vybrat sešit. 
 
Chcete-li se sešitem pracovat jako s databází (seznamy 
považovat za analogii databázových tabulek), musí mít 
seznamy definované názvy na úrovni sešitu, jinak je 
MS Query při tvorbě dotazu neuvidí a oznámí, že 
v sešitu nenašel žádné viditelné tabulky. 

Zdroj dat pro databáze Accessu 

 

 
Začnete-li tvořit zdroj dat pro databázi 
Accessu, postupuje se tak, že po klepnutí na 
tlačítko Připojit, klepnete na tlačítko Vybrat. 
 
V dialogovém okně Vybrat databázi nestačí 
vybrat složku jako v případě ovladače 
dBASE. Musíte vybrat soubor databáze 
(.mdb).  
 
Tlačítka Vytvořit, Opravit a Komprimovat 
umožňují dokonce vytvořit novou databázi 
nebo existující  opravit či komprimovat. 
Mohlo by se vám to hodit, kdybyste náho-
dou neměli přístup k Accessu, i když si 
myslím, že by se tyto akce měly raději pro-
vádět v něm. 

Správce zdrojů dat ODBC 
Zdroje dat můžete také vytvářet mimo Excel, pomocí Správce zdrojů dat ODBC. Otevřete ovládací pa-

nely Windows a dvojitě klepnete na ikonu ODBC Data Sources (32 bit), čímž se dostanete do dialogového 
okna správce zdrojů dat ODBC (ODBC Data Sources Administrator). Na stránce Drivers uvidíte všechny 
ovladače, které jsou momentálně nainstalované na systému. Nové ovladače instalujte pomocí instalačních 
programů. 

Na stránce User DSN správce zdrojů dat můžete vytvářet, konfigurovat či odstraňovat zdroje dat, které 
jsou určeny jen pro vás a pro váš počítač, na stránce System DSN zdroje, které uvidí všichni uživatelé 
daného počítače a služby Windows NT a na stránce File DSN zdroje dat určené pro připojení ke 
zprostředkovateli dat, které mohou sdílet uživatelé vybavení stejnými ovladači. 

Postup používaný ve správci zdrojů dat ODBC je velmi podobný tomu, který je založen na příkazu Data 
>Načíst Externí data Excelu. Ukážeme si v něm, jak se vytvoří zdroj dat pro databáze SQL Serveru. 
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Vytvoření zdroje dat pro databáze SQL Serveru 
V brožuře sice pracujeme s daty běžné databáze Accessu (.mdb), a to hlavně proto, že předpokládám, že 

k ní bude mít většina potenciálních čtenářů přístup. Máte-li ale dostup k SQL Serveru a vytvoříte si odpoví-
dající zdroj dat, budete si moci vyzkoušet a ověřit, že se s daty v databázi SQL Serveru pracuje v podstatě 
úplně stejně, jako kdyby to byla databáze .mdb uložená na vašem lokálním disku (asi ale budete mít omeze-
na přístupová práva, takže zřejmě nebudete moci měnit strukturu tabulek, odstraňovat je apod.). 

 

 

1. Zvolte Start > Nastavení > Ovládací panely, 
dvojitě klepnete na ikonu ODBC Data Sources (32 
bit), vyberte jednu ze stránek, jejíž záložka 
obsahuje text DSN (například System DSN) a 
klepněte na Add. 

2. V seznamu dostupných ovladačů vyberte 
SQL Server a klepněte na Dokončit.  

Nemáte-li ovladač dostupný, musíte ho 
nainstalovat opětovným spuštěním instalačního 
programu Office nebo instalačního programu 
dodávaného s ovladačem. Možná se vám také 
budou dialogová okna zobrazovat v angličtině. 

 

 

 

3. Do pole Název napište název zdroje dat a do 
pole Popis případně další informace. (Chcete se 
připojit k ukázkové databázi Pubs, která se dodává 
s SQL Serverem a obsahuje data o knihách, jejich 
autorech, vydavatelích apod.) 

Ze seznamu dole vyberte jeden z dostupných 
serverů (ten, na němž je přístupná publikační 
databáze a případně i další databáze) a klepněte na 
Další. 

 

 

 

4. Zvolte (pokud to lze) způsob ověření, 
zkontrolujte konfiguraci klienta a zadejte své 
přihlašovací jméno a heslo. Pak klepněte na Další. 

 
Chcete-li přistoupit k ukázkovým databázím SQL 
Serveru verze 7, je obvykle přihlašovací id „sa“ 
a heslo se nezadává. 
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5. Chcete-li, změňte jazyk systémových zpráv 
a určete další charakteristiky. Významné může být 
zejména políčko, jímž si můžete určit, aby se 
používala místní nastavení ovládacích panelů.  

6. Zaznamenávání informací nemůže nikdy škodit, 
takže raději ponechejte obě spodní políčka 
zaškrtnutá. Máte-li dobrý důvod, upravte případně 
nabízené cesty.  Pak klepněte na Dokončit. 

 
Průvodce oznámí spoustu informací o tom, co jste si 
v předchozím procesu vytváření zdroje dat navolili. 
Zkontrolujte, zda je vše podle vašich představ. Možná 
by také neškodilo někam si informace zapsat (zvláště 
pro případ, že jste potlačili zaznamenávání informací 
do protokolů).  

7. Až budete hotovi, klepněte na tlačítko Test zdroje 
dat, abyste vytvářený zdroj dat prověřili: 

 
 

Nyní se otestuje, zda je všechno v pořádku a zda je možné se k Serveru připojit. Výsledky testů uvidíte 
v dialogovém okně. Až si vše přečtete, ukončete práci průvodce klepáním na OK. 

 

 

 
Až budete chtít na list importovat data z databáze SQL Serve-
ru, postupujte obdobně, jako při práci s jinými zdroji dat (Da-
ta > Načíst externí data > Nový databázový dotaz atd.). I když 
jste za výchozí databázi označili Pubs, neznamená to, že se 
nemůžete připojit k jiné databázi na serveru. Vyberte název 
databáze ze seznamu v oblasti Možnosti.. 
 
Na obrázku vlevo vidíte, že se uživatel právě chystá připojit 
k projektu Northwind, což je populární verze databáze 
„Severní vítr“ pro SQL Server. 
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Základní techniky pro databázové operace 
Jakmile jste si importem, ručním pořízením dat nebo databázovým dotazem vytvořili na listu seznam, 

můžete všechny obvyklé hromadné operace prováděné v databázích vyřešit v Excelu velmi snadno pomocí 
jeho běžných vizuálních technik. Chcete-li některé z akcí automatizovat, zaznamenejte akci jako makro 
a upravte je tak, aby se dalo využívat obecně, aby nebylo závislé na konkrétních datech konkrétního listu.  

Řazení 
Seřadit seznam podle hodnot v některých sloupcích je v Excelu jednou z nejprostších úloh. Stačí umístit 

kurzor do jakékoli buňky ve sloupci a klepnout na tlačítko Seřadit vzestupně resp. Seřadit sestupně na 
standardním panelu. Chcete-li řadit podle více kritérií a v každém kritériu jinak, postupujte takto:  

Klepněte kdekoli v seznamu a zvolte Data > Seřadit. Excel vybere celý seznam a zobrazí dialogové ok-
no Seřadit. Zvolte sloupce, podle nichž chcete řadit, a způsob řazení.  

Na obrázku vidíte řazení podle zemí, pak podle funkcí, pak podle firem, vše vzestupně. Dolní přepínač 
by vás mohl zmást, protože poloha Se záhlavím neznamená, že se má řadit včetně záhlaví, ale naopak, že 
seznam obsahuje v prvém řádku záhlaví a že se proto má z řazení vyloučit. 

 
Zajímavé možnosti pro řazení poskytuje tlačítko Možnosti. Dejme tomu, že byste chtěli data zákazníky 

seřadit podle funkcí, ale ne podle abecedy, ale ve stanoveném pořadí funkcí. například, aby nejprve byli 
všichni obchodní zástupci, pak majitelé, pak vedoucí nákupu atd., prostě podle vámi stanoveného pořadí: 

1. Vyhledejte ve sloupci Funkce všechny různé hodnoty a uložte si je do nějaké oblasti buněk 
(například M11:M22). Jak se sestrojí vzorec pro získání jedinečných hodnot sloupce seznamu 
je popsáno v  brožuře „Microsoft Excel a práce se vzorci“ vydané nakladatelstvím UNIS 
Publishing v lednu 2001. 

2. Vyberte tuto oblast buněk, zkopírujte ji do schránky, vyberte stejně velikou oblast v jiném 
sloupci, zvolte Úpravy > Vložit jinak, přepněte přepínač do polohy Hodnoty a klepněte na OK. 

3. Se stále vybranou oblastí zvolte Nástroje > Možnosti, přejděte na stránku Seznamy, klepněte na 
tlačítko Importovat a klepněte na OK. Vytvoříte vlastní řadu, kterou využijete při řazení. 
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4. Vyberte nějakou buňku v seznamu, zvolte Data > Seřadit a ze seznamu Seřadit podle vyberte 

Funkce. Klepněte na tlačítko Možnosti. 

5. V dialogovém okně Možnosti řazení vyberte ze seznamu Hlavní klíč řazení vlastní řadu, kterou 
jste si právě vytvořili. Klepněte na OK a zvolte případně další kritéria (například podle země 
sestupně). Klepněte na OK. 

 

 
Seznam seřazený podle 
těchto kritérií a obě 
dialogová okna vidíte na 
obrázku vlevo. 
 
V dialogovém okně 
Možnosti řazení můžete 
ještě určit, aby se při řazení 
rozlišovala velikost písmen 
a přepínačem Orientace je 
možno jako kritérium řazení 
určit hodnoty v několika 
řádcích. 

 
Poznámka. Podobně jako ostatní činnosti, i řazení můžete zaznamenávat jako makro, chcete-li případě 

některé postupy později automatizovat. Například, seznam Zákazníci seřadíte na listu Zákazníci vzestupně 
podle zemí příkazem: 
Worksheets("Zákazníci").Range("Zákazníci").Sort _ 
      Key1:=Range("Země"), Order1:=xlAscending  
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Filtry 
Pojmem filtrování se v databázích rozumí operace, jimiž se získávají podmnožiny řádků zdrojové sady 

záznamů. Je třeba říci, že filtrování je vlastně jen jednou z dílčích operací výběrových dotazů SQL (vlastně 
je dáno podmínkami fráze WHERE či HAVING příkazu SQL SELECT) a že filtry lze obecně řešit v rámci 
tvorby databázových dotazů, kdy máte navíc možnost současně vybrat jen určité sloupce, vytvořit 
dopočítané sloupce, řadit atd. 

Filtrovací techniky jsou ale velmi jednoduché a operace se provádějí namístě. Nepotřebujete-li opravdu 
nic jiného, není třeba chodit s kanónem na vrabce (například s MS Query, nechcete-li udělat nic jiného než 
vybrat řádky objednávek do USA). V Excelu lze filtrovat v podstatě dvěma základními způsoby: 
automatickým filtrem (jednodušší, ale jen pro prostší úlohy) a rozšířeným filtrem (obtížnější, ale vyřeší 
i komplikovanější úlohy). 

Filtrování už nebudeme předvádět na tabulce, ale na výsledcích dotazu (oblasti externích dat převedené 
na hodnoty), jímž jsme získali hierarchický výběr polí z několika tabulek propojených relacemi. Chcete-li se 
nejprve podívat, jak se takový dotaz sestrojí, najdete příslušné postupy v oddílu „Výběrový dotaz založený 
na více tabulkách“.  

Automatické filtry 
Automatické filtry patří mezi nejjednodušší techniky, přitom ale poskytují poměrně dost možností. 

Předvedeme si je na seznamu, který slouží jako testování operací týkajících se fakturace. Chcete-li zobrazit 
řádky fakturace, které se týkají San Francisca: 

1. Klepněte v nějaké buňce seznamu a zvolte Data > Filtr > Automatický filtr. Excel seznam vybere 
a k názvům v řádku záhlaví přidá rozevírací šipky. Na stavovém řádku se zobrazí slovo Filtr. 

2. Klepněte na některé šipce rozvíracího seznamu. Zobrazí se všechny položky, které se v daném 
sloupci nacházejí.  

Poznámka. Kromě toho máte k dispozici i několik „obecných“ položek. Položka (vše) vlastně ruší 
nastavený filtr. Položka (prvních 10) umožňuje volit nejen přesně 10, ale jakýkoli počet, případně i 
vyjádřený v procentech. Položka (vlastní) umožňuje filtrovat podle dvou položek.  

Dvě speciální položky (prázdné) a (neprázdné) umožňuje filtrovat řádky, v nichž je buňka v daném 
sloupci prázdné resp. neprázdná. Tyto položky budete mít k dispozici jen tehdy, bude-li v daném sloupci 
alespoň jedna prázdná buňka. (jejich fungování můžete prozkoušet například na poli Region tabulky 
Zákazníci nebo na poli DomovskáStránka tabulky Dodavatelé). 

3. Chcete-li zjistit faktury do San Francisca, klepněte na šipku v poli Země příjemce a vyberte 
USA. Klepněte na šipku v poli Město příjemce a vyberte San Francisco. Viz obrázek: 

 
Zobrazí se jen ty řádky, které vyhovují automatickému filtru (začínají na řádku 1451 a čísla jsou modrá. 

Na stavovém řádku se vypíše, kolik záznamů se našlo (v tomto konkrétním případě v něm bude text 
„10 z 2155 záznamů nalezeno“). 
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Podobně jako jiné akce, i filtrování lze zaznamenávat jako makro. Například  
' Zapne automatický filtr: 
Selection.AutoFilter 
' Nastaví dvě kritéria, která musí platit současně 
Selection.AutoFilter Field:=5, Criteria1:="USA" 
Selection.AutoFilter Field:=3, Criteria1:="San Francisco" 
' Zobrazí všechna data 
ActiveSheet.ShowAllData 
' Vypne automatický filtr 
Selection.AutoFilter 

Automatické filtry nejsou určeny jen pro tak jednoduché úlohy, jakou je ta předchozí. Chcete-li 
například zobrazit 15 procent objednávek s nejvyšší výslednou cenou, které směřují  do USA nebo do 
Kanady a přepravuje je firma Speedy Express, postupujte takto:  

1. Zapněte automatický filtr, klepněte na rozvírací šipku pole Země příjemce a vyberte položku 
(vlastní). 

 

 
Můžete určit dvě podmínky, které mohou být 
splněny buď současně, nebo alespoň jedna.  
Mezi operace patří nejen běžné porovnávací 
operace, ale také má či nemá na začátku, na konci, 
obsahuje či neobsahuje.  
Když si navíc uvědomíte, že se mohou 
v hodnotách uvádět zástupné symboly, dají se tu 
vyřešit i dost komplikovaná kritéria. 

2. Klepněte na rozvírací šipku pole Firma a v seznamu vyberte Speedy Express.  

3. Klepněte ve sloupci VýslednáCena a klepněte na tlačítko Seřadit sestupně.  

4. Klepněte na rozvírací šipku pole VýslednáCena a v seznamu vyberte položku (prvních 10).  

 

 
V dialogovém okně 
Automatický filtr – 
prvních 10 naklepejte 
nebo napište v číselníku 
hodnotu 15 a v seznamu 
vpravo vyberte procent. 
 
Skryjte nepotřebné 
sloupce, abyste nemuseli 
po seznamu běhat sem a 
tam: 
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Pokud byste si zaznamenávali i tento postup jako makro, definují se v kódu VBA složitější podmínky 
automatického filtru takto: 
Selection.AutoFilter Field:=5, Criteria1:="=USA", Operator:=xlOr, _ 
        Criteria2:="=Kanada" 
Selection.AutoFilter Field:=14, Criteria1:="Speedy Express" 
Selection.AutoFilter Field:=20, Criteria1:="15", Operator:=xlTop10Percent 

Výběr oblasti automatického filtru 
Máte-li nastavený automatický filtr, můžete celou oblast vybrat pomocí skrytého názvu, který Excel pro 

filtrovanou oblast vytvoří: 
• Otevřete dialogové okno Přejít na (Ctrl+G). Do pole Odkaz napište _FiltrDatabáze (začíná na 

znak podtržení) a klepněte na OK. Excel vybere celou oblast filtrovaného seznamu. 

Souhrny ve filtrovaných seznamech 
Prvním údajem, který asi zajímá při filtrování každého, je počet nalezených záznamů. Ten se sice objeví 

na chvilku ve stavovém řádku, ale po přepočítání listu zmizí. Chcete-li mít k dispozici údaj o počtu naleze-
ných záznamů na listu „natrvalo“, zavolejte velmi užitečnou funkci listu SUBTOTAL. S její pomocí se totiž 
mohou vypočítávat i jiné souhrnné statistiky filtrovaných seznamů. Je to totiž jediná funkce, která respektu-
je automatický filtr. Jiné funkce, které počítají souhrny, zpracují všechny řádky, tedy i ty, které filtr skryl.  

Ještě připomínka. Vzorce pro výpočty souhrnných statistik byste měli ukládat do buněk nacházejících se 
v řádcích nad seznamem nebo pod ním. Jinak by se mohlo stát, že by se vám při změně filtru buňky 
s dopočítávanými statistikami skryly. (Jeden z důvodů, proč seznamy ukládáme od buňky A11 a ne od A1). 

Příklad. V našem seznamu jsou ve sloupci T uloženy výsledné ceny. Napíšete-li například do nějakých 
buněk na řádku 1 vzorce: 
=SUMA(T12:T2166) a =POČET(T12:T2166) 

zjistíte, že celkový součet je 31643030,962155 a počet záznamů je 2155. Uložíte-li si pro porovnání 
například pod tyto buňky vzorce: 
=SUBTOTAL(9;T12:T2166) a =SUBTOTAL(3;T12:T2166) 

a nastavíte dejme tomu automatický filtr země příjemce na Irsko, zjistíte, že se hodnoty prvních dvou 
vzorců nezmění, ale SUBTOTAL vrátí 1249497,62455 resp. 55, tedy objem a počet objednávek směřujících 
do Irska. 

První parametr funkce SUBTOTAL určuje, jakou statistiku chcete spočíst (jedná se o funkce listu 
Excelu). 1 = Průměr, 2 = Počet, 3 = Počet2, 4 = Max, 5 = Min, 6 = Součin. , 7 = Smodch.výběr, 8 = smodch, 
9 = Suma, 10 = Var.výběr a 11 = Var. 

Rozšířené filtry 
Jak jste viděli v předchozí ukázce, mají  vlastní automatické filtry docela dost možností, obecně ale 

nestačí. Budete-li chtít například filtrovat objednávky do skandinávských zemí, musíte sáhnout po 
mocnějším filtrovacím nástroji. Říká se mu rozšířený filtr. 

Rozšířený filtr je založen na zvláštní oblasti kritérií, která je tvořena minimálně dvěma řádky. První řá-
dek musí obsahovat některé nebo všechny názvy polí seznamu (stačí ty, pro něž chcete specifikovat nějakou 
podmínku). Ve druhém řádku se uvedou filtrovací podmínky. Podobně jako u vzorců pro souhrnné statistiky, 
i oblast kritérií je dobré dávat do řádků nad nebo pod seznam. 
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Některé ze schopností rozšířeného filtru si předvedeme na ukázce, založené na stejném seznamu, který 
jsme použili při sestrojování automatických filtrů. Chcete zobrazit objednávky do skandinávských zemí za 
zvolené období (dejme tomu za rok 1997), ale jen ty objednávky, u nichž je výsledná cena menší než prů-
měrná cena objednávky za všechny země (z celého seznamu). Pomocí rozšířeného filtru se dá tato úloha vy-
řešit například takto: 

1. Nejprve sestrojte oblast kritérií. Dejme tomu, že jste se rozhodli ji umístit nad seznam, počínaje 
buňkou E1. V prvním řádku budou názvy, v dalších kritéria: 

 

Podmínky umístěné na stejném řádku 
musí být splněny současně, podmínky 
na různých řádcích jsou spojeny 
operátorem NEBO, musí být tedy splněna 
alespoň jedna. 

Sloupec H ukazuje, že se kritérium dá zadat také jako vzorec. Jediná podmínka je, že vzorce musí vracet 
logickou hodnotu. Ve sloupci H vidíte výsledky vzorců, samotný vzorec vidíte v řádku vzorců nad záhlavím 
sloupců.  

2. Klepněte v libovolné buňce uvnitř seznamu a zvolte Data > Filtr > Rozšířený filtr. Zobrazí se 
dialogové okno Rozšířený filtr. Viz obrázek. 

 

 
Protože jste předem klepli v seznamu, nemusíte oblast seznamu 
vybírat. 
 
Přepnutím přepínače Akce do polohy Kopírovat jinam, můžete 
filtrovaná data zkopírovat na jiné místo. Cílovou oblast pak 
vyberte ukázáním (nebo napište) v poli Kopírovat do.  
 
Zaškrtnete-li políčko Bez duplicitních záznamů, vyloučíte 
z výsledného zobrazení duplicitní vyfiltrované řádky. 
 

3. Klepněte na tlačítko se šipkou vpravo na pravé straně textového pole Oblast kritérií, vyberte 
oblast E1:H5 a klepněte znovu na tlačítko se šipkou v minimalizovaném dialogovém okně. Pak 
klepněte na OK. 

Excel zobrazí filtrovaný seznam. Pomocí funkce SUBTOTAL si opět můžete spočíst souhrnné statistiky, 
které respektují podmínky filtru. Práci v dialogovém okně Rozšířený filtr si usnadníte, když předem oblasti 
seznamu a kritérií vhodně pojmenujete. 

Vzorce mohou být poměrně dost komplikované nebo dokonce maticové, v porovnávacích výrazech se 
mohou používat zástupné znaky. atp. Pro praxi to znamená, že filtrem vyřešíte prakticky jakoukoli úlohu, 
která je založena na extrakci dat ze seznamu. S pomocí vzorců se často dá velká oblast kritérií podstatně 
zmenšit. Například, kritérium pro země uvedené výše, se dá umístit do jediné buňky vzorcem: 
=KDYŽ(NEBO(E12={"Dánsko";"Finsko";"Norsko";"Švédsko"});PRAVDA) 
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Filtry a databázové funkce 
Při práci s filtry můžete také využívat speciální kategorii databázových funkcí. Velmi úzce totiž souvise-

jí s rozšířenými filtry, protože se jako jejich poslední parametr uvádí oblast kritérií. Všechny začínají na 
písmeno D a zbytek názvu většiny z nich odpovídá agregačním funkcím SQL.  

Například, následující vzorec aplikovaný na oblast kritérií z předchozího příkladu, vrátí součet výsled-
ných cen pro Dánsko v roce 1997:  
=DSUMA(FakturyDotaz;"VýslednáCena";$E$1:$G$2) 

FakturyDotaz je pojmenovaný název našeho seznamu, druhý parametr udává název sloupce, pro který 
chcete spočíst danou statistiku a poslední parametr udává podmnožinu oblasti kritérií uvedené na obrázku 
výše. 

Poznámka. Součty, počty a jiné souhrnné statistiky lze samozřejmě počítat mnoha různými způsoby, mj. 
i pomocí jiných funkcí listu, jako jsou SUMIF nebo COUNTIF. Nejste-li v těchto funkcí zběhlí, zkuste 
využít doplněk Průvodce podmíněným součtem. 

Vyhledávání dat 
Při zpracování seznamů (záznamů databázových tabulek) se někdy nevybírají celé řádky a (nebo) celá 

pole, ale je potřeba vyhledávat konkrétní hodnoty v nějakém poli nebo v několika polích. Pro tyto typy úloh 
nabízí Excel několik základních technik, které jen stručně připomenu: 
• Hledání. Hledáte-li něco v seznamu, využijte možnosti dialogového okna Najít (příkaz Úpravy> Najít). 

prohledávat můžete po řádcích nebo po sloupcích, hledat můžete ve vzorcích, hodnotách nebo 
v komentářích, rozlišovat velikost písmen nebo ne a případně prohledávat jen celé buňky.  

• Nahrazování. Dialogové okno Nahradit (příkaz Úpravy > Nahradit) může dokonce (tlačítko nahradit vše) 
simulovat hromadné databázové akce vykonávané v SQL aktualizačním dotazem (UPDATE). 

• Skok na dané místo v seznamu. Potřebujete-li skočit na nějaké místo v seznamu, využívejte dialogové 
okno Přejít na (příkaz Úpravy> Přejít na) a nezapomeňte se podívat, jaké bohaté možnosti poskytuje tla-
čítko Jinak.  

• Vyhledávací vzorce a funkce. Pro vyhledávání v seznamu,  v oblasti buněk či v jedné oblasti na základě 
hodnot v jiné oblasti poskytuje Excel celou skupinu tzv. vyhledávacích funkcí listu. Kromě toho se při 
vyhledávání hodnot dají využít různé vzorce, zejména maticové. Ukázku vyhledání pomocí maticového 
vzorce a pomocí vyhledávací funkce najdete na stranách 65-66 brožury „Microsoft Excel a práce se 
vzorci“ vydané nakladatelstvím UNIS Publishing v lednu 2001. 

Průvodce vyhledáváním 
. Nejste-li zběhlí v psaní vzorců či vyhledávacích funkcí, mohl by vám pomoci Průvodce vyhledáváním. 

Ukážeme si, jak se s ním pracuje na kontingenční tabulce země – měsíce – zaměstnanci, která se vytváří 
v části brožury „Kontingenční tabulky“. (Vyhledávat můžete sice i v seznamu, ale na první pokus je lepší, 
když použijete kontingenční tabulku, protože ta má záhlaví sloupců i řádků). Dejme tomu, že chcete vytvo-
řit vzorce, který vyhledá prodeje Mr. Kinga za červenec. 

1.  Chcete-li průvodce vyhledáváním využívat, musíte ho nejprve nainstalovat. Zvolte Nástroje > 
Doplňky, v dialogovém okně Dostupné doplňky zaškrtněte políčko Průvodce vyhledáváním a 
klepněte na OK. 

V prvním kroku průvodce máte určit oblast, v níž chcete něco hledat. Má-li to být celý seznam nebo 
kontingenční tabulka, vybere ho průvodce sám. 
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2. Přejděte na list s kontingenční tabulkou, klepněte v něm a zvolte Nástroje > Průvodce > 
Vyhledávání. Odstraňte z vybrané oblasti první řádek (tj. od řádku A4, nikoli A3) a klepněte na 
Další. 

 

 
V horním seznamu vyberte popisek sloupce, v dolním 
popisek řádku. 
 
Aplikujete-li průvodce na seznam, ten nemívá popisky řádků. 
V takové případě zvolte ze seznamu položku Žádný popisek 
řádku neodpovídá přesně. Novou hodnotu pak zadejte 
v doplňkovém dialogovém okně. 

3. Klepněte na Další. Rozhodněte, zda chcete kopírovat pouze vzorec nebo i parametry vyhledání 
a klepněte na OK. (Dejme tomu, že jste se v této ukázce rozhodli zkopírovat jen vzorec). 

4. Vyberte ukázáním pro vzorce buňku (nebo ji napište) a klepněte na Dokončit.  

V buňce se objeví hodnota 139 999,50. je to výsledek vzorce: 
=INDEX($A$4:$N$49; POZVYHLEDAT("červenec";$A$4:$A$49;);  
     POZVYHLEDAT("King";$A$4:$N$4;)) 

Neříkám, že je složitý, ale na první pokus ho ručně každý bez chyby nenapíše. 

Získávání souhrnných statistik 
Pro výpočty všelijakých, nejen souhrnných statistik, poskytuje Excel prakticky nepřeberné množství 

technik, algoritmů či funkcí. V tomto oddílu se podrobněji podíváme ne dva nástroje: souhrny a slučování. 

Výpočty souhrnů v seznamech 
Souhrny s osnovou je jedna z mnoha velmi mocných a přitom až směšně jednoduchých technik. Říká se 

jí také přehledy. Je to seznam, na který jste aplikovat příkaz Data > Souhrny. Kromě toho se dá při splnění 
jistých předpokladů vytvořit přehled automaticky příkazem Data > Skupina a přehled >Automatický přehled. 
Data musí být ve formě seznamu, na listu musejí být souhrnné údaje vypočtené pomocí vzorců a buňky se 
vzorci musejí sousedit s podrobnými údaji. Nejsou-li souhrnné údaje dopočítávané, ale přímo zapsané do 
buněk, lze přehled vytvořit ručně, v podstatě stejným postupem jako v ukázce vytváření skupin uvedené 
v oddílu „Vytváření vlastních skupin“. Přehledy nejvíce oceníte na ručně připravených listech, které obsahu-
jí  tabulky s vícenásobným členěním  

Základní vizuální technikou pro vytvoření souhrnů v seznamech jsou souhrny (Data > Souhrny) a 
přehledy (Data > Skupina a přehled) s osnovou, kterou lze sbalovat a rozbalovat. Přehled o několika 
úrovních si teď sestrojíme.  

Předpokládejte, že máte na listu výsledky nějakého databázového dotazu, který obsahuje údaje za 
prodeje výrobků v jednotlivým měsících zvoleného roku za všechny země příjemce, kategorie výrobků i 
jednotlivé výrobky. V tomto seznamu chcete vytvořit vnořené souhrny tak, abyste se mohli snadno podívat 
na prodeje za duben, za Brazílii v jednotlivých měsících apod. Postup: 
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1. Klepněte v seznamu a zvolte Data > Souhrny. 

 

 
V horním seznamu vyberte sloupec, kde se má při každé změně 
hodnoty vytvořit souhrn. 
 
Vyberte agregační statistiku, kterou chcete spočíst. 
 
Určete, které sloupce se mají sumarizovat. 
 
Políčko Nahradit aktuální souhrny ponechejte zaškrtnuté jen při 
nastavování nejvyšší úrovně, nebo když chcete stávající souhrny 
odstranit a nahradit jinými.  

2. Klepněte na OK. Opakujte postup ad 1 pro sloupec ZeměPříjemce, NázevKategorie i Název 
Výrobku. Ve všech opakovaných krocích zrušte zaškrtnutí políčka Nahradit aktuální souhrny. 

Excel vypočte souhrny a v levé části listu vytvoří osnovu, kterou lze sbalovat a rozbalovat. Na dalším 
obrázku vidíte část listu se souhrny. Zobrazen je přehled prodejů do Argentiny v lednu  Pak následuje prodej 
za Brazílii v lednu atd. Do obrázku jsem přidal řádek 244, který obsahuje celkový souhrn prodejů do 
Argentiny v únoru. 

 
Jednotlivé úrovně lze pohodlně sbalovat a rozbalovat klepáním na tlačítcích plus (+) a mínus (-) 

v osnově. To však nejsou zdaleka jediné možnosti přehledů.  
Na dalším obrázku vidíte tentýž přehled v jiném členění. Údaje za leden jsou sbalené, takže je vidět 

pouze celkový objem prodejů: 

.  

 
Údaje za únor jsou sbaleny až 
na úroveň zemí, ale pro Brazílii 
jsou vypsány souhrnné údaje o 
úroveň níž, tedy za jednotlivé 
kategorie. Souhrny na úrovni 
jednotlivých výrobků jsou 
sbalené všude. 

Při práci se souhrny máte k dispozici také odpovídající příkazy v kaskádové nabídce příkazu Data> 
Skupina a přehled. Zobrazit detaily, Skrýt detaily, Vytvořit automatický přehled atd. 
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Slučování oblastí 
Souhrny za několik oblastí seznamu lze také vizuálně vytvářet v nějaké cílové oblasti mimo seznam 

pomocí dialogového okna Sloučit. Vyberte cílovou oblast a zvolte Data > Sloučit: 

 
Vyberete funkci (seznam dostupných funkcí vidíte vpravo od dialogového okna), určíte odkaz, klepnutím na 
Přidat ho přidáte do seznamu všech odkazů, určíte, zda a jaké se mají použít popisky a klepnete na OK. Co 
znamená políčko vpravo dole vidíte na okénku nápovědy. 

Další techniky pro získávání souhrnných statistik 
Následující výčet připomíná postupy, které nějak souvisí s databázemi pracovních listů a rozhodně není 

vyčerpávající. S některými z nich se setkáte v různých oddílech brožury. 
• Hlavní vizuální nástroj pro vytváření souhrnů samozřejmě tvoří kontingenční tabulky a s nimi související 

techniky, jako jsou dopočítávaná pole a položky a vlastní skupiny. Viz oddíl „Kontingenční tabulky“. 
• Mezi techniky, které zasahují do zpracování seznamů a kontingenčních tabulek, lze zařadit také tzv. citli-

vostní analýzy (Příkaz Data > Tabulka). Citlivostními analýzami se tato brožura nezabývá, protože patří 
do oblasti analýz typu „Co se stane, když“, jejichž popis a výklad přesahuje rámec i kapacitní možnosti 
brožury.  

• Mezi základní nástroje pro výpočty jednotlivých statistik nebo souhrnů za celé oblasti patří tlačítko 
Autosum a běžné funkce listu pro výpočet souhrnných statistik (SUMA, PRŮMĚR, POČET atd.) 

• Pro práci se seznamy je k dispozici skupina databázových funkcí. Viz „Filtry a databázové funkce“. 
• Dopočítávané sloupce agregačních dotazů SQL se na listech vytvoří velmi snadno pomocí vzorců 

volajících funkce pro výpočty souhrnů. 
• Pomocí běžných či maticových vzorců (ale také voláním speciálních funkcí jako jsou SUMIF, 

COUNTIF) se počítají počtu výskytů, součty a jiné souhrnné statistiky založené na podmínkách. Některé 
vzorce můžete vytvořit vizuálně pomocí Průvodce podmíněným součtem. Pracujete-li s filtry, je v tomto 
ohledu neocenitelná funkce listu SUBTOTAL, protože jako jediná respektuje podmínky filtru.  

• Pomocí speciálních funkcí, vzorců nebo speciálních dotazů lze zjišťovat takové věci, jako je nejčastější 
hodnota, počet jedinečných hodnot či dokonce seznam jedinečných hodnot. Ukázka viz oddíl Výběrový 
dotaz vracející jedinečné hodnoty.  

• Souhrnných statistik se také týkají příkazy v kaskádové nabídce příkazu Data > Skupina a přehled. 
Umožňují mj. velmi snadno vytvářet vlastní skupiny. Ukázku najdete v oddílu „Kontingenční tabulky“. 
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Pomůcky pro import, pořizování a výpočty 
Do této části brožury jsem zařadil stručnou připomínku několika technik, které by se vám mohly při 

řešení databázových úloh v Excelu hodit. Excel poskytuje bohatou paletu nejrůznějších pomůcek a mnohdy 
nelez jednoznačně říci, že pro tento typ úlohy je nejlepší právě tento postup. Výběr vhodné techniky je 
ovšem často otázkou osobních preferencí, konkrétního prostředí či věcné náplně řešené úlohy.  

Import přes schránku a propojování obsahů 
V části brožury věnované importu tabulek jsme uvedli standardní techniky, které by měly vyřešit vaše 

úlohy importu, pokud dostáváte data v „rozumném“ formátu. Jestliže ne, může vám někdy vypomoci stará 
dobrá schránka Windows. Klíčovým nástrojem bývá při těchto importech příkaz Úpravy > Vložit jinak, který 
je vybaven takovými schopnostmi, o nichž jste možná ani netušili. Předvedeme si to na ukázce. 

Představte si, že pracujete na dokumentu nějaké výroční zprávy ve Wordu. Součástí dokumentu jsou 
různé tabulky. Během psaní jste zjistili, že byste některé tabulky potřebovali přenést do Excelu. Lze to 
udělat velmi jednoduše. Tabulku z Wordu můžete na list umístit mnoha různými způsoby: jako objekt, jako 
doplňující ilustraci dat na listu, ale také jako skutečný seznam. Přitom se ještě budete moci rozhodnout, zda 
na list umístíte kopii tabulky nebo zda tabulku Wordu s listem propojíte, takže se budou změny provedené 
později ve výroční zprávě automaticky promítat do propojené tabulky na listu.  

 

 

 
Vlevo vidíte tabulku jako výřez z dokumentu Wordu ve 
stránkovém zobrazení. Jak bývá při práci ve Wordu 
obvyklé, zobrazují se různé pomocné symboly, jako jsou 
konce odstavců nebo hranice buněk tabulky. Patrně se 
pracuje v češtině a je zapnutá kontrola pravopisu, takže jsou 
exotické názvy výrobků podtržené červenou vlnovkou.  
 
 

1. Klepněte v tabulce a stiskněte Alt + 5 na číselném panelu klávesnice (vyberte tím celou 
tabulku). 

2. Zvolte Úpravy > Kopírovat (nebo Ctrl+C). Tabulka se umístí do schránky. Přejděte do Excelu a 
aktivujte list, na který chcete vložit tabulku. Pak zvolte Úpravy > Vložit jinak. Je to jiné 
dialogové okno, než když vkládáte přes schránku „jinak“ obsah buněk. Viz obrázek na příští 
stránce). 

3. Zvolíte-li Vložit a Objekt Document Microsoft Word, vloží se tabulka jako objekt, který „plave“ 
nad buňkami a bude dám vzorcem: 

          =VLOŽENÍ("Word.Document.8";"")' 
4. Chcete-li objekt propojit tak, aby se změny v dokumentu Wordu automaticky odrážely 

v objektu plovoucím na listu, přepněte přepínač do polohy Vložit propojení. Objekt pak bude 
svázán se vzorcem: 

         =Word.Document.8|'C:\Dokumenty\Výroční zpráva.doc'!'!OLE_LINK1' 
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Tabulku (nebo jakoukoli jinou část dokumentu Wordu-například nějakou se speciálním formátová-
ním, které lze v Excelu docílit obtížně) můžete na list také vložit jako obrázek. 

 

 
Dialogové okno Vložit jinak nabídne různé možnos-
ti. Přepínačem vlevo určíte, zda se má vložit kopie 
tabulky nebo zda se mají data na listu propojit se 
zdrojovou tabulkou Wordu, políčko vpravo umož-
ňuje vložený objekt zobrazit jako ikonu a zvolit 
vzhled ikony (Políčko je dostupné jen pro první po-
ložku seznamu, tedy objekt). Seznam uprostřed 
ukazuje, jaké formáty máte při přenosu tabulky 
k dispozici. 

Nás spíše zajímají možnosti, které vytvoří z tabulky Wordu na listu seznam. Vložíte-li tabulku jako 
HTML, Text v kódu Unicode nebo jako Text, vloží se data jako seznam. Příkazem Vložit > Název > Definovat 
pak seznam a případně i jeho sloupce pojmenujte. 

Propojení přes hypertextový odkaz 
Hypertextovými odkazy se sice brožura nezabývá, přesto bych chtěl alespoň připomenout, že potřebuje-

te-li propojovat dokumenty Office nebo jiných aplikací, že hypertextový odkaz je asi nejjednodušší a přitom 
velmi elegantní způsob.  

1. Vyberte tabulku v dokumentu Wordu a vložte ji do schránky. Přejděte do Excelu, klepněte 
v buňce, do které chcete odkaz vložit a zvolte Úpravy > Vložit jako hypertextový odkaz. 

2. Klepněte na odkazu pravým tlačítkem myši a z místní nabídky zvolte Hypertextový odkaz > 
Upravit hypertextový odkaz. V dialogovém okně Upravit hypertextový odkaz změňte 
zobrazovaný text odkazu na lépe vypovídající, případně proveďte další potřebné úpravy. 

Když pak na odkazu klepnete, otevře se Word, otevře se odkazovaný dokument a „skočíte“ na místo, 
kde se nachází tabulka, která bude navíc vybraná. 

Automatické vyplňování  
Když pracujete se seznamy, potřebujete tu a tam přidat popisky, které tvoří určité posloupnosti nebo na-

psat data, která lze vyjádřit jako jisté posloupnosti. V takových případech mohou otravné pořizování pod-
statně urychlit dvě schopnosti Excelu: automatické vyplňování a možnost definovat vlastní řady.  
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Vyplníte-li jednu nebo více buněk a táhnete úchyt výběru (v pravém 
dolním rohu vybrané oblasti) pravým tlačítkem myši, uvidíte, že Excel 
dokonce odhaduje, jaký trend jste asi měli na mysli.  
 
Zobrazuje okénko s plánovanou hodnotou buňky a když uvolníte 
tlačítko myši, zobrazí se místí nabídka, v níž upřesníte, co a jak chcete 
vyplnit.  
 
Přístupnost jednotlivých příkazů v nabídce závisí na tom, jaké data jste 
do buňky napsali (prostřední část bude například přístupná je  tehdy, 
rozpozná-li Excel zapsané hodnoty jako datum). 

Poslední příkaz v místní nabídce (Řady) vede na dialogové okno, v němž můžete dále konkretizovat své 
záměry: 

 

 
Jestliže jste do buňky napsali 1.1.2001 a táhli dolů, 
v takto vyplněném dialogovém okně se po klepnutí na OK 
na list vyplní hodnoty 1.4.2001, 1.7.2001, 1.10.2001 atd.  
 
Dialogové okno umožňuje vytvářet i lineární nebo růstové 
řady. Políčko Trend umožňuje dokonce vypočítat lineární 
nebo růstový trend na základě vybraných hodnot. 
 

Do dialogového okna Řady se dostanete také příkazem Úpravy > Vyplnit > Řady. Nakonec bych chtěl 
upozornit na to, že schopnost automatického vyplňování můžete podstatně obohatit definicí vlastních řad, 
které pak Excel rozpoznává jako vestavěné řady. Zvolte Nástroje > Možnosti a definujte své vlastní řady na 
stránce Seznamy. Viz oddíl „Řazení“. 

Například, dejme tomu, že si definujete zkratky pro názvy měsíců (Le, Ún až Pr). Když pak na listu 
napíšete do dvou buněk Le, Ún, táhnete úchyt pravým tlačítkem myši a z místní nabídky zvolíte Vyplnit řady, 
doplní Excel další vybrané buňky podle položek vaší vlastní řady, tedy Bř, Du, Kv, atd. 

Tyto dovednosti sice patří více méně do základů práce v Excelu, ale ve stresu si někdy uživatel 
neuvědomuje, že je má k dispozici a ťuká bezhlavě data do jedné buňky za druhou. Proto jsem považoval za 
vhodné je připomenout. 

Ověřovací kritéria a podmíněné formátování 
Když pořizujete nebo aktualizujete údaje seznamu přímo v buňkách, mohly by se vám hodit jiné dvě  

speciální schopnosti Excelu: podmíněné formátování a ověřování dat. Podmíněným formátováním můžete 
upozorňovat na buňky, v nichž se nachází neplatná hodnota, kritická hodnota (málo výrobků na skladě) 
apod.  

Ověřování dat umožňuje přidat k buňce nápovědu týkající se pořízení či modifikace hodnoty a zprávu, 
která se objeví, když uživatel napíše do buňky hodnotu, která nesplňuje ověřovací kritéria. Ověřovací 
kritéria mohou být pouze upozorněním na to, že je něco v nepořádku, můžete ale také zápisu neplatné 
hodnoty do buňky zabránit.  
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Ukázka podmíněného formátování. V seznamu, který obsahuje rozpis objednávek se mj. nacházejí 
sloupce Množství a Sleva. Dejme tomu, že byste chtěli speciálním formátováním vyznačit „malé množství“, 
například menší než 10: 

1. Vyberte údaje ve sloupci a zvolte Formát > Podmíněné formátování. V dialogovém okně se-
strojte podmínku a klepněte na tlačítko Formát. Dostanete se do dialogového okna Formát bu-
něk, v němž budete mít k dispozici stránky Písmo, Ohraničení a Vzorky. Nastavte formát a 
klepněte na OK. 

 

 
Na obrázku je formát textu v buňce nastaven 
na červenou barvu, tučnou kurzívu na světle 
zeleném podkladě. 
 
Vyberete-li ze seznamu vlevo položku vzorec, 
budete moci podmíněný formát založit na 
vzorci, čímž můžete omezující možnosti tří 
podmínek typu A snadno obejít. 

2. Klepnete-li na Přidat, můžete nastavit ještě další dvě podmínky. Aby byl podmíněný formát 
v činnosti,musí platit všechny uvedené podmínky současně. 

Ukázka ověřování dat. Ve sloupci Sleva jsou desetinnými čísly vyjádřené slevy na objednané množ-
ství. Dejme tomu, že nechcete poskytovat větší slevu než 20%. Pak můžete zápisu jiných hodnot do buněk 
zabránit tím, že sestrojíte odpovídající ověřovací kritéria: 

1. Vyberte oblast buněk, na kterou chcete aplikovat ověřovací kritéria a zvolte Data > Ověření. 

 

V seznamu Povolit vyberte typ dat, který se smí do 
buňky zadávat. Rozhodněte, zda se mají při 
ověřování přeskakovat prázdné buňky a nastavte 
ověřovací kritérium. Obsah dialogového okna se 
mění podle toho, co vyberete v seznamu Data. 
 
Vyberete-li v seznamu Povolit položku vlastní, bude 
seznam Data nepřístupný a ověřovací kritérium bude 
založeno na vzorci, který napíšete do zobrazeného 
pole Vzorec.  
 
V okénku vidíte text nápovědy pro spodní 
zaškrtávací políčko. 

2. Klepněte na záložku stránky Zpráva při zadávání. Zaškrtněte políčko Zobrazit zprávu po výběru 
buňky a napište text do titulkového pruhu a text nápovědy. 

3. Klepněte na záložku stránky Chybové hlášení. Zaškrtněte políčko Zobrazit chybové hlášení po 
zadání neplatných dat, vyberte styl (ikonu) a napište text do titulkového pruhu a text chybové 
zprávy. Nevyberete-li „stopku“, nezabráníte zápisu chybné hodnoty do buňky. 

4. Až budete hotovi, klepněte na OK. 
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5. Klepněte v některé z buněk, pro niž jste nastavili ověřovací kritérium. Vedle buňky se objeví 
napovídající zpráva. Zkuste zapsat nějakou nesprávnou hodnotu. Objeví se okno chybové 
zprávy. Viz obrázek:  

 

 
Klepne-li uživatel na Znovu, vrátí se do buňky a bude mít 
možnost nesprávnou hodnotu opravit. Klepne-li na 
Storno, obnoví se původní hodnota buňky.  
 
Ve sloupci Množství vidíte aplikovaný podmíněný formát 
popsaný výše. Připomínám, že i pro tento sloupec je 
nastaveno ověřovací kritérium. Do buňky lze zapsat 
pouze celé číslo větší nebo rovno nule. 
 
Nakonec několik poznámek: 

• Chcete proces ověřování automatizovat, můžete si napsat proceduru VBA, která buňky zkontroluje a 
když najde chybu, oznámí to uživateli, který by se pak měl postarat o nápravu. Procedura by také mohla 
vytvořit jakýsi protokol o nalezených chybách. Podle něho by pak uživatel mohl údaje opravovat. 
Procedura se dá mj. sestrojit také tak, aby se spouštěla automaticky při každém otevření sešitu. 

• Ukázku podmíněného formátování a ověřování dat založených na vzorcích najdete na stránkách 11-14, 
resp. 37-38 brožury „Microsoft Excel a práce se vzorci“. 

• Další možností, jak zvýraznit určitá data, je zakroužkování neplatných dat. Vede k němu cesta přes 
příkaz Nástroje > Závislosti > Panely nástrojů. Ukázka viz str. 15 tamtéž.  

• „Nedodělkem“ podmíněného formátování a ověřovacích kritérií je to, že nastavíte-li tyto schopnosti do 
nějaké buňky a pak do ní zkopírujte obsah jiné buňky,. nastavený podmíněný formát či ověřovací kritéria 
tím vymažete. Viz také poznámky v příštím oddílu. 

Uživatelský formulář Excelu  
Jestliže vám z nějakého důvodu nevyhovuje pořizování či úpravy údajů přímo v buňkách a toužíte po 

formulářích, nemusíte nic programovat. Klepněte v seznamu a zvolte Data > Formulář. Budete moci upravo-
vat existující data i přidávat nové záznamy v tzv. uživatelském formuláři Excelu.  

Myslíte-li si, že se opravdu neobejdete bez vyspělých formulářů, máte samozřejmě na výběr několik 
způsobů řešení. Můžete si vytvořit vlastní formuláře pomocí Microsoft Forms (v rámci Excelu) a naprogra-
movat do nich patřičné událostní a jiné procedury. Nebo můžete naprogramovat formuláře pro pořizování a 
aktualizace dat v nějakém jiném prostředí (vývojové prostředí databázového systému, Visual Basicu apod.). 

Na příští stránce se podívejte na formulář, který je otevřen nad seznamem zákazníků. Vpravo nahoře vi-
díte, který záznam je zobrazen ve formuláři a kolik je záznamů celkem. Tlačítko Kritéria by vás mohlo 
zmást: Někdo by si třeba myslel, že bude moci nastavovat ověřovací kritéria pro buňky, zatímco se jedná o 
možnost nastavit filtr na záznamy. Proto jsem do obrázku přidal okénko nápovědy k tomuto tlačítku. Tlačít-
kem Nový můžete do seznamu pořídit nový záznam. 

Z kódu VBA vyvoláte uživatelský formulář například příkazem ActiveSheet.ShowDataForm. Po 
dobu, kdy pracujete s formulářem, bude procedura VBA pozastavena a bude pokračovat ve vykonávání, až 
formulář uzavřete.  
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Jak je vidět, je uživatelský formulář velmi pohotově po ruce. Je to ale jen pomůcka, takže od něj 

nečekejte zázraky. Mně osobně na něm překvapují určité drobnosti. Zbytečně kazí dobrý dojem, který 
uživatel má, když formulář poprvé uvidí. Například: 
• Bez ohledu na to, která buňka seznamu je aktivní, zobrazí formulář při otevření první řádek seznamu 

(tedy ne ten, na kterém stojíte). Myslíte-li si, že by se to mohlo spravit tím, že vyberete celý řádek nebo 
oblast řádku v seznamu, to nejde vůbec, protože pak Excel z nějakého důvodu oznámí, že nemůže určit 
popisky seznamu. 

• K polím na formuláři nemůžete přidávat ověřovací kritéria. Horší ale je (asi nejzávažnější nedostatek 
uživatelského formuláře), že máte-li v buňce definovaná ověřovací kritéria, uživatelský formulář je 
prostě ignoruje a do buněk se tak snadno dostanou neplatná data. (Podmíněné formátování však formulář 
kupodivu respektuje.) 

• Chybí tlačítka „Jdi na první, resp. na poslední záznam“ (musíte použít posuvník) a tlačítko „Odstranit“, 
takže nemůžete z formuláře vymazat řádek. 

Propojení s aplikací Microsoft Access  
I když jste už možná v tomto okamžiku nabyli přesvědčení, že vám pro řešení všech úloh postačí Excel, 

může se stát, že budete (asi spíše pro někoho jiného než pro sebe) potřebovat svá data převést na databázi 
Accessu. nebo vytvořit prototypy nějakých pořizovacích formulářů či výstupních sestav. Nemusíte se přitom 
Access učit, ani do něho lézt. Stačí, když máte Access dostupný. Ukážeme si to na příkladu. 

Dejme tomu, že jste získali v nějakém sešitu Excelu databázi, kterou společnost Microsoft používá pro 
školení uživatelů a že si z ní chcete udělat databázi Accessu. Ukážeme si, jak se ze seznamu na listu vytvoří 
tabulka ve formátu Accessu. Současně se vytvoří i databáze Accessu, (soubor .mdb), do něhož se ukládají 
kromě tabulek i jiné databázové objekty, například formuláře a sestavy. Pak nad tabulkou vytvoříme 
prototyp formuláře a sestavy. Vše vyřešíme vizuálně a neopustíme ani na okamžik prostředí Excelu.  

1. Předpokládám, že už máte otevřený sešit s patřičnými seznamy, který se jmenuje dejme tomu 
Cukroví.xls. Nejprve je třeba nainstalovat doplněk. Zvolte Nástroje > Doplňky, v seznamu Do-
stupné doplňky zaškrtněte políčko Propojení s aplikací Access a klepněte na OK. Instalací do-
plňku přidáte do spodní části nabídky Data tři nové příkazy. 

2. Zvolte Data > Převést do aplikace MS Access.  
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Protože chcete vytvořit novou databázi, přepněte přepí-
nač do horní polohy a napište název nové databáze. 
Připomínám, že databáze je soubor .mdb a exportovaná 
tabulka bude jedním objektem uloženým v souboru da-
tabáze. její název určíte později. 
 

3. Klepněte na OK. Spustí se Access a spustí se Průvodce importem z tabulkového kalkulátoru. 
V jeho prvním kroku zkontrolujte, zda první řádek obsahuje záhlaví sloupců a dělicí čáry mezi 
poli. klepněte na Další. 

4. Protože chcete data uložit do nové tabulky (ještě nic nemáte), přepněte přepínač  do horní 
polohy. Klepněte na Další a zkontrolujte možnosti polí. Protože první pole budete chtít později 
prohlásit za primární klíč, vyberte ze seznamu Indexované položku ano (bez duplicity). Můžete 
se také rozhodnout, že některé pole nebudete importovat. Vyberte ho v dolní části a zaškrtněte 
políčko Neimportovat pole (přeskočit). Klepněte na Další. 

 

 
Přepněte přepínač do prostřední polohy a ze 
seznamu vyberte název pole. Protože víte, že první 
pole obsahuje jednoznačný kód složený ze čtyř 
znaků, můžete zvolit vlastní primární klíč.  
 
Pokud byste nechali řešení na Accessu, přidá do 
tabulky nové pole typu automatické číslo. Má mj. 
tu výhodu, že při přidávání nových záznamů 
generuje jeho hodnotu sám Access, takže mají 
uživatel aplikace (nemůže nic zkazit) i vývojář 
(nemusí nic kontrolovat) o starost méně.  
 

5. Klepněte na Další, napište název tabulky pro exportovaný seznam (například Bonboniéry) 
klepněte na Dokončit.  

Dialogové okno oznámí, že export byl ukončen (zapamatujte si pro strýčka Příhodu vypsanou cestu k 
databázi). Uvidíte okno aplikace Access, v něm okno databáze a ikonu s názvem tabulky.  

Teď, nebo kdykoli později, můžete vytvořit formulář a sestavu Accessu a uložit je do této databáze nebo 
do nové databáze. 

1. Zvolte Data > Formulář aplikace MS Access. Přepněte přepínač do polohy Existující databáze a 
pro jistotu klepněte na Procházet a vyberte úplnou cestu k databázi v dialogovém okně 

2. Klepněte na OK. Spustí se průvodce formulářem Accessu, jímž se ale proklikáte velmi snadno. 
V prvním kroku klepněte na tlačítko >> , pak na Další. Nechcete-li měnit rozvržení, klepněte na 
Další. nechcete-li měnit styl, klepněte na Další. zadejte název formuláře a klepněte na Dokončit. 
Uvidíte polotovar formuláře: 
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Jak vidíte, jsou některé popisky neúplné, některá pole 
příliš velká, zobrazování false a true také asi není ono 
(lepší by bylo zaškrtávací políčko), ale v principu 
formulář funguje a dá se s ním pracovat.  
 
Kdybyste chtěli, aby měl vynikající štábní kulturu, 
museli byste se trochu seznámit s návrhářem formulářů 
Accessu. Úpravy se dělají velmi podobně jako při práci 
v Microsoft Forms (v Accessu se toho ale na 
formulářích dá dělat o dost víc). 
 

Zcela analogicky byste se mohli proklikat při vytváření výstupní sestavy. Zvolte Data > Sestava aplika-
ce MS Access. Zase se spustí průvodce, stačí zase zvolit výstupní pole, několikrát klepnout na Další, pak na 
Dokončit. Vytvořený prototyp sestavy uvidíte v okně náhledu: 

 

 

 
Opět řada vad na kráse. Asi by chtělo 
změnit název v titulkovém pruhu, 
upravit nadpisy sloupců, písmo atp.  
 
V dolní části vidíte, že průvodce 
sestavou přidá datum a číslování stránek 
a že dokonce umí skloňovat názvy 
měsíců! Grafické čáry jsou součástí 
vytvořené sestavy. 
 

Až příště otevřete sešit, podívejte se na pravý okraj seznamu: 

 

 
Excel zobrazuje nejen informaci o převodu do 
databáze Accessu, ale poskytuje také tlačítka pro 
spuštění formuláře a sestavy. 
 
Klepnete-li na například na tlačítko Zobrazit 
formulář MS Access, spustí se Access a v něm 
formulář. 
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Průvodce šablonou se sledováním dat 
Poslední pomůckou, o níž se brožura zmiňuje, umožňuje vytvořit šablonu, kterou můžete použít 

k zadávání dat do databáze propojené se šablonou. Následující ukázka by vám měla pomoci pochopit, k če-
mu průvodce šablonou vlastně je a jak se s ním pracuje. Představte si, že zpracováváte všelijaké platby 
a v samostatném sešitu máte evidenci plateb, které zaměstnanci platí v půlročních intervalech: 

 

 
Ve sloupci D jsou vzorce, které sečtou 
hodnoty odpovídajících buněk ze 
sloupců B a C. 
 

Dejme tomu, že chcete vytvořit databázi, do které byste ukládali vybrané informace z listu půlročních 
výdajů, například jméno zaměstnance a celkové platby.  Dá se to udělat všelijak, také pomocí průvodce 
šablonou. Postup: 

1. Za předpokladu, že pracujete právě v sešitu z obrázku výše, zvolte Data > Průvodce šablonou. 
Dozvíte se, co průvodce dělá. V horním seznamu se má specifikovat sešit, podle něhož se 
vytvoří šablona. Protože právě v tomto sešitu pracujete, nemusíte nic vybírat. V dolním 
seznamu je uvedena úplná cesta ke složce šablon a doporučený název vytvářené šablony bude 
stejný jako název sešitu (ale přípona bude .xlt). Nemáte-li dobrý důvod, nic neměňte. 

2. Klepněte na Další a vyberte typ databáze (k dispozici je Access,Excel a dBASE). Protože se 
v brožuře především zabýváme databázovými možnostmi Excelu, ponechejte nabízenou 
položku sešit Microsoft Excel a vyberte nebo napište cestu a název souboru databáze, například 
Půlroční platby databáze Excelu.xls.  

3. Klepněte na Další. V tomto kroku musíte určit, které buňky chcete ukládat do databáze (a 
propojit je tak se sešitem, který potom založíte na právě vytvářené šabloně). Buňky musíte 
vybírat po jedné. Viz obrázek na příští straně. 

4. Klepněte na Další. Průvodce se vás zeptá, zda chcete do databáze přidat nějaké údaje z jiných 
sešitů. Protože ještě nic nemáte, klepněte na Další. Poslední krok je více méně informativní a 
informuje o zajímavé možnosti napojení se na elektronickou poštu (čímž se zde zabývat 
nebudeme). 

 

 
 
 
Klepněte v políčku ve sloupci buňka a klepněte na 
listu v odpovídající buňce. Ve sloupci Název pole se 
automaticky doplní název pole, který můžete upravit.  
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Za předpokladu, že se vám předchozí postup podařilo úspěšně dokončit, můžete teď uvést do chodu 
šablonu i databázi (možná že teprve pak pochopíte, co jste vlastně vytvořili). 

1. Zavřete pro jistotu všechny sešity a zvolte Soubor > Nový. Na stránce Obecné dialogového 
okna Nový byste měli vidět kromě ikony Sešit též ikonu  vaší právě vytvořené šablony Půlroční 
platby.xlt. Dvojitě na ní klepněte. 

Založili jste nový sešit na své šabloně. Sešit dostane název Půlroční platby1. 

2. Abyste viděli názorně, co se bude dít, zvolte Soubor > Otevřít a otevřete sešit databáze. Zatím 
v ní nic není (viz obrázek). Vyplňte údaje v sešitu založeném na šabloně a klepněte na tlačítko 
Uložit na standardním panelu.  

3. Zobrazí se dialogové okno Šablona – uložit do databáze. Zkontrolujte, je-li přepínač v poloze 
Vytvořit nový záznam a klepněte na OK. 

 
Data z propojených buněk se přenesou do databáze, což neuvidíte, protože Excel hned zobrazí 

dialogové okno Uložit jako (zatím jste totiž sešit založený na šabloně ještě neuložili). 

4. Zvolte umístění a klepněte na Uložit. V sešitu databáze byste měli vidět vyplněný první řádek 
(první záznam). 

5. Přejděte do sešitu Půlroční platby1, vyplňte údaje pro jiného pracovníka a zase klepněte na 
Uložit.  

Opět se zobrazí dialogové okno Šablona – uložit do databáze, přepínač ale bude mít tři polohy, 
přibude Aktualizovat existující záznam. Jestliže jste opravdu zapisovali údaje pro jiného člověka, 
přepněte přepínač do polohy Vytvořit nový záznam a klepněte na OK. Do sešitu databáze by se měl 
přidat další záznam (dialogové okno Uložit jako se už neobjeví).  

6. Uzavřete oba sešity a znovu otevřete sešit Půlroční platby1. Měli byste v něm vidět naposled 
pořizovaný záznam. Změňte něco a klepněte na Uložit. Zobrazí se dialogové okno Šablona – 
uložit do databáze a otevře se sešit databáze. 

Zda se stane tato technika vaším oblíbeným nástrojem, nevím. Sešit založený na šabloně vlastně 
simuluje pořizovací formulář a sešit databáze simuluje databázi. Je to asi (jako v řadě jiných případů) otázka 
osobních preferencí, já osobně raději používám „opravdový“ formulář a pro uložení primárních dat 
„opravdovou databázi“. 
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Databázové dotazy 
Hierarchické výběry z databází jsou jednou z nejdůležitějších a nejčastějších akcí, kterou interaktivní 

uživatelé vykonávají nad údaji uloženými v tabulkách těchto databází. Aby se tyto databázové výběrové 
dotazy vytvářely pohodlně, poskytuje Office pomocnou aplikaci s názvem Microsoft Query, což je vizuální 
nástroj pro vytváření a organizaci dat z různých zdrojů. Je to něco podobného jako návrháři dotazů, které 
najdete v databázových aplikacích jako je Access či FoxPro nebo jako tvůrce dotazu, s nímž se můžete 
setkat ve Visual Basicu. 

Za dotazy se v obecnějším smyslu považují nikoli jen výběrové dotazy, ale i jiné akce vykonávané nad 
daty v databázi nebo nad strukturou databáze. Běžné akční dotazy se ale na seznamech v Excelu obvykle 
řeší jeho technikami (odstraňování záznamů (zdánlivé) pomocí filtrů, hromadné změny existujících dat 
pomocí vzorců atp.) a nebudete potřebovat ani definiční dotazy měnící strukturu databáze, protože ji máte 
přímo na listu a změny můžete udělat technikami Excelu.  

S MS Query můžete pracovat samostatně (spustíte-li ve Windows její výkonný modul 
MSQUERY32.EXE), ale obvykle ji spouštíte z jiné aplikace, v našem případě z Excelu. Většinou se do ní 
dostáváte implicitně, v různých etapách práce s průvodcem dotazu. (Například, potřebujete vytvořit nový 
zdroj dat, upravit dotaz, který jste si dříve uložili apod.) 

Práce s výběrovými dotazy ale není jedinou úlohou, kterou Microsoft Query pomáhá řešit. Umožňuje 
také vytvářet a konfigurovat zdroje dat (což se probírá v oddílu „Výběr či vytvoření zdroje dat“) a zasahuje 
i do definičních akcí prováděných nad databází, protože umožňuje definovat v rámci zvoleného typu 
databáze nové tabulky (a indexy). Krátkou ukázku najdete na konci této části brožury v oddílu „Vytvoření 
nové tabulky“. Práce s daty OLAP ilustruje ukázka v oddílu „Práce s datovými krychlemi OLAP“ v části 
brožury věnované kontingenčním tabulkám. 

MS Query se dá také chápat jako alternativa k různým (často mocnějším) technikám, které najdete 
v nabídce Data Excelu (řazení, filtry, souhrny, kontingenční tabulky apod.). Při práci v MS Query 
nezapomínejte, že je, co se týče práce s daty, primárně určen k vytvoření sady záznamů, kterou uložíte na 
list jako seznam, a pak nad ní provádíte různé výpočty, analýzy, kreslíte grafy atd. 

Omezený rozsah brožury neumožňuje, abych se podrobně zabýval všemi schopnostmi MS Query, které 
se týkají práce s dotazy. Ovládání MS Query je však poměrně jednoduché a názorné a k jejímu pochopení 
snad postačí tyto ukázky: 

• Vytvoření výběrového detailního dotazu založeného na několika tabulkách propojených relací. 
Dotaz bude obsahovat s dopočítávaný sloupec a ukážeme si na něm, jak se dá dotaz 
parametrizovat. 

• Vytvoření agregačního dotazu, který nevrací z databáze detailní záznamy, ale každý výsledný 
záznam je reprezentantem určité skupiny detailních záznamů ve vypočítávaných polích obsahuje 
souhrny za tuto skupinu. 

• Vytvoření dotazu, který zjistí všechny různé hodnoty v poli seznamu. 
• Sestavení tzv. definičního dotazu, který v databázi vytvoří novou tabulku. 



D a t a b á z e  v  s e š i t e c h  E x c e l u  2 0 0 0  

58 

Výběrový dotaz založený na více tabulkách 
Začneme dotazem, jímž shromáždíme údaje z několika databázových tabulek propojených relacemi. 

O všech datech se předpokládá, že se nacházejí jako seznamy na listech jediného sešitu Excelu. Zvolil jsem 
toto umístění především z toho důvodu, abychom si názorně předvedli, že i tyto činnosti se dají dělat přímo 
při práci se sešitem a že kvůli tomu, abyste seznamy propojili relacemi a vybrali z nich podmnožinu řádků 
a sloupců nepotřebujete kupovat mastodonta Access. 

Pro potřeby fakturace potřebujete na listu s názvem Příprava faktur shromáždit určité údaje z tabulek 
Zákazníci, Objednávky, Rozpis objednávek, Výrobky a Přepravci. Kromě toho chcete přidat do výsledné 
sady záznamů dopočítávaný sloupec, v němž pro potřeby dalších analýz spočtete výslednou cenu 
(vynásobíte cenu za jednotku množstvím a odečtete případnou slevu). 

Dotaz začnete vytvářet podobně, jako kdybyste chtěli importovat externí data. Předpokládám, že máte 
otevřený sešit, v němž máte na jednotlivých listech (levý horní roh buňka A11) seznamy odpovídající data-
bázovým tabulkám a nacházíte se na prázdném cílovém listu s názvem Příprava faktur: 

1. Zvolte Data > Načíst Externí data > Nový databázový dotaz. V dialogovém okně Zvolit zdroj 
dat vyberte na stránce Databáze zdroj Soubory Excel* (nebo jiný předem připravený zdroj pro 
práci se sešity – v naší ukázce to bude zdroj z názvem Sešity Excelu 97 – 2000“). 

2. V dialogovém okně Vybrat sešit vyhledejte sešit obsahující seznamy, na nichž chcete založit 
svůj dotaz (v tomto případě právě ten sešit, s nímž aktuálně pracujete). Můžete určit, že má být 
sešit otevřen jen pro čtení a sešit můžete také vyhledávat na síti. Viz obrázek:  

 
3. Klepněte na OK. Dostanete se do dialogového okna Průvodce dotazem – volba sloupců. Vybí-

rejte z jednotlivých seznamů podkladové databáze ty sloupce, které chcete mít ve výsledné sadě 
záznamů. Viz obrázek: 
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4. Klepnete-li na tlačítko Náhled, uvidíte, jaká data se nacházejí v právě vybraném sloupci. 

Tlačítkem Možnosti můžete omezit či rozšířit seznam zobrazovaných tabulek v levém sloupci 
o pohledy, systémové tabulky a synonyma, případně seřadit zobrazené názvy podle abecedy. 

 

 
Stane-li se vám, že místo dialogového okna na 
obrázku výše zobrazí MS Query tuto zprávu, neděste 
se. Sešit je v pořádku.  

Abyste mohli seznamy umístěné v sešitu používat jako tabulky, musí mít seznamy definované názvy, 
a to na úrovni sešitu, nikoli na úrovni listu. V takovém případě práci v MS Query přerušte, klepněte 
na listu se seznamem, klepněte v některé buňce seznamu, zvolte Vložit > Název > Definovat 
a definujte pro seznam vhodný název úrovně sešitu. 

5. Ze seznamu Objednávky vyberte sloupce JménoPříjemce, AdresaPříjemce, MěstoPříjemce, 
PSČPříjemce a ZeměPříjemce a ze seznamu Zákazníci: KódZákazníka, Firma, Město, PSČ a 
Země. Pak ještě z tabulky Objednávky sloupce ČísloObjednávky, Datum Objednávky a 
Dopravné, z tabulky Přepravci Firma, z tabulky Výrobky NázevVýrobku a konečně, z tabulky 
Rozpis objednávek sloupce ČísloVýrobku, JednotkováCena, Množství a Sleva. Až budete 
hotovi, klepněte na Další. 

6. Do prostředí aplikace MS Query se dostanete poněkud „netradičním“ způsobem. Reakcí 
MS Query je totiž toto dialogové okno: 

 
7. Poslechněte a klepněte na OK. Zobrazí se okno aplikace MS Query: 
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Jak vidíte, je to běžná aplikace, která má pruh nabídek a panel nástrojů pro často prováděné akce. 

Význam tlačítek na panelu (zleva): Nový dotaz, Otevřít dotaz, Uložit dotaz, Načíst data do aplikace Microsoft 
Excel, Zobrazit SQL, Zobrazit či skrýt tabulky, Zobrazit či skrýt kritéria, Kritérium =, Souhrny, Seřadit 
vzestupně, Seřadit sestupně, Spustit dotaz, Automaticky, Nápověda a Nápověda pro MS Query. 

V horním panelu aplikace jsou umístěny tabulky, v dolním vybrané sloupce. Nový sloupec v dolní mříž-
ce vytvoříte prostě tak, že do ní přetáhnete pole z některé tabulky. Nebo zvolte Záznam > Přidat sloupec a 
v dialogovém okně Přidat sloupec vyberte název sloupce ze seznamu Pole všech sloupců všech tabulek, na 
nichž je dotaz založen.  

V poli Záhlaví sloupce můžete zapsat své záhlaví sloupce a ze seznamu Souhrn vybrat agregační operaci 
(agregované dotazy viz příští oddíl). Až budete hotovi, klepněte na Přidat.  

Stejnou technikou (příkaz Záznam > Upravit sloupec nebo dvojité klepnutí v záhlaví sloupce) můžete 
měnit záhlaví existujících sloupců.  

Hvězdička v seznamu polí tabulky zastupuje všechny sloupce a také lze přetáhnout do spodní mřížky. 
Vlevo dole máte k dispozici navigační tlačítka, s jejichž pomocí se můžete pohybovat po sadě záznamů.  

Úpravy v mřížce se provádějí podobnými technikami, jako to děláte na listu Excelu. Pořadí sloupců 
můžete měnit tažením (vyberte sloupec klepnutím na jeho záhlaví, klepnete a táhnete sloupec na nové 
místo). Šířka sloupce se mění tažením rozhraní záhlaví nebo se automaticky přizpůsobuje dvojitým 
klepnutím na rozhraní záhlaví.  

Tažením rozhraní voliče řádků vlevo lze změnit výšku řádků v mřížce (ale všech najednou). V dotazech, 
který má hodně sloupců ( jako je tento) můžete také využít možnost skrýt sloupce. (Sloupce, které chcete 
skrýt resp. zobrazit, zaškrtnete v  dialogovém okně.) Příkazy Skrýt sloupce a Zobrazit sloupce najdete 
v nabídce Formát, kde jsou také ostatní příkazy určené k úpravám rozměrů resp. písma mřížky dotazu (Výš-
ka řádku, Šířka sloupce a Písmo). 

V mřížce je vidět. že jsou údaje ve sloupcích zatím špatně, protože tabulky nejsou propojené relacemi. 
Je třeba je nastavit: 
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1. Klepněte v tabulce Přepravci na pole ČísloPřepravce, přetáhněte je na pole Přeprava v tabulce 
objednávky a pusťte.  

Mezi tabulkami se objeví čára vyjadřující relaci.  

2. Obdobně klepněte v tabulce Zákazníci na pole ČísloZákazníka a přetáhněte je na pole se 
stejným názvem v tabulce Objednávky.  

3. Klepněte v tabulce Objednávky na pole ČísloObjednávky a přetáhněte je na pole se stejným 
názvem v tabulce Rozpis objednávek.  

4. Klepněte v tabulce Výrobku na pole ČísloVýrobku a přetáhněte je na pole se stejným názvem 
v tabulce Rozpis objednávek. 

Poznámka. Jak je vidět z první relace, není nutné, aby se propojovací pole v tabulkách jmenovala 
stejně. Jsou-li ale stejná, usnadňuje to nastavování relací, protože okamžitě vidíte, která pole asi 
máte propojit. 

5. Upravte pozici tabulek tak, aby se čáry nekřížily. Vyberte v mřížce dotazu první sloupec zleva a 
klepněte na tlačítko Seřadit vzestupně (nebo využijte příkaz Záznam > Seřadit). Nezmění-li se 
vám obsah mřížky dotazu, klepněte na tlačítko Spustit dotaz. Viz obrázek: 

 
Úpravy provedené v posledním kroku nejsou nutné. První z nich ale přispívá k lepší srozumitelnosti 

nastavených relací, druhá informuje o tom, zda jsou relace opravdu dobře a zda dotaz reaguje na změny. 
Nejste-li si jisti, jak chcete mít data seřazená a nevíte, jaké řádky je možno z výsledné sady záznamů 
vyloučit, raději tyto operace odložte až na pozdější dobu. Viz oddíl „Základní techniky pro databázové 
operace“ výše. 
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Úpravy relací 
(Nechcete-li se úpravami relací zabývat a pokračovat v řešení úlohy, klidně tento oddíl přeskočte.)  

• Jestliže jste zjistili, že Upustíte-li tažené pole na nesprávném poli, vyberte prostě čáru relace a 
stiskněte klávesu Del.  

• Důležitou informaci dostanete, když na grafické čáře relace dvojitě klepnete: 

 

 
 
 
 
Jak je vidět, zařazují se do výsledné sa-
dy záznamů standardně jen řádky, které 
mají kompletní řetězec relací (tj. jen zá-
kazníci, kteří mají nějakou objednávku a 
jen ty objednávky, které jsou přiřazené 
nějakému zákazníkovi) 

Tyto informace někdy uživatelé vizuálních návrhářů dotazů přehlížejí a někdy se pak stává, že jsou 
výsledky dotazů, jiné než očekávají. Říká se tomu vnitřní spojení tabulek a takto to funguje standardně 
i jinde, například v Accessu.  

Vnější spojení tabulek (outer join) 
Chcete-li zobrazit všechny zákazníky (bez ohledu na to, učinili-li nějakou objednávku nebo ne), musíte 

tabulky propojit relací typu levé vnější spojení (poloha 2. přepínače na obrázku výše). Chcete-li zobrazit 
všechny objednávky včetně těch (asi chybných), které nemají přiřazeného zákazníka, použijte polohu 3.  

Poznámka. Vnější spojení zde ale funguje jen tehdy, je-li dotaz založen pouze na dvou tabulkách a má 
smysl pouze tehdy, jsou-li v propojených tabulkách nějaké „osiřelé záznamy“, což mimochodem není případ 
tabulek Zákazníci a Objednávky z databáze Northwind. Chcete-li si tato spojení vyzkoušet (což doporučuji), 
postupujte takto: 

1. Importujte na listy seznamy zákazníků a objednávek a na jiných listech vytvořte izolované 
kopie seznamů (vyberte externí data, zkopírujte je do schránky, přejděte na jiný list a vložte 
jinak, jako hodnoty). Pak sestrojte dotaz obracející se na obě tabulky a držte se postupu 
uvedeného výše.  

2. Relaci mezi tabulkami nastavte jako vnější spojení (relační čára bude mít na konci šipku). 
Osiřelé záznamy najdete tak, že přidáte kritérium, které vybere jen ty záznamy z mateřské 
tabulky, v nichž je připojený klíč prázdný (v jazyku SQL fráze IS NULL). Návrhové zobrazení 
dotazu, který vyhledá zákazníky bez objednávek, vidíte na obrázku na příští straně: 
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Kritéria v dotazu 
V brožuře se držíme zásady, že importujeme na listy pokud možno všechna data a teprve tam provádíme 

databázové operace. (Nechcete-li se kritérii zabývat a pokračovat v řešení úlohy, klidně tento oddíl přeskoč-
te.) Přesto bychom si měli alespoň na jednom dotazu ukázat, jak se dá na list poslat filtrovaná sada zázna-
mů. Třeba pro případy,  že budete pracovat s opravdu objemnými tabulkami a výsledná sada záznamů by se 
nevešla na jeden list, nebo když prostě víte, že určité záznamy v plánovaném zpracování opravdu potřebovat 
nebudete. Kromě toho, jednou sestrojený a uložený dotaz lze velmi snadno podle potřeb později upravit.  

Dejme tomu tedy, že chcete na list importovat pouze objednávky na sever Evropy, tedy do Německa, 
Dánska, Finska, Norska a Švédska za první čtvrtletí roku 1997. Postupujte takto: 

1. Zvolte Kritéria > Přidat kritéria. V dialogovém okně Přidat kritéria vyberte pole 
Objednávky.ZeměPříjemce a klepněte na tlačítko Hodnoty. V dialogovém okně Hodnoty 
vyberte jednotlivé státy a klepněte na OK. Viz obrázek: 

 
2. Klepněte na Přidat a ujistěte se, že je horní přepínač v poloze A (obě kritéria budou muset platit 

současně). Vyberte z seznamu Pole Objednávky.DatumObjednávky, v seznamu Operátor 
vyberte je mezi, klepněte na Hodnoty, vyberte rozmezí 1. ledna 1997 až 31.března 1997, 
klepněte na OK, pak na Přidat a Zavřít. 

3. Všechna nastavená kritéria uvidíte, vydáte-li příkaz Zobrazit > Kritéria. Mezi panelem tabulek a 
mřížkou sady výsledků se objeví mřížka kritérií: 
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4. Potřebujete-li nějaké kritérium upravit, dvojitě klepněte v mřížce a dostanete se do dialogového 

okna Upravit kritéria. Nová kritéria můžete také přidávat přímo, přetažením některého pole 
z tabulky a výběrem hodnoty, hodnota může být také určena výrazem. Viz příští oddíl.  

Nyní se vrátíme zpět k naší původní úloze. 

5. Nechcete-li právě sestrojená kritéria v dotazu zachovat, zvolte Kritéria > Odstranit všechna 
kritéria. 

Dopočítávaný sloupec 
Do našeho dotazu chceme ještě přidat jeden dopočítávaný sloupec, který vynásobí cenu za jednotku 

množstvím a sníží výsledek o případnou slevu.  

1. Zvolte Záznam > Přidat sloupec. Z pole ze sezname Pole nebudete nic vybírat, ale napíšete tam 
patřičný výraz. Do pole Záhlaví napište VýslednáCena. Viz obrázek. 

 
1.  Klepněte na OK. Dopočítávaný sloupec se umístí v mřížce dotazu zcela vpravo.  

Výraz v seznamu Pole vypadá takto: 
RozpisObjednávek.JednotkováCena*RozpisObjednávek.Množství*(1-Sleva) 

Kvalifikované názvy byste měli uvádět vždy (i u pole Sleva), aby bylo zcela jasné, ze které tabulky pole 
uvedené ve výrazu pochází. Výraz pro dopočítávaný sloupec můžete také rovnou zapsat do záhlaví nového 
sloupce a upravit jeho záhlaví tam, ale výše uvedený způsob mi připadá přirozenější. 

Uložení definice dotazu a přenesení dat na list 
Náš dotaz je hotov a asi bude dobré, uložit si jeho definici pro pozdější potřeby.  

1. Klepněte na tlačítko Uložit, přijměte nabízenou složku Dotazy, ponechejte nabízenou příponu 
.dqy a klepněte na Uložit.  

2. Zbývá přenést výsledky do Excelu, proto klepněte na tlačítko Načíst data do aplikace Microsoft 
Excel (nebo zvolte odpovídající příkaz z nabídky Soubor).  

3. Dostanete se do nám již dobře známého dialogového okna Vložení externích dat. Zvolte 
umístění, upravte případně vlastnosti a klepněte na OK.  
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Zaznamenání a úprava výsledného makra 
Jestliže jste si (podobně jako jsme to dělali v oddílu „Import a export externích dat“ zaznamenali celý 

proces jako makro, patrně jste zjistili, že nefunguje, protože je příkaz SQL příliš dlouhý, takže se narazí buď 
na povolený počet pokračovacích řádků (viz také oddíl zabývající se importem textového souboru 
s oddělovači) nebo na horní mez délky příkazu Visual Basicu. Také proto jsem volil za ukázku poměrně ob-
jemný příkaz SQL. 

Vygenerované makro se dá poměrně jednoduše spravit, dokonce i tehdy, když se do makra nezaznamená 
celý příkaz SQL. Postupujte takto: 

1. Klepněte v importovaném seznamu a zvolte Data > Načíst Externí data > Upravit dotaz. 

2. V aplikaci Microsoft Query zvolte Zobrazit > SQL. V dialogovém okně SQL vyberte kompletní 
kódu příkazu SELECT, zkopírujte si ho do schránky, vložte do kódu makra a označte jako ko-
mentář. Jeho části použijete pro úpravu nefunkčního makra. 

Poznámka. Blok kódu prohlásíte za komentář takto. Vyberte kód, klepněte pravým tlačítkem myši 
na nějakém viditelném panelu nástrojů as z místní nabídky zvolte Edit. Klepněte na tlačítko 
Comment Block. Až budete chtít převést zpětně komentář na kód, postupujte stejně, ale klepněte na 
tlačítko Uncomment Block. 

3. Z vygenerovaného makra je možno především odstranit volání funkce Array a při nastavování 
hodnoty vlastnosti .CommandText také odkaz na cestu k sešitu, protože se jedná o aktuální 
sešit. Výsledný kód může po drobných úpravách vypadat takto: 

Dim S1 As String, S2 As String, S3 As String 
' Následujících 8 řádků tvoří jediný příkaz 
S1 = "SELECT Objednávky.JménoPříjemce, Objednávky.AdresaPříjemce, 
Objednávky.MěstoPříjemce, Objednávky.PSČPříjemce, Objednávky.ZeměPříjemce, 
Zákazníci.KódZákazníka, Zákazníci.Firma, Zákazníci.Město, Zákazníci.PSČ, 
Zákazníci.Země, Objednávky.ČísloObjednávky, Objednávky.DatumObjednávky, 
Objednávky.Dopravné, Přepravci.Firma, Výrobky.NázevVýrobku, 
RozpisObjednávek.ČísloVýrobku, RozpisObjednávek.JednotkováCena, 
RozpisObjednávek.Množství, RozpisObjednávek.Sleva, 
RozpisObjednávek.JednotkováCena*RozpisObjednávek.Množství*(1-Sleva) AS 
'VýslednáCena' " 
 
S2 = "FROM Objednávky, Přepravci, RozpisObjednávek, Výrobky, Zákazníci " 
 
' Následující 4 řádky tvoří jediný příkaz 
S3 = " WHERE Objednávky.ČísloObjednávky = RozpisObjednávek.ČísloObjednávky AND 
Výrobky.ČísloVýrobku = RozpisObjednávek.ČísloVýrobku AND Zákazníci.KódZákazníka = 
Objednávky.KódZákazníka AND Přepravci.`Číslo přepravce` = Objednávky.Přeprava 
ORDER BY Objednávky.ZeměPříjemce" 
 
' Předpokládá se, že list Příprava faktur v sešitu existuje: 
Sheets("Příprava faktur").Select 
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' Následující 4 řádky tvoří jediný příkaz 
With ActiveSheet.QueryTables.Add(Connection:="ODBC;DSN=Sešity Excelu 97-
2000;DBQ=c:\ExcelDB\Sešity\Filtry a dota-
zy.xls;DefaultDir=c:\ExcelDB\Sešity;DriverId=790;FIL=excel 
8.0;MaxBufferSize=2048;PageTimeout=5;", Destination:=Range("A11")) 
 
   .CommandText = S1 & S2 & S3 
 .Name = "Příprava faktur" 
' atd. až  
   .Refresh BackgroundQuery:=False 
End With 

Prohlížená a aktualizace dat pomocí v prostředí MS Query 
Data zobrazovaná v mřížce dotazu lze nejen prohlížet, ale za určitých okolností i měnit (včetně přidává-

ní nových záznamů). Úpravy musí především povolovat zdroj dat a dotaz musí být založen na jediné tabul-
ce. Je-li dotaz aktualizovatelný, bude přístupný příkaz Záznam > Povolit úpravy. Těmito možnostmi 
MS Query se zde zabývat nebudeme. Další informace si vyhledejte v nápovědě k Microsoft Query. Potřebu-
jete-li upravovat data seznamu na listu, můžete to dělat přímo v něm. 

Parametrizace výběrových dotazů 
Při vytváření velkého množství výběrových dotazů se často stává, že se jednotlivé dotazy liší pouze 

jedním či několika kritérii. V takových situacích můžete celkový počet dotazů podstatně snížit, když je 
parametrizujete. Například, prostřednictvím dotazu, který jste sestrojili výše, byste mohli vyřešit problém, 
jak zobrazit přehled faktur do zvolené země.  

Dokončili jste dejme tomu výběrový dotaz jako v předchozím oddílu a v mřížce dotazu jste si prohlédli 
jeho výsledky. Zdá-li se vám, že produkuje to, co má, je úprava na parametrický dotaz velmi snadná: 

1. Vypněte tlačítko Automaticky na panelu nástrojů MS Query.  

2. Stiskněte tlačítko Zobrazit či skrýt kritéria.  

3. Přetáhněte do řádku Pole panelu kritérií pole ZeměPříjemce.  

4. Pro řádek Hodnota nevybírejte žádnou konkrétní hodnotu, ale napište text výzvy v hranatých 
závorkách. Viz prostřední mřížka na obrázku na příští straně. 

5. Spusťte dotaz klepnutím na tlačítko Spustit dotaz. Zobrazí se dialogové okno Zadat hodnotu 
parametru. Napíšete-li do něho slovo Brazílie, objeví se ve výstupu jen faktury pro Brazílii.  

6. Klepněte na tlačítko Načíst data do aplikace Microsoft Excel a určete cílovou oblast pro 
výsledky dotazu. 

Parametrů můžete mít více a hodnotu každého z nich pak uživatel zadává v samostatném 
dialogovém okně. 
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. Parametrické dotazy jsou sice pěkná schopnost, na druhou stranu je ale při interaktivní práci v Excelu 

většinou můžete snadno (a pohodlněji ) nahradit automatickými filtry či jinými technikami přímo na listech. 
Z hlediska syntaxe SQL se parametrický dotaz od „normálního“ liší tím, že je místo konkrétní hodnoty 

ve frázi WHERE dané podmínky symbol otazník: 
WHERE Objednávky.ČísloObjednávky = RozpisObjednávek.ČísloObjednávky AND 
Výrobky.ČísloVýrobku = RozpisObjednávek.ČísloVýrobku AND Zákazníci.KódZákazníka = 
Objednávky.KódZákazníka AND Přepravci.`Číslo přepravce` = Objednávky.Přeprava AND 
((Objednávky.ZeměPříjemce=?)) 

Snímání textu výzvy a hodnoty parametru z listu 
Text výzvy a parametr dotazu lze také zadávat přímo z listu Excelu. Za předpokladu, že máte na 

nějakém listu Excelu, který je právě aktivní, výsledky parametrického dotazu, postupujte takto:  

1. Klepněte v některé buňce výsledného seznamu. Nevidíte-li panel nástrojů Externí data, 
klepněte pravým tlačítkem myši na nějakém zobrazeném panelu nástrojů a zaškrtněte prvek 
Externí data.  

2. Na panelu Externí data klepněte na tlačítko Parametry. V levém seznamu vyberte parametr, 
jehož charakteristiky chcete změnit (v naší ukázce pracujeme pouze s jediným parametrem): 

3. Do textového pole pod prvním přepínačem napište nový text výzvy.  
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Do textového pole druhým 
přepínačem můžete napsat hodnotu, 
kterou přiřadíte parametru „natvrdo“.  
 
Máte-li možné hodnoty parametru 
uložené v nějakých buňkách, můžete 
parametr zadat tak, že do textového 
pole pod třetím přepínačem napíšete 
(nebo ukážete) adresu buňky 
obsahující hodnotu parametru. 

4. Klepněte na OK a klepněte na tlačítko Aktualizovat na panelu Externí data. Protože v naší 
ukázce jsem pouze změnili text, zobrazí se dialogové okno v této podobě:  

 

 
Můžete také dodatečně určit napsanou hodnotu jako 
stálou a poručit si automatickou aktualizaci sezna-
mu, pokud by se hodnota v buňce změnila. 

Odtud je už jen malý krůček k tomu, abyste si na listu vytvořili otevřený nebo rozvírací seznam, z něhož 
by uživatel vybral zemi a po výběru země by se automaticky aktualizovala externí data dotazu: 

1. Vytvořte na listu oblast obsahující všechny hodnoty parametru (například patřičným vzorcem 
nebo dotazem popisovaným dále). 

2. Umístěte na list rozvírací seznam nacházející se na panelu Formuláře. 

3. Nastavte jeho vlastnosti podle obrázku: 

 

 
V buňce C2 je vzorec 
 
=INDEX(A2:A5;B2) 
 
Tuto buňku použijte k aktualizacím 
a v dialogovém okně Zadat hodnotu 
parametru nezapomeňte zaškrtnout 
políčko Obnovit automaticky při 
změně hodnoty buňky. 

Seznam můžete také pochopitelně naplnit a celé zpracování řídit z VBA. Tento způsob však ukazuje, že 
se i při takovýchto úlohách můžete obejít bez programování. 
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Agregační dotazy 
Smyslem agregačních dotazů je vypočítávat různé souhrnné statistiky. V Excelu mi připadá řešení 

těchto typů úloh přes MS Query problematické, vzhledem ke schopnostem, které Excel pro výpočty těchto 
statistik poskytuje. Možná budete dávat přednost jiným technikám, když si uvědomíte, jaké možnosti 
poskytují přehledy či kontingenční tabulky a vezmete v úvahu, že dotaz produkuje vždy pouze jedinou 
úroveň agregace.  

Například, nemůžete mít ve výsledcích dotazu platy jednotlivých zaměstnanců a zároveň součty za jed-
notlivé divize, nebo součty za divize a zároveň součty za pobočky. Chcete-li získat celkové součty, budou to 
jediná čísla, která jako výsledek dotazu obdržíte – sada záznamů výsledků dotazu bude v takovém případě 
tvořena jen jediným řádkem.  

Pomocí MS Query však každopádně agregační dotazy řešit lze, takže si alespoň jednu ukázku 
předvedeme. Chcete spočíst souhrny prodejů jednotlivých výrobků v rámci jednotlivých kategorií a výstup 
omezit na ty záznamy, u nichž jsou souhrnné prodeje vyšší než 100 000.  

Poznámka. U agregačních dotazů můžete zadávat dva druhy podmínek. Na detailní záznamy (fráze 
WHERE), které SQL zařadí resp. vyřadí z výsledků dotazu ještě předtím, než provede agregační operaci. 
Nebo na agregované záznamy (fráze HAVING), tedy až po získání finálních záznamů skupin s vypočtenými 
agregačními statistikami. Postup: 

1. Začněte stejně jako při vytváření běžného detailního výběrového dotazu. Předpokládám, že 
máte otevřený sešit, v němž máte na jednotlivých listech (levý horní roh buňka A11) seznamy 
odpovídající databázovým tabulkám a nacházíte se na prázdném cílovém listu s názvem 
Agregační dotaz. Pak 

2. Zvolte Data > Načíst Externí data > Nový databázový dotaz, zvolte zdroj dat Soubory Excel*, 
vyhledejte sešit obsahující seznamy, na nichž chcete založit dotaz – tedy právě aktuální sešit.  

3. Ze seznamu Kategorie vyberte sloupec NázevKategorie, ze seznamu Výrobky vyberte 
NázeVýrobku a ze seznamu RozpisObjednávek sloupce JednotkováCena, Množství a Sleva. Až 
budete hotovi, klepněte na OK.  

MS Query opět oznámí, že relace nemůže vytvořit automaticky, takže si je opět procvičíte 
v návrhovém zobrazení dotazu.  

4. Klepněte v tabulce Kategorie na ČísloKategorie a přetáhněte je na stejnojmenné pole v tabulce 
Výrobky. Obdobně klepněte v tabulce Výrobky na pole ČísloVýrobku a přetáhněte je na pole se 
stejným názvem v tabulce RozpisObjednávek.  

5. Zvolte Záznam > Přidat sloupec. Do Pole napište RozpisObjednávek.JednotkováCena * 
Množství*(1-Sleva), do pole Záhlaví napište ProdejVýrobku, ze seznamu Souhrn vyberte 
Součet a klepněte na Přidat. Viz obrázek na příští straně. 

Pole z tabulky RozpisObjednávek máte v mřížce dotazu jen dočasně a jakmile zkontrolujte, zda 
dotaz produkuje správné výsledky, můžete je odstranit.  
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6. Vyberte tažením záhlaví sloupců JednotkováCena, Množství a Sleva a stiskněte Del. 

7. Vyberte dopočítávaný agregační sloupec ProdejVýrobku a zvolte Kritéria > Přidat kritéria. Ze 
seznamu Operátor vyberte je větší nebo rovno, do pole Hodnota napište 1000 a klepněte na OK.  

8. Abyste měli nejúspěšnější výrobky nahoře, přetáhněte agregační sloupec doleva (klepněte 
v jeho záhlaví, klepněte a táhněte), vyberte ho na cílovém místě a klepněte na tlačítko Seřadit 
sestupně.  

9. Klepněte na panelu nástrojů na tlačítko Zobrazit či skrýt kritéria, abyste viděli, jak dané 
kritérium vypadá v mřížce kritérií. Viz obrázek: 

 



D a t a b á z o v é  d o t a z y  

71 

Poznámka k programovacímu jazyku SQL. Pole, podle nichž se seskupuje, se uvádějí ve frázi GROUP 
BY. Na rozdíl od běžných kritérií se kritéria aplikovaná až na agregované záznamy uvádějí nikoli ve frázi 
WHERE, ale ve frázi HAVING: 
GROUP BY Výrobky.NázevVýrobku, Kategorie.NázevKategorie 
HAVING (Sum(RozpisObjednávek.JednotkováCena*Množství*(1-Sleva))>=100000) 
ORDER BY Sum(RozpisObjednávek.JednotkováCena*Množství*(1-Sleva)) DESC 

Klíčové slovo DESC ve frázi ORDER BY vyjadřuje sestupné řazení. Standardní je vzestupné (ASC). 

Výběrový dotaz zjišťující všechny různé hodnoty 
Při práci se seznamy bývá někdy zapotřebí zjistit, jaké všechny různé hodnoty se vyskytují v nějakém 

sloupci. Za účelem vytvoření nějakého číselníku, rozvíracího seznamu, z něhož si bude moci uživatel vybí-
rat, pro potřeby datové tabulky apod. V oddílu „Řazení a filtrování dat“ jsem se zmínil o tom, že je tuto úlo-
hu možno řešit vzorcem. Ten je ale poměrně dost komplikovaný. Úlohu můžete podstatně jednodušeji 
vyřešit výběrovým dotazem. Vyzkoušíme si to na tabulce zákazníků. Chcete zjistit, ze kterých zemí zákaz-
níci pocházejí. 

1. Přidejte do sešitu nový list a zvolte Data >  načíst Externí data > Nový databázový dotaz.  

2. Vyberte jediný sloupec, jehož všechny hodnoty hledáte, proklikejte se až do závěrečného kroku 
Průvodce dotazem, v něm zvolte prostřední polohu přepínače Zobrazit data nebo upravit dotaz 
v aplikaci Microsoft Query a klepněte na Dokončit. 

3. Zvolte Zobrazit > Vlastnosti dotazu a zaškrtněte políčko Bez duplicitních záznamů. Viz obrázek: 

 

 
 
 
Tlačítko Seskupit záznamy představuje 
alternativní, explicitní  způsob, jak sdělit MS 
Query, že chcete seskupovat záznamy podle 
hodnot ve vybraném sloupci. 

4. Klepněte na OK, vyberte sloupec Země a klepněte na tlačítko Seřadit vzestupně. Klepněte na 
tlačítko Načíst data do aplikace Microsoft Excel. 

5. Vyberte takto vzniklý jedno sloupcový seznam bez záhlaví a klepněte na kopírovat. Vyberte 
cílovou oblast, zvolte Úpravy > Vložit jinak, přepněte horní přepínač do polohy Hodnoty a 
klepněte na OK.  

Teď  máte na listu k dispozici všechny různé hodnoty jako oblast externích dat i jako nezávislou 
statickou oblast hodnot. 
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Vytvoření nové tabulky 
Vytvářet databázové tabulky mimo databázové systémy není záležitost, kterou by člověk dělal každý 

den. Kromě toho je vytváření tabulek „zvenku“, ať už vizuálně nebo v programovém kódu, obvykle 
mnohem nepohodlnější a pracnější, než když můžete pracovat ve vývojovém prostředí dané databáze 
(například z ní sebrat vygenerovaný příkaz CREATE TABLE a kopírovat ho do svého kódu VBA). Často 
také narazíte na různá omezení (právě proto, že přicházíte zvenku), někdy dost nečekaná. 

Rozhodně ale asi stojí zato vědět, že ani v této situaci nemusíte letět kupovat Access nebo FoxPro. Až 
budete jednou za uherský rok opravdu potřebovat vytvořit novou strukturu tabulky a nebudete mít 
k dispozici pohodlnější způsob, vždycky můžete sáhnout po MS Query.  

Dejme tomu, že plánujete evidenci svých kulinářských specialit a pro tento účel chcete připravit struktu-
ry požadovaných tabulek pro databázi svých receptů. Ukážeme, si, jak se vytvoří nová tabulka pro Visual 
FoxPro (verze 6.0).  

Doporučený postup v Accessu je samozřejmě jiný. Spustíte v něm Průvodce tabulkou, kde několikrát 
kliknete a tabulka receptů bude hotová. Nebo dokonce spustíte Průvodce databází, vyberete vzorovou 
databází Recepty, několikrát kliknete a budete mít nejen tabulku recepty a několik dalších potřebných 
tabulek, ale i formuláře, sestavy a dokonce i systém řízení aplikace uživatelem. Máte-.li nějaký seznam na 
listu a chcete z něho vyrobit tabulku Accessu, podívejte se do oddílu „Propojení s aplikací Microsoft 
Access“. 

Chcete si ale vyzkoušet, jak se do databáze Accessu (nebo do databáze jiného typu) přidá nová tabulka 
z MS Query (protože třeba zrovna Access nemáte po ruce), držte se následujícího postupu. Pro jiné databáze 
bude velmi podobný, pouze v seznamu datových typů budou pro různé ovladače uvedeny různé položky. 
Zároveň vidíte, že se s aplikací MS Query dá pracovat také samostatně. Tabulku Visual FoxPro vytvoříte 
následujícím postupem: 

1. Klepněte na tlačítko Start na hlavním panelu Windows, zvolte Spustit, v dialogovém okně 
Spustit klepněte na Procházet a vyhledejte výkonný modul MS Query nebo úplnou cestu přímo 
napište do textového pole. 

 Standardně je to cesta "C:\Program Files\Microsoft Office\Office\MSQRY32.EXE". 

2. Klepněte na OK. Otevře se aplikace MS Query. V ní vydejte příkaz Soubor > Definice tabulky. 

3. V dialogovém okně Zvolit zdroj dat vyberte vhodný zdroj dat, například Databáze Visual 
FoxPro 6.0 a klepněte na OK. 

 

 
MS Query zobrazí seznam tabulek, který odpovídá 
zvolenému zdroji dat (zde se jedná o databázi Testdata.dbc, 
dodávanou s Visual FoxPro 6.0).  
 
Chcete-li vytvořit tabulku, která se strukturou podobá 
některé z tabulek uvedených v seznamu, klepněte na 
Zobrazit a úpravy provádějte v dialogovém okně Zobrazit 
definici tabulky. Rozsah úprav, které budete moci provádět, 
závisí na zvoleném zdroji dat. 

4. Protože chcete vytvářet novou tabulku od začátku, klepněte na Nová. 
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Do pole Název tabulky napište název, pod kterým se má 
tabulka uložit do databáze. Pak definujte její jednotlivá 
pole. (Musíte brát v úvahu omezení daného databázového 
systému – zde jedno slovo, nejvýše 10 znaků). 
 
Napište název pole, vyberte datový typ ze seznamu, 
připadá-li to v úvahu, specifikujte délku a (nebo) počet 
desetinných míst. Určete, jedná-li se o povinné pole (bude 
se muset povinně vyplňovat) a klepněte na Přidat.  
 
Zde je datový typ dán prvním písmenem anglického názvu 
datového typu (C= Character, L = Logical atp.). 
 
Přidávaná pole se umisťují do seznamu v dolní části 
dialogového okna. 

5. Až budete hotovi, klepněte na Vytvořit.  

MS Query by měl oznámit, že tabulka byla úspěšně vytvořena. Po klepnutí na OK se vrátíte do 
dialogového okna Vybrat tabulku. V tomto případě se tabulka zařadí do databáze Testadata.dbc, na kterou je 
zvolený zdroj dat propojen. Protože je součástí definice také memo pole, vznikne kromě souboru 
Recepty.dbf též soubor recepty.fpt.  

Poznámka. Tabulka zařazená do databáze se ve Visual FoxPro nemůže používat mimo kontext dané 
databáze (jako volná tabulka). Potřebujete-li volnou tabulku, zvolte zdroj dat pro volné tabulky. Nebo, máte-
li přístup k Visual FoxPro, uvolněte tabulku z databáze. Otevřete databázi příkazem File > Open. V návrháři 
databáze klepněte na chlívek tabulky pravým tlačítkem myši a z místní nabídky zvolte Delete. 
V zobrazeném dialogovém okně odpovězte na dotaz klepnutím na No (kdybyste klepli na Yes, odstranili 
byste tabulku nejen z databáze, ale také fyzicky z disku).  

Typickou součástí definice tabulek dBASE či FoxPro bývají indexové soubory, jimiž se definuje logické 
řazení zejména ten, kterému se říká produkční index (má stejný název jsou soubor tabulky a příponu .mdx 
v dBASE, .cdx ve FoxPro).  

6. Chcete-li pro tabulku vytvořit indexový soubor, vyberte právě sestrojenou tabulku Recepty 
v dialogovém okně Vybrat tabulku a klepněte na tlačítko Index.  

 

 
Pojmenujte index, podle jakého pole se má indexovat a určete, 
jedná-li se o jednoznačný index (v daném poli nebudou povoleny 
duplicitní hodnoty). Klepněte na Přidat.  
 
Bude-li vše v pořádku, oznámí MS Query, že index úspěšně 
vytvořil. 
 

Oznámí-li vám při vytváření indexu MS Query něco jako „Syntax error“ nebo „Operace není pro tento 
typ objektu podporována“, obstarejte si novější ovladač nebo vytvořte indexy pro tabulky jiným způsobem 
(spuštěním definičního dotazu z VBA či přímo v databázovém systému, až k němu získáte přístup). 



D a t a b á z e  v  s e š i t e c h  E x c e l u  2 0 0 0  

74 

Kontingenční tabulky  
Kontingenční tabulkou se rozumí určitý druh dynamické výstupní sestavy se souhrnnými statistikami, 

která vznikne na základě výběru dat z databáze. Kontingenční tabulky a grafy se hodí především při práci 
s velmi rozsáhlými sadami vybraných záznamů, které jsou velmi nepřehledné a mají v té podobě, v jakém 
výsledky dorazu vznikly, velmi malou vypovídající hodnotu. S pomocí kontingenčních sestav a grafů může-
te velmi rychle a velmi snadno takové seznamy analyzovat a udělat si okamžitě představu o nejdůležitějších 
jevech, které jsou v datech skryty.  

Průvodce a ostatní přidružené prostředky, které Excel poskytuje pro tvorbu kontingenčních tabulek, 
představují vzorový příklad toho, jak by měly vypadat vyspělé, efektivní a přitom velmi snadno 
zvládnutelné nástroje, které mohou využívat jak běžní uživatelé, tak vývojáři.  

Kontingenční tabulky pokrývají problematiku rozdělení četností, křížových dotazů a grafů, zahrnují 
průběžné a celkové souhrnné statistiky a především jsou interaktivní. Vytvořením kontingenční tabulky 
možnosti jejího autora zdaleka nekončí. Kdykoli se může vrátit „dovnitř“ návrhářského procesu a prakticky 
jakkoli stávající tabulku „přeorat“. I do finální kontingenční tabulky se dají přidávat dopočítávané 
charakteristiky. V závěru této části brožury také uvidíte, že kontingenční tabulky jsou nepostradatelným 
nástrojem, chcete-li v Excelu pracovat s daty OLAP.  

Sestrojení kontingenční tabulky 
Podobně jako jiné vyspělé nástroje Excelu, se i kontingenční tabulky nejsnáze vysvětlují na konkrétním 

příkladu. Na listu Excelu máte seznam, který obsahuje přehled prodejů zaměstnanců podle zemí a měsíců 
v roce 1997. Seznam vypadá takto: 

 
Data jsou založena na dotazu uloženém v databázi „Severní vítr“, z něhož byly údaje na list přeneseny. 

Při vytváření kontingenční tabulky jsme se mohli obrátit na data databáze Accessu a jako první krok 
sestrojit požadovaný dotaz. Chtěl jsem se zde však především soustředit na otázky spojené s kontingenčními 
tabulkami, proto jsem podkladový dotaz připravil předem. Navíc chci opět ukázat, že i kontingenční tabulky 
mohou mít svá zdrojová data na listech a nemusíte je vždy tahat ze (vzdálené) databáze. Pokud by chtěl 
někdo dotaz sestrojovat v MS Query nebo v programovém kódu VBA, takhle vypadá jeho podkladový 
příkaz SELECT SQL: 
SELECT Objednávky.ZeměPříjemce, Zaměstnanci.Příjmení, 
Format([DatumObjednávky],"mmmm") AS MěsícProdeje, Sum([Rozpis 
objednávek].[jednotkovácena]*[Množství]*(1-[sleva])) AS ProdejeVýrobků, 
Count([Rozpis objednávek].Množství) AS PočetKusů 
FROM Zaměstnanci INNER JOIN (Výrobky INNER JOIN (Objednávky INNER JOIN [Rozpis 
objednávek] ON Objednávky.ČísloObjednávky = [Rozpis objednávek].ČísloObjednávky) 
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ON Výrobky.ČísloVýrobku = [Rozpis objednávek].ČísloVýrobku) ON Zaměstnan-
ci.ČísloZaměstnance = Objednávky.ČísloZaměstnance 
GROUP BY Objednávky.ZeměPříjemce, Zaměstnanci.Příjmení, 
Format([DatumObjednávky],"mmmm"), Objednávky.DatumObjednávky 
HAVING (((Objednávky.DatumObjednávky) Between #1/1/1997# And #12/31/1997#)) 
ORDER BY Objednávky.ZeměPříjemce, Zaměstnanci.Příjmení, 
Format([DatumObjednávky],"mmmm"); 

Z tohoto seznamu chceme nyní vytvořit trojrozměrnou souhrnnou kontingenční sestavu, která bude na 
jednotlivých svých stránkách obsahovat přehled za zvolenou zemi (nebo za všechny země). V řádcích 
budou měsíce, ve sloupcích příjmení prodejců. Postup: 

1. Přejděte na volný list (není to bezpodmínečně nutné) a zvolte Data > Kontingenční tabulka a 
graf.  

 

 
Do druhé polohy byste horní přepínač 
přepnuli, kdybyste chtěli kontingenční 
tabulku založit na datech z externí 
databáze (následovala by volba zdroje 
dat atd.) 
 
Násobné oblasti sloučení umožňují 
založit kontingenční sestavu na více než 
jedné oblasti na listu. Právě 
sestrojovanou tabulku nebo graf můžete 
také založit na jiné, již existující tabulce 
či grafu.. 

2. V naší ukázce nic neměňte a hned klepněte na Další. V druhém kroku průvodce přejděte na list, 
kde máte vstupní data a vyberte celou oblast seznamu, včetně záhlaví: 

 

 
Jestliže máte podkladová data pro 
kontingenční tabulku nebo graf 
v jiném sešitu, klepněte na tlačítko 
Procházet a vyhledejte sešit 
v zobrazeném dialogovém okně. 

3. Klepněte na Další.  

Poznámka. Jestliže už v sešitu nějakou kontingenční tabulku máte, zeptá se vás Excel, chcete-li prá-
vě sestrojovanou tabulku založit na existující kontingenční tabulce, protože to může přispět ke zvý-
šení výkonnosti. Protože chcete vytvořit nezávislou kontingenční tabulku, klepněte na Ne.  

Dostanete se do třetího kroku průvodce, který se vás ptá na levý horní roh budoucí tabulky. To ale 
udělejte až nakonec, nejprve je třeba tabulku sestavit a provést počáteční úpravy.. 

4. Klepněte na Rozvržení. Přetahejte tlačítka nacházející se v pravé části dialogového okna do di-
agramu uprostřed podle následujícího obrázku: 



D a t a b á z e  v  s e š i t e c h  E x c e l u  2 0 0 0  

76 

 

 
Nelíbí-li se vám  nabízené názvy v oblasti 
DATA (například proto, že jsou příliš dlouhé 
či víceslovné), můžete je přejmenovat.  
 
Dvojitě klepněte na poli a přepište název 
v dialogovém okně Pole kontingenční tabulky.  
Seznam Souhrn připomíná, že se dají počítat 
i jiné statistiky, než pouhý součet.  
 
Tlačítko Skrýt umožňuje vyloučit vybrané 
pole z kontingenční sestavy (netýká se 
zdrojových dat). 
  
Klepnete-li na tlačítko Možnosti, můžete zvolit 
některý ze speciálních zobrazení hodnot (viz 
rozvinutý seznam dole vlevo).  
 
Tlačítko Číslo poskytuje přístup ke stránce 
Číslo dialogového okna Formát buněk. 
 

5. Obdobné možnosti máte i pro stránková, řádková a sloupcová pole: 

 

 
Dostupnost prvků v dialo-govém 
okně Upřesnit závisí na tom, 
jakého druhu jsou zdrojová data.  
 
Všimněte si zejména horního 
přepínače, který umožňuje 
optimalizovat přenos externích 
dat (zde je nepřístupný, protože 
nepracujeme s externími daty, 
máme je na listu). Jak uvidíte 
později, nemůže se ale využívat 
při práci s daty OLAP. 
 
 

Chtěl bych připomenout, že nejste-li si jisti, jaké možnosti přesně zvolit, netrapte se s tím. Možnosti 
kontingenční tabulky budeme moci snadno upravit kdykoli po jejím vytvoření. Z hotové kontin-
genční tabulky se totiž můžete kdykoli snadno vrátit do prostředí průvodce. 

6. Až budete s rozvržením a s možnostmi hotovi, klepněte na OK. Vrátíte se do třetího kroku 
průvodce. Přehršel možností má také samotná tabulka. Klepněte na tlačítko Možnosti a 
prohlédněte si je.  
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Není-li vám jasné, co některá 
možnost znamená, klepněte na 
tlačítko otazník v titulkovém pruhu 
dialogového okna a pak na prvku. 
Zobrazí se okénko s nápovědou.  
Na obrázku vlevo vidíte tuto 
nápovědu pro zaškrtávací políčko 
Uložit heslo. 
 
Políčko Označit součty hvězdičkou 
(*) je dostupné jen při práci s daty 
OLAP. Je-li zaškrtnuté, označí se 
všechny mezisoučty a celkové 
součty hvězdičkou, což indikuje, že 
souhrny zahrnují skryté i zobrazené 
položky. 
 

7. Vyberte buňku levého horního rohu vytvářené tabulky na aktuálním nebo jiném listu a klepněte 
na Dokončit. 

Vytvoří se kontingenční tabulka, jejíž levý horní roh a panel nástrojů Kontingenční tabulka vidíte na ob-
rázku: 

 
Na panelu Kontingenční tabulka nepřehlédněte čtvrté tlačítko zleva, jímž se můžete okamžitě vrátit do 

posledního kroku průvodce kontingenční tabulkou a grafem a právě vytvořenou kontingenční sestavu 
jakkoli upravit. Všechny možnosti panelu plus některé další najdete také v místní nabídce, která se zobrazí, 
když klepnete pravým tlačítkem myši uvnitř kontingenční tabulky. 

Zejména bych chtěl upozornit na možnost skrývání či zobrazování podrobností a na seskupování 
položek. Vyberete položky, klepnete pravým tlačítkem myši a z místní nabídky zvolíte odpovídající příkaz 
z kaskádové nabídky příkazu Skupina a přehled. 
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Poznámka. Kontingenční tabulka není „normální“ oblast buněk, (je to objekt) a nemůžete s ní proto ma-
nipulovat podle libosti jako s normální oblastí. Nemůžete do ní přidávat řádky, nemůžete do ní psát vzorce 
apod. Chcete-li s ní pracovat jako s běžnou oblastí buněk, zkopírujte ji do schránky a vložte hodnoty (pří-
padně i formáty opakovaným vložením) na jiné místo pomocí dialogového okna Vložit jinak (přepínač do po-
lohy Hodnoty). Bude se ovšem jednat o statickou kopii, která nemá žádné napojení na zdrojová data.  

Jisté dodatečné statistiky však do kontingenční tabulky přidávat můžete, ovšem stanoveným způsobem. 
Říká se jim výpočtová pole a výpočtové položky. Co znamenají, jaký je mezi nimi rozdíl a jak se sestrojují 
uvidíte v příštím oddílu. 

Výpočtová pole a výpočtové položky 
Výpočtovým polem se rozumí nové datové pole vytvořené z jiných polí kontingenční tabulky. V právě 

sestrojené kontingenční tabulce máte k dispozici dvě datová pole, součet a počet, nabízí se tedy dopočtení 
jejich podílu. Postup: 

8. Klepněte v kontingenční tabulce pravým tlačítkem myši a z místní nabídky zvolte Vzorce > 
Výpočtové pole.  

9. V dialogovém okně Vložit výpočtové pole napište vypovídající název výpočtového pole a 
samotný vzorec: 

 

 
Psaní vzorce můžete urychlit, když vyberete 
pole v seznamu a klepnete na tlačítko Vložit 
pole.  
 
Vzorce mohou obsahovat funkce listu, ale 
nemohou se odkazovat na pojmenované oblasti 
nebo buňky. 
 
Je-li název pole víceslovný, musí být 
v apostrofech. (Vkládáte-li pole, Excel je přidá 
sám.) 

10. Až budete hotovi, klepněte na Přidat.  

Výpočtové položky se od výpočtových polí liší tím, že se nesestrojují pro datovou oblast kontingenční 
tabulky, ale pro oblasti řádky, sloupce nebo stránka. Protože máme přehled prodejů po jednotlivých 
měsících v roce, nabízí se vytvořit dopočítávané položky pro jednotlivá čtvrtletí nebo pro první a druhé 
pololetí.  

1. Klepněte v oblasti řádků (měsíce) kontingenční tabulky pravým tlačítkem myši a z místní 
nabídky zvolte Vzorce > Výpočtová položka. 
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Při sestavování sloupcových výpočtových položek 
pro čtvrtletí resp. pololetí se postupuje analogicky 
jako při volbě výpočtových polí.  
 
Abych potěšil feministky, přidal jsem také dvě 
dopočítávané řádkové položky, totiž Ženy a Muži.  
 
Vzorec pro ženy by snad měl být (alespoň podle 
fotografií v tabulce Zaměstnanci): 
= Callahan + Davolio + Dodsworth 
  + Leverling + Peacock. 

Na závěrečném obrázku tohoto oddílu vidíte kontingenční tabulku s přidanými výpočtovými poli a po-
ložkami. Aby se mi do obrázku vešly řádkové dopočítávané položky, skryl jsem údaje pro jednotlivé osoby, 
až na pana Mr. Kinga (rozevřít seznam Příjmení a zrušit zaškrtnutí těch polí, která nechcete vidět). 

 

 

 
Jak lze vyčíst z průměrných hodnot, jsou 
ženy v prvním čtvrtletí úspěšnější než 
muži, a to dokonce ve všech třech 
měsících.  
 
Ovšem, jak je vidět z výkonů  
Mr. Kinga, je to skutečně „prodejů 
king“, ovšem nad výkonem ostatních 
mužů (když jsou o dost horší než 
ženské), by se měl vedoucí manažer 
prodeje vážně zamyslet! 

Na závěr několik tipů 

 

 
Přidáte-li do kontingenční tabulky 
více polí, položek a vzorců, určitě 
oceníte, že si můžete jejich seznam 
spolu s dalšími pokyny, které Excel 
připojí, zobrazit na samostatném 
listu.  
 
Klepněte v kontingenční tabulce 
pravým tlačítkem myši a zvolte 
Vzorce > Seznam vzorců. 
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Zajímá-li vás, v jakém pořadí se dopočítávají 
výpočtové položky, zvolte Vzorce > Pořadí 
řešení.  
 
Pomocí tlačítek Nahoru a Dolů můžete měnit 
jejich pořadí, tlačítkem Odstranit lze 
nepotřebnou výpočtovou položku odebrat. 

• Pokud byste chtěli mít údaje za jednotlivé země na samostatných listech, nic není lehčího. Zvolte 
Zobrazit stránky z místní nabídky kontingenční tabulky. 

• Chcete-li mít názvy čtvrtletí s malým č, musíte vypnout automatickou opravu. Zvolte Nástroje > Automa-
tické opravy a zrušte zaškrtnutí políčka Velká písmena na začátku vět. Nebo klepněte na Výjimky a do se-
znamu na stránce Výjimky automatických oprav napište do pole Neměnit na velká po text 1., klepněte na 
Přidat a opakujte pro 2., 3. a 4. Nebo vypište požadované texty do polí Nahrazovat: a Čím:. 

• Alternativou ke kontingenčním tabulkám jsou tzv. dynamické křížové tabulky, jakési vlastní zpracování 
kontingenčních sestav, kdy se jednotlivé hodnoty pro datová pole (a někdy i pro řádková či sloupcová 
pole) vypočítávají pomocí vzorců. Kompletní ukázku najdete na stránkách 69-74 brožury „Microsoft Ex-
cel a práce se vzorci“ vydané nakladatelstvím UNIS Publishing v lednu 2001. 

• Podobně jako jiné činnosti, i vytváření a úpravy kontingenčních tabulek lze zaznamenávat pero potřeby 
případné automatizace zpracování, volání z jiných aplikací apod. Proces vytvoření kontingenční tabulky 
včetně jednoho výpočtového pole a jedné výpočtové položky (včetně přemístění položky 1. čtvrtletí na 
správné místo) ilustruje následující kód: 

    ActiveWorkbook.PivotCaches.Add(SourceType:=xlDatabase, SourceData:= _ 
        "'Data pro kontingenční tabulku'!R1C1:R409C5").CreatePivotTable _ 
        TableDestination:=Range("A3"), TableName:="Ktg z makra" 
 
    ActiveSheet.PivotTables("Ktg z makra").AddFields RowFields:=Array _ 
        ("MěsícProdeje", "Data"), ColumnFields:="Příjmení", PageFields:= _ 
        "ZeměPříjemce" 
    With ActiveSheet.PivotTables("Ktg z makra").PivotFields( _ 
        "ProdejeVýrobků") 
        .Orientation = xlDataField 
        .Caption = "Prodeje" 
        .Position = 1 
    End With 
 
    With ActiveSheet.PivotTables("Ktg z makra").PivotFields("PočetKusů") 
        .Orientation = xlDataField 
        .Caption = "Množství" 
    End With 
    ActiveSheet.PivotTables("Ktg z makra").CalculatedFields.Add _ 
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        "Průměrně", "= ProdejeVýrobků/PočetKusů" 
    ActiveSheet.PivotTables("Ktg z makra").PivotFields("Průměrně"). _ 
        Orientation = xlDataField 
 
    ActiveSheet.PivotTables("Ktg z makra").PivotFields("Příjmení"). _ 
        CalculatedItems.Add "Ženy", _ 
        "= Buchanan + Callahan+ Davolio+ Leverling+ Peacock" 
 
    ActiveSheet.PivotTables("Ktg z makra").PivotFields("MěsícProdeje"). _ 
        CalculatedItems.Add "1. čtvrtletí", "= leden + únor + březen" 
 
    Range("A41:M43").Select 
    Selection.Cut 
    Range("A14:M16").Select 
    ActiveSheet.PivotTables("Ktg z makra").PivotFields("MěsícProdeje"). _ 
        PivotItems("1. čtvrtletí").Position = 4 

Závěr makra byste měli upravit, aby se neodkazoval na konkrétní oblasti buněk.  
Kolekce PivotCaches reprezentuje kolekci vyrovnávacích pamětí pro jednotlivé kontingenční sestavy 

sešitu. PivotTables je kolekce kontingenčních tabulek nacházejících se na daném listu. Kolekce 
PivotFields reprezentuje všechna pole kontingenční tabulky včetně skrytých. Je možné se také odkázat 
na podmnožiny polí pomocí vlastností ColumnFields, RowFields, PageFields, DataFields, 
HiddenFields a VisibleFields (pole sloupcová, řádková, stránková, datová, skrytá a viditelná). 
Kolekce CalculatedFields resp. CalculatedItems reprezentují všechna výpočtová pole resp. 
výpočtové položky v dané kontingenční sestavě. 

Vytváření vlastních skupin 
Že se v Excelu dají velmi často podobné věci dělat několika možnými způsoby, lze ilustrovat 

i v kontingenčních tabulkách. Například dopočítávané statistiky za čtvrtletí, které jsme do tabulky dostali 
poměrně pracně přes vypočítávané položky, lze sestrojit zcela vizuálně, bez psaní jakýchkoli vzorců.  

Prostě vyberte ty řádky nebo sloupce, které chcete seskupit (například leden, únor a březen) a zvolte 
Data > Skupina a přehled > Seskupit. Vytvoří se nová úroveň seskupení a stačí jen nahradit výchozí název 
Skupinan vypovídajícím (například přepsat je na řádku vzorců na 1. čtvrtletí). Postup opakujte pro všechny 
skupiny, které chcete v kontingenční sestavě vytvořit. Nakonec změňte i názvy přidaných souhrnných 
oblastí 

Na obrázku na příští straně vidíte přidané skupiny za čtvrtletí a pololetí: 
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Práce s datovými krychlemi OLAP 
Při vytváření dotazů či kontingenčních tabulek jste určitě narazili na zkratku OLAP či termín datová 

krychle. OLAP (On-line Analytical Processing) je technologie určená pro práci s velmi rozsáhlými databá-
zemi. Databázím OLAP, které obsahují různé sady různých úrovní (neboli dimenze) se říká datové krychle, 
protože obvykle kombinují několik dimenzí.  

Hlavní výhoda práce s databázemi OLAP spočívá v tom, že sumarizační akce zajišťuje server OLAP, 
takže se při vytváření či aktualizacích kontingenčních tabulek nebo grafů urychluje zpracování. 

Nepracujete-li ale s opravdu velmi rozsáhlými databázemi, je otázka, zda data OLAP nepřinášejí víc ne-
výhod než výhod. Na několik omezení, s nimiž musíte počítat při práci s daty OLAP, upozorňuje následující 
výčet: 

• Načítáte-li údaje z databáze OLAP nebo z datové krychle, můžete je do Excelu dostat jen 
v podobě kontingenční tabulky. Pole v datech OLAP se navíc mohou používat buď jen jako 
stránková, řádková či sloupcová nebo jako datová (podle toho, pro jaký účel byla vymezena). 

• Souhrnná data se počítají na serveru, takže například nemůžete souhrnné funkce měnit (zobrazit 
či odebrat), u jednoho datového pole použít více souhrnných funkcí nebo určit, zda součty mají 
nebo nemají zahrnovat skryté položky. 

• Nelze používat výpočtová pole a výpočtové položky. 
• Ve vícestránkových kontingenčních tabulkách nelze načítat data jen pro jedinou položku 

stránkového pole. Není k dispozici příkaz Zobrazit stránky a ve stránkových polích nemusí být 
dostupná položka (vše).  

• Nelze modifikovat podkladový dotaz (v Microsoft Query) kontingenční tabulky nebo 
kontingenčního grafu. 

• Nelze spouštět podkladové dotazy kontingenčních tabulek nebo kontingenčních grafů na pozadí 
nebo čekat na výsledky. 

• Ovladače zdrojů dat OLAP nepodporují  parametrické dotazy. 
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• Server OLAP vrací nová data do Excelu při každé změně rozvržení kontingenční tabulky nebo 
kontingenčního grafu. Není dostupná možnost Optimalizovat paměť (příkaz Kontingenční tabulka > 
Možnosti tabulky, resp. Kontingenční graf > Možnosti). Nepracujete-li s daty OLAP, můžete volit 
různé způsoby aktualizace. 

• Některé analytické funkce Excelu, které používáte v „normálních“ kontingenčních tabulkách, 
nebudete moci při práci s daty OLAP použít, protože je zabezpečuje přímo server OLAP. 

• Další drobnosti. Pokud při práci  s daty OLAP přejmenujete pole a položky, obnoví se při novém 
zobrazení původní názvy. Nejsou k dispozici příkazy Seskupit a Oddělit. Nelze zobrazovat 
podrobnosti, protože se souhrnné hodnoty počítají na serveru. Nejde zobrazit položky, které 
neobsahují data. Počáteční řazení položek určuje server (u normálních kontingenčních tabulek je 
výchozí řazení podle názvů).  

Rozhodnutí pro data OLAP nebo pro jiný způsob uspořádání dat by mělo být založeno na znalostech 
věcné problematiky řešených úloh a možná i na předběžných testech výkonnosti konkrétního systému a jeho 
okolí. Abyste si udělali alespoň prvotní představu o tom, jakým způsobem se s daty OLAP pracuje, zařadil 
jsem na závěr části věnované kontingenčním tabulkám a brožury vůbec krátkou ukázku.  

Vytvoření datové krychle offline 
Nemáte-li k dispozici už připravená data OLAP a chcete s nimi pracovat, bývá prvním krokem vytvoře-

ní datové krychle z dat nějaké objemné relační databáze (SQL Server, Access apod.). Aby vám tuto etapu 
Excel usnadnil, poskytuje Průvodce vytvořením datové krychle OLAP. Vytvoříte-li soubor datové krychle, 
budete moci pracovat s daty OLAP i tehdy, nebudete-li připojeni k síti. Tento postup je výhodný také tehdy, 
když prostě nechcete uživatelům povolit přístup k „originální“ relační databázi. 

Následující postup předpokládá napojení na databázi Northwind.mdb Accessu 2000, ale postup by byl 
analogický, i kdybyste se napojovali na jinou databázi Accessu nebo na databázi SQL Serveru. V naší 
ukázce budeme předpokládat, že v databázi máte uložený pomocný dotaz Rozšířené podrobnosti objednávek 
(je v původní databázi) a dotaz s názvem Prodeje podle zemí a kategorií, (mírná modifikace původního 
dotazu Prodeje podle kategorií). 

Dotaz Prodeje podle zemí a kategorií extrahuje z tabulek Kategorie, Výrobky a Objednávky a z dotazu 
Rozšířené podrobnosti objednávek pole NázevKategorie, ZeměPříjemce, NázevVýrobku, 
DatumObjednávky a dopočítávaný sloupec ProdejeVýrobků. Dopočítávaný sloupec ProdejeVýrobků je 
součet dopočítávaného sloupce VýslednáCena dotazu Rozšířené podrobnosti objednávek. Sloupec 
VýslednáCena je založen na výrazu: 
     JednotkováCena * Množství * (1- Sleva) 

polí z tabulky Rozpis objednávek. 
Ze sady záznamů výsledků tohoto dotazu vytvoříme soubor datové krychle OLAP. Vytvořenou datovou 

krychli pak použijeme jako zdroj dat pro kontingenční tabulku, kterou umístíme na list sešitu Excelu. Za 
předpokladu, že pracujete v nějakém listu sešitu Excelu, je další postup tento: 

1. Zvolte Data > Načíst Externí data > Nový databázový dotaz. V dialogovém okně Zvolit zdroj 
dat vyberte na stránce Databáze zdroj Severní vítr. Dostanete se do Průvodce dotazem – volba 
sloupců. V seznamu Dostupné tabulky a sloupce vyberte dotaz Prodeje podle zemí a kategorií 
a klepněte na tlačítko >. 

2. Do seznamu Sloupce v dotazu vpravo se přenesou čtyři pole tohoto dotazu (vyjmenoval jsem je 
výše). Klepejte na Další, dokud se nedostanete do posledního kroku průvodce. V něm přepněte 
přepínač do spodní polohy Vytvořit z dotazu datovou krychli OLAP a klepněte na Dokončit. 
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3. Zobrazí se úvodní  dialogové okno průvodce vytvořením datové krychle OLAP, které je pouze 
informativní. Přečtěte si, co průvodce umožňuje a klepněte na Další. V prvním kroku 
zkontrolujte, případně změnou stavu zaškrtávacích políček určete, která z polí se budou 
používat jako datová pole: 

 
4. Klepněte na Další. Ve druhém kroku definujte dimenze. V datové krychli musí být alespoň 

jedna dimenze a každé dostupné pole lze použít pouze jednou. Na obrázku vidíte, že v této 
krychli jsme zvolili tři dimenze, každou o jediné úrovni (něco komplikovanějšího se ostatně z 
pouhých tří dostupných polí dá udělat jen obtížně): 

 
5. Klepněte na Další. 

 

 
Protože v této ukázce chcete vytvořit 
soubor krychle, ponechejte přepínač 
v nabízené spodní poloze.  
 
Přečtěte si, co nabízejí zbylé dvě 
polohy. 
 
Máte-li dobrý důvod měnit cestu či 
název souboru .cub datové krychle, 
udělejte to. Například na Krychle 
prodeje podle zemí a kategorií. 
Klepněte na Dokončit. 
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6. V dialogovém okně Uložit jako pojmenujte soubor dotazu (asi je vhodné uložit jej pod stejným 
názvem). U datových krychlí mají dotaz příponu .oqy (u běžných dotazů MS Query .dqy). 
Klepněte na Uložit.  

7. Excel oznámí, že vytváří datovou krychli offline a za chvilku se dostanete do třetího kroku 
průvodce kontingenční tabulkou a grafem, které už důvěrně znáte. Klepněte na Rozvržení a na-
stavte tvar kontingenční tabulky přetažením polí do diagramu. Klepněte na Možnosti a upravte 
možnosti sestrojované kontingenční tabulky. Určete levý hodní roh cílové oblasti kontingenční 
tabulky a klepněte na Dokončit. 

Dotaz obracející se na existující krychli offline 
Máte-li uloženou datovou krychli offline a dotaz typu .oqy, můžete z ní velmi snadno vytvořit 

kontingenční tabulku.  

1. Buď 

• Zvolte Data > Načíst externí data > Spustit uložený dotaz. V dialogovém okně Spustit dotaz 
vyberte dotaz obracející se na krychli (v našem případě Krychle prodeje podle zemí 
a kategorií.oqy) a klepněte na Načíst data. 

• nebo 
• Zvolte Data > Načíst externí data > Nový databázový dotaz. V dialogovém okně Zvolit zdroj dat 

klepněte na záložku stránky Datové krychle OLAP, vyberte zdroj dat (v našem případě Krychle 
prodeje podle zemí a kategorií) a klepněte na OK. 

 

 
Dostanete do ihned do třetího kroku 
Průvodce kontingenční tabulkou a grafem.  
 
Klepněte na Rozvržení a nastavte tvar 
kontingenční tabulky přetažením polí do 
diagramu. Například tak, jak vidíte na 
obrázku vlevo. Pak klepněte na OK. 

2. Nastavte podle potřeby možnosti sestrojované kontingenční tabulky, určete levý horní roh 
cílové oblasti a klepněte na Dokončit. 

Na listu se objeví kontingenční tabulka (v tomto případě trojrozměrná) a výběrem položek z rozvíracích 
seznamů máte k dispozici celou paletu sestav či přehledů. Například, na dalším obrázku vidíte přehled 
prodejů do Skandinávie a Německa kategorií Cukrovinky, Koření a Mořské produkty: 
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Hvězdička u součtů indikuje, že jsou do nich zahrnuty i skryté hodnoty. Není nic lehčího, než z dat 

kontingenční tabulky vytvořit graf.  

1. Zvolte Vložit graf. 

Na nový list sešitu se vloží graf. Vidíte ho na posledním obrázku. Jedná se o přehled prodejů jiných tří 
kategorií výrobků, tentokrát do zemí Střední a Jižní Ameriky: 

 
2. Nelíbí-li se vám typ grafu nebo jiné jeho atributy, klepněte pravým tlačítkem myši v grafu a  

z místní nabídky zvolte Typ grafu nebo jiný příkaz podle toho, co chcete na grafu měnit. 

Nemusím snad připomínat, že jakmile změníte graf výběrem z nabízených seznamů, že se okamžitě au-
tomaticky aktualizuje i podkladová kontingenční tabulka (a naopak).  

Protože je kontingenční tabulka trojrozměrná, můžete výběrem ze seznamu Název výrobku analyzovat 
stav prodejů konkrétního výrobku do zvolených zemí. Kontingenční tabulka se sama automaticky upraví 
tak, že zobrazí jen tu kategorii, do které zvolený výrobek patří. 

Protože se jedná o data založená na krychli OLAP, nejsou k dispozici některé schopnosti, které jste 
zvyklí používat v „normálních“ kontingenčních tabulkách. Viz výčet nejdůležitějších omezení na začátku 
oddílu. 
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